


NNOVATION IS A peculiar challenger—it keeps
staring at you all the time, but almost always
waits for you to make the first move.

Grappling with this challenger has been a
delightful and rewarding experience—both for us,
and for our readers.

When Ernst and Young certified our print run
of 1.2 lakh earlier this year, we were humbled
more than proud. That Digit is India’s undisputed
leader in the tech media segment bears no
repetition. Therefore, it would have surprised
many when we decided it requires change—a
complete makeover that would give it a new skin,
a new personality.

Why, many asked? Digit’s readership is by far
the largest in the tech media segment, and despite
new entrants in the market, has held on to its No
1 position with the possessiveness of an Australian
cricket captain holding on to his World Cup.

But change and innovation have been deep,
underlying philosophies at Digit. We were India’s
first magazine to give a free CD, and later, two. In
December 2003, we became India’s first
publication to give a movie VCD free (Ice Age). In
August 2003, we bundled a free Linux DVD.

Our competitors followed by giving DVDs once
in a while, or copying our packaging all the while.
Even their CD nomenclature was similar. We were
humbled again. 

Imitation, as the Mahatma said, is the most
sincere form of flattery.

From August 2004, we decided to pleasantly
surprise our readers once again. Digit is now
India’s first magazine to give a DVD free with
every issue—4.3 GB of the best software, the best
games, the best entertainment. And we won’t be

surprised if this time too, competition follows our
lead.

As a magazine, too, Digit has evolved. It
underwent this makeover because our reader is
now more technology-aware than ever before.
Technology is no longer on an esoteric geek plane,
but something he uses every day, in every
imaginable (and perhaps, unimaginable) way. It is
no longer just about inanimate hardware and
mute software; it is now about people, and how
they use it in real life situations. It is about what
technology can do for us, in ways we sometimes
did not even realise it could.

I hope you enjoy your favourite magazine’s
new avatar, and continue to be fellow travellers on
this exciting journey. 

PS: I would like to introduce Sachin Kalbag, Digit’s
new Executive Editor. He has been with us for six
months, and brings with him 10 years of media
experience—print, radio and Web. In between
qualifying for the final rounds of BBC
Mastermind, reading up on world mythology, and
listening to Django Reinhardt, he teaches
journalism in Mumbai. Apart from that, he says,
he pretty much does nothing. 

Meanwhile, our dear Sumod shall continue to
be the ‘geek on board’, guiding you through the
labyrinth of core technologies.

Publisher’s
Note
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A
lvin Toffler’s Third Wave is receding. Or is it?

Conventional wisdom would say no. Toffler’s
First and Second Waves — the agrarian and indus-
trial economies — are long over, and it is the infor-
mation society that defines this age.

Stock markets react more sharply to Wipro’s
fortunes than a cement major’s; software exports
touched Rs 80,000 crore last year, three per cent of
India’s GDP; there are more cellphones than land-
lines in several Indian cities; and laptops are no
longer being bought only by jet-setting executives.

Yet, it is becoming increasingly evident that the
Third Wave is now making way for the Fourth. Not
because technology is no longer relevant, but
because it has stopped fascinating us. We are used
to it, we take it for granted, but most importantly,
we want to know how to use it best.

Therefore, the Fourth Wave will not be about
technology, but how we exploit it.

Consequently, more than ever before, we are
being subtly pushed into understanding what tech-
nology’s new manifestations are, and master them.
It is these avatars you shall see in Digit from now.

They will reflect how we — post-modernist chil-
dren of a society travelling at hyperspeed — take a
pause and look at technology. We always knew we
interacted with technology, but could never put a
finger on how we did it. Digit has made an attempt
to do just that.

You will find stories that thrill, inform, edu-
cate, and entertain. ‘Enter’ launches you quickly
into the magazine, at the pace you are used to
when playing NFS Underground — furiously fast.

It progresses to ‘Digital Passion’, with stories
that fuel the pursuit of technology knowledge; of
people who hold technology dear to their hearts.

The ‘make-technology-work-for-me’ feel is
reflected in ‘Digital Tools’, with articles that place
you ahead of your peers at the workplace, or other-
wise. It is replete with tools that maximise your pro-
ductivity, and is aimed at the individual as well as
the SoHo segments.

Naturally, then, the next stop is ‘Digital
Business’ — tools to maximise returns on invest-
ment and cut costs to give muscle to the bottom-
line of small and medium businesses, a segment

that holds tremendous promise. We finally leave you
with ‘Digital Leisure’, to understand how technology
has permeated our lives beyond the workplace. This
is where you relax, and spend some quality time
with technology, having fun all the while. 

You can then hit ‘Esc’, the perfect exit to the
magazine, and one that leaves a sweet after taste,
just like dessert after a hearty meal.

When you read the new Digit, you may realise
that the Fourth Wave was always upon us, only we
never realised it. It is a thought that may make us
smile, and if it does, we just may have a great time
ahead together.

Welcome to the Fourth Wave

Editorial

“The fourth wave
won’t be about

technology, but how
we exploit it”

Sachin Kalbag Executive Editor
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can research smarter
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power surges and outages
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116 Arm Your Mobile
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Keep your mobile workforce
equipped and updated. 
Here are a few affordable
ideas to let productivity 
take-off

128 Live Life WireFree
Many say WiFi may be the
next big thing to happen to
India after the mobile boom.
Get expert comments and
views from five decision
makers on their WiFi
experience in their domains

155 A Site To Give
Swapnil and Tausef are just two among the
thousands of NGO beneficiaries in the
country. Here’s the story about how
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114 No Noise
Most people choose not to switch off their
mobile phones in critical situations and
‘silence zones’. Here’s how you can make
sure that your business doesn’t suffer
because of this menace

118 The All-rounders
Multi-Functional Devices are creating a
mini revolution in the office. A copier-
printer-fax-scanner combo brings relief
through huge savings, and clears the
clutter, too
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You get to choose what goes on Digit Interactive. 
This month, you have chosen:

Subscribe now...

Lookout for the exciting Tech Shack subscription

offer on page 28

WEB SPECIAL

WEB SPECIAL

taste technology at www.thinkdigit.com

The end of Uncertainty  
Experience is the best teacher, but
not in technology, until recently.
Find out how a 250-year-old theo-
rem is being employed in today's
systems to make use of the knowl-
edge of the past.

▼▼
▼▼

Banking on technology      
Customers have never had it this
good as banks go all out to woo them.
A look at what Indian banks have
on offer.

Want to brainstorm?
Start a discussion? Share an idea?
Log on to www.thinkdigit.com/forum

SUBSCRIBE

FORUM

BY DEMAND

BigOven 1.3
Size: 7.11 MB
Mindware

Road Trip 2004  
Size: 37 MB
Playware

Expect these on the August 2004 CDs
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Digit’s new look will not be complete without a mention of
Hashim P M, whose fine sense of design has driven this
magazine’s new personality. The 35-year-old unassuming
Master of Design from IIT Bombay’s Industrial Design Cen-
tre spent innumerable days (and nights!) defining Digit’s
design vision, and then perfecting it. Hashim runs his inde-
pendent design studio, Design DIfference, out of Cochin.
You can write to him at designdifference@vsnl.com, or visit
his Web site www.design-difference.com.

The designer who made the difference

Cover Illustration Mahesh Benkar
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Politics makes for strange
bedfellows. So do e-mail

and search wars.
Take Yahoo! and Google.

Until a year ago, both were
best of pals, with Yahoo!
even being a long-time
investor in Google.

Back in 2002,
Yahoo! took on
Google as its
partner to power
its search. In
February 2004,
the two compa-
nies parted ways:
Yahoo! began to
test its own
search engine.
And recently, Google
launched Gmail, starting 
off the e-mail-storage
domino-effect.

Then, in July, Google
acquired Picasa, an online
photo-management

company that makes soft-
ware for organising digital
photos. In May this year,
Picasa’s technologies were
integrated into the Blogger
service of Google, in order
to help simplify the process
of publishing and sharing of 

digital images
within the context
of Blogger.

The latest is
that Yahoo! has
acquired Oddpost
Inc., a startup that
has “gained the
reputation for
making it easier
and more enticing

to communicate on the
Web,” according to MIT’s
technologyreview.com. And
according to
internetweek.com, “Oddpost
technology will play an

important role in develop-
ing of the next generation
Yahoo! Mail.”

Yahoo! spokesperson
Mary Osako said in an offi-
cial statement, “The acquisi-
tion of Oddpost provides
Yahoo! with outstanding
technological expertise,
which will be brought to
bear on products across the
Yahoo! network, such as
Yahoo! Mail.”

So why did Yahoo! want
Oddpost? Oddpost’s applica-
tion provides regular e-mail,
photo sharing, and news
feed aggregation. The appli-
cation functions like a desk-
top application without the
need to continually refresh
pages, through a combina-
tion of DHTML, XML, and
JavaScript. The application
remains accessible from any
location. Ostensibly, the
new Yahoo e-mail service

War of the Searches

With Google
taking over
Picasa and
Yahoo! acquiring
Oddpost, the two
giants are ready
for a face off

Geet Sethi Sportsman

Geet Sethi, six-time world
billiards champion,

Padma Shri, Arjuna Award
winner, national snooker
champ, and founder of
sports portal, Khiladi.com,
speaks to Digit on
technology, technology, and
well, more technology.
What does technology

mean to you? 
Technology 

speeds up
communication
and eases
work. Gadgets
help simplify

and streamline
lots of activities.

Is technology only
for geeks?

Technology touches every
part of our life—transport,
communication, even in
mundane services like
booking tickets online. We
will be wrong to say
technology is for geeks only.
And how do you use it
everyday?
For communication, mainly. I
use my Palm Tungsten T for
e-mail. I use my Bluetooth-
enabled mobile phone for
easier communication, and
my Sony Vaio notebook. I
use the laptop to write
columns. At home I use
audio-video systems. Not to
forget, my laptop! 
What gadgets do you
usually buy?
I’m interested in PCs, audio
systems, and MP3 players. I
think the Apple iPoD is
beautiful.
Do you keep up with latest
tech trends?
I read lots of foreign
magazines like Fortune.
Sometimes keeping up to
date is difficult especially if
you play lots of events on
the professional circuit.

WEB BATTLES

Enter

Illustrations M
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A Video iPod
UK mobile supplier Peripheral Corner has launched
“Swiss Army Knife of gadgets”— a portable video
player with a hard disk. It has 40 GB, ready for MP3,
MPEG 4 video and JPEG pictures, which are down-
loaded from a PC via USB 2.0. 

Virtual Reality
Sony Labs have devised Transticks—removable media
that act as a virtual wire and as a shared memory
card. The virtual wire can be used to connect laptops
to slide projectors, while the cards will allow two
computers to share memory on a server.

illustration Atul D
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Pulse

would incorporate some of
this.

In addition to this,
Yahoo! offers RSS newsfeeds,
which Google does not. 

So what’s next? Yahoo!’s
Content Acquisition
Program (CAP), of course.
Yahoo!’s CAP plans to map
the deep web, or the invisi-
ble web, the part of the 
Web currently uncharted 
by crawlers. What Google
will do about that remains
to be seen.

SMART PHONE

A phoney
future

We knew this was
coming. “All the credit

cards, keys, money-all that

stuff in a purse or
wallet-should go
into the phone,”
Takeshi Natsuno
says. “By having
the phone with
you, you shouldn’t
need anything
else but your
clothes.” Natsuno,
MD for i-mode
strategy at NTT DoCoMo, the
biggest cell-phone company
in Japan, is talking about

DoCoMo’s plans for a new
smartphone.

i-mode, DoCoMo’s wire-
less Internet service, is plan-
ning on nothing less than a
phone that will act as a
remote control for your life.
This “remote control” will
include cash, credit cards,
other commercial cards,
driver’s license, business
cards, bank documents,
cheques, and even your
house and car keys. Sounds
futuristic? 

But that’s exactly
Natsuno’s vision for right
now. The phone will feature
a Sony chip, called ‘Felica’,
that lets it pay at checkout
counters, serve as personal
identification, unlock doors,
operate household appli-
ances, and buy various 
kinds of tickets, amongst
other tasks.

DoCoMo’s first target is
Japan’s railway stations,
which house restaurants,
department stores and
more. In addition to stores,
the Felica phones can
replace the cards that Japan-
ese currently use to move
through turnstiles.

Naturally, such ubiqui-
tous computing has its
perils: what if a phone is

used by a hacker
to “download”
money from
another person’s
phone? Also,
DoCoMo will
have access to too
much info about
a customer. It is
fear about such
issues that may

delay mass deployment.
By the way, read our

feature ‘Good-bye laptop,

Hello Smart-phone’ in Digi-
tal Passion to get an idea of
what the future smart-
phone can do.

PRIVACY MATTERS

Darling, may
I read your
e-mail?

In privacy-crazy America, a
new ruling by a Boston

federal appeals court 
may seem outrageous. It
ruled that e-mails may be
read by anyone, without a
search warrant.

The court ruling says
that if an e-mail has been
stored on a server for even a
millisecond, then, ostensi-
bly because it’s not entirely
yours, the privacy that you
assumed the e-mail should
be accorded does not exist.

There’s also a difference

One Silly Question Which browsers do you know and prefer?

Laxmi Ravikumar, Chennai

Rajat Mishra, Bangalore

Ashwini Ramakrishnan,  Navi Mumbai Sachin Chandna, New Delhi

MFDs
Why buy
many, when
one will do! Multi-functional
Device (MFD) sales are on a
rise as users are preferring
a single-point solution for
their scanning-printing-
copying and faxing needs.

Low-end 
Scanners
Entry level

scanners that served us
faithfully all these years are
being pushed to oblivion by
printer-scanner-fax-
photocopier combos that
save money and desk space.

I prefer IE because it’s like a phonenumber. I’d never want to change it. IE, MS Explorer and MSN Explorer.I use IE. It’s easy to use. IE, Opera, Netscape. I prefer IE6 as it’s

user-friendly. Opera isn’t for first t
imers. I know only IE and Netscape.But I prefer Internet Explorer. I only know IE and Netscape. I prefer

IE because I am used to it.

Priya , Mumbai

Security Watch

W32.Beagle.AG@mm

AAllssoo  kknnoowwnn  aass::
WORM_BAGLE.AH,
W32/Bagle.ai@MM

IInnffeeccttiioonn  MMeetthhoodd::  This
mass-mailing worm uses
its own SMTP engine and
opens a backdoor on TCP
port 1080. It sends e-mails
to addresses found on the
victim's computer. These
include attachments that
have .com, .cpl, .exe, .scr,
or .zip extensions. The
'From' address is spoofed.
It also copies itself to
folders that have ‘shar’ in
their name. It uses fake
file names (ACDSee 9.exe,
Porno Screensaver.scr, etc)
to fool the user into
executing it. 

DDaammaaggeess:: It generates a
flood of e-mails, and thus
slows down the PC, clogs
mail servers and degrades
network performance. It
also kills processes
associated with anti-virus
applications.

RReemmoovvaall  IInnssttrruuccttiioonnss::
Download its removal tool
from http://security
response.symantec.com/av
center/FxBeagle.exe. Close
all applications, disconnect
the system from the
network, disable 'System
Restore' and run this tool.
Reboot the computer and
run the tool once more. 

DoCoMo’s
wireless service,
i-mode, is set to
come up with a
phone that plays
remote control
for your life
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Are cyber cafes responsible for truancy
and youth violence? The Los Angeles City
Council thinks so. This powerful body
has now passed an ordinance
restricting the number of hours during
which minors can visit Internet cafes. It
has also made it mandatory to install
video cameras for security.

LOS ANGELES

UNITED KINGDOM

SINGAPORE

A round-up of technology news from across the globeThe Digital World

London-based 33-year-old millionaire pirate
Mark Purseglove has been jailed for three and
a half years for bootlegging music CDs worth
15 million pounds (Rs 131 crore). He pirated
CDs of bands such as Oasis, David Bowie,
Eminem, Michael Jackson and The Beatles. He
printed covers of illegal music CDs and sold
them for 12 to 15 pounds apiece.

Twenty-three-year-old student Kimberly
Yeo typed 26 words in just 43.24
seconds to create as new world record
of the fastest SMS ever, beating the
previous world record of 67 seconds.

JAPAN

The Japanese telecom ministry
announced that bags of schoolkids in
Tabe will be tagged with RFID to 
monitor the little ones on their way to
and from school. Parents will receive
updates about their kids’ whereabouts.

VATICAN CITY

Two million books, manuscripts and
other literary gems at the Vatican Library
in Rome will now have Radio Frequency
Identification (RFID) tags, making them
easy to easy to identify and manage. At
last count, the library has tagged more
than 50,000 of its 1.2 lakh volumes in its
public reading rooms.

FRANCE

France has become the latest
government to embrace open
source software, when it replaced
1500 Windows NT servers from
Microsoft with Mandrakesoft. The
deal was struck by the French
Ministry of Equipment.

Hunt for your ideal soulmate

http://www.indiandating.com/
Launched in 1998, this is the
granddaddy of Indian dating sites.
Photo profile creation is free.
Search the database with simple
search, or use the advanced search
tool for specific results. You can also
look for a particular member by
using the handle or keyword search.

http://www.indianfriendfinder.com/
Part of the international Friend
Finder Network, Indian Friend
Finder has Indian as well as an
international database of singles,
pen pals and activity partners. Get
access to Indian Friendfinder
Magazine with dating and
relationships tips.

http://www.fropper.com/
Formerly called DesiCupid.com,
Fropper (short for Friend Hopper)
encourages users to build
relationships — be it platonic or
romantic. 
Its USP? An instant messenger.
Users can also start a free private
network which is first reviewed by a
panel of experts before allowing it
to go online. It also has a premium
membership section. 

Indian Dating

Indian Friend Finder

Fropper

Three Incredibly Useful Sites
between read and unread
messages: you’ll need to
figure out the logic here. If
a message has not been
read by the recipient, prose-
cutors would have access to
the message only through a
search warrant. But if the
message has been read 
and remains on the service
provider’s server system, a
subpoena, rather than a
search warrant, is enough
for a prosecutor to open 
and read it.

At the backdrop of all
this is the wiretap law,
which requires prosecutors
to prove their need for a
wiretap. The law applies to

e-mails only
when they are in
transit, not once
they are resident
on a server. It all
seems logical now: you’re
not tapping a wire if you’re
reading a resident message!

But despite all the legal-
ities, the law will not make
much difference to most
people, because most major
ISPs have explicit policies
against anyone reading
their customers’ e-mails.

Still, one wonders if this
ruling is a result of the Big
Brother phenomenon. Will
there come a time when 
the US government will
actually have access to all 
e-mails? Only time, and
more lawsuits, will tell.

3G

No porn
please, it’s a
phone

Vodafone, a major UK
mobile carrier, has

implemented an adult-
content blocker on its 3G
service. ‘Adult content’
refers not just to porn, but
also to gambling sites and
other such. The move has
made for mixed reactions:
child protection groups
have lauded it, while some
users say it is troublesome.
One needs to go to a Web
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site and register using a
credit card to turn the 
filter off.

Vodafone said that the
implementation
of such a system
on a network
with such a large
consumer base
was bound to
have its teething
problems, but
there’s no short-
age of 
complaints.
Amongst those who didn’t
like the content blocker
were one customer who

found himself blocked not
just from adult content but
all his corporate e-mail. One
user was prevented from

reaching the Sky
mobile site
because the news
site “might
contain stories
inappropriate for
people under 18”.
Yet another said
the system simply
wasn’t working,
because when he

typed in “porn” in Google,
he was able to surf porn
sites within seconds.

In January this year, all
major UK network operators
agreed on a code of practice
designed to restrict access
to adult content with the
aim of protecting children.
They signed up to have 
their filters in place by the
end of 2004.

CONVERGENCE

A TV on 
your lap

Ever wished for a laptop
that you could use as a

TV set? Of course you have,
but then there’s the hassle
of attaching a TV tuner
card, starting up a special
software, and so on, right?

Toshiba has come up
with just what you might
want: a laptop it calls
Qosmio, which allows 
you to watch TV without
booting the computer up.
Combine this with what
Toshiba says is the best
laptop display in the
market, and you’ve got a
great product on your
hands. Analysts say this is
the beginning of a trend
that will last for years to

come. The Qosmio will be
Toshiba’s first laptop to
fully integrate audio and
video features, including a
bright, near-TV-quality
display, DVD drive, TV-

tuner, and enhanced speak-
ers. A user could click on
the TV with the laptop’s
remote control, or watch a
DVD movie without having
to go through the process of
starting the OS.

There’s a caveat,
however: if you want to
pause a show, or record a
broadcast onto the hard
disk, you’ll need to boot up
the system. But then, imag-
ine watching TV and 
recording a clip onto your
hard disk, just with a mouse
click, and having access to
the clip ever after.

Even though you can

Pulse

Vodafone has
started an adult-
content blocker
on its 3G server.
It will block porn
as well as
gambling sites

Phonebook >
Delete >
Hairdresser
Every month, the Digit team
will come up with a funny
caption for a photograph. All
you have to do is come up with
something funnier, and beat
them at their own game!

Cheap handhelds 
Find some cool offers for PDAs from
Tungsten, Sharp and Mitashi. The
RReeddiiffff..ccoomm ValuStore also has a Palm
Internet Watch for Rs 3,000. Some
handhelds are priced as low as Rs
500. Of course, those are the basic
models. For some more features,
you’d have to shell out anywhere
between Rs 1,200 and Rs 2,000.

http://shopping.rediff.com

Cool digicams 
It’s raining digicams at SSiiffyy..ccoomm, 
at unbelievable discounts. 
Get Rs 8,000 off on a Rs 14,999 
5-in-1 SlimCam. Or save a whop-
ping Rs 6001 and grab the DV3
Camcorder originally priced at 
Rs 12,500. It’s nearly 50 per cent
off on most of the goodies, 
including a Spy Pen Digicam.

http:// sify.com/shopping

A selection of best offers from popular e-com sites

Photograph Jiten Gandhi

Send your captions to
beatthat@thinkdigit.com
and win an Optical Mouse
from Logitech
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already watch TV on any
computer with a TV tuner
card, with this kind of
convenience, it probably
won’t be long before 
the DRM, RIAA and MPAA
guys come in.

IM MERGING

Even three
make a
company

Microsoft, AOL and
Yahoo! have announced

an agreement that will link
their instant messaging 
networks. This, however, is
for business users only. The
combined network would
get to more than 400 
million customers globally.
The agreement is aimed at
making instant messaging
as widely used as e-mail is,
without the network 
compatibility problems 
associated.

"This agreement repre-
sents the dawn of the next
era for instant messaging,
which will unleash the true
potential of real-time
communication and 
collaboration in the work-
place," said Edmund Fish,
senior vice president at
America Online.

The new system will be
based on Microsoft's Live
Communications Server
2005. It will serve as the hub
that will connect the 
messaging systems.

Nate Root, a senior
analyst with Forrester
Research, says: "This is a
very significant announce-

ment. The value here is for
corporations. Corporations
will now have the ability 
to span the instant messag-
ing landscape."

However, for now at
least, the three companies
have no plans to integrate
instant messaging outside
corporate workplaces. "What
this does not do," Root said,
"is the holy grail of instant
messaging, which is to allow
anybody on any network to
send a message to anybody
on any other network."

The new service being
would have features that
include recording and 
saving of messages sent over
IM, and a guarantee of
secure communications,
which the free IM services 
do not provide.

Corporate use of 
instant messaging is wide-
spread, but it remains to 
be seen whether companies
will be willing to actually
spend on the new 
service, thereby formalising
instant messaging.

DOWNLOAD

And now, 
evolution for
technology

Darwin’s theories of 
evolution may soon

dictate how soon a down-
load completes.

Scientists at the Univer-
sity of Karlsruhe in
Germany are developing
genetic algorithms that
would help in
speeding up Net
downloads.

A genetic
algorithm is one
that has been
“bred” by the
principles of
Darwinian evolu-
tion: for exam-
ple, from an
initial pool of
algorithms, the ones that
give the best results are
chosen for the next itera-
tion, and so on, until 
one algorithm emerges the
winner. This is the “opti-
mal”, or best, algorithm.

There are variants of this
method - in some cases,
different algorithms in the
pool combine and discard
properties according to the
Darwinian principles of
crossover and mutation, in
order to arrive at the opti-
mal algorithm.

The relation to Net
downloads is that a lot of
the data transmitted over

networks is
repeated. If all
data were to be
transferred afresh
each time, it
would mean a
waste of resources.
To solve this prob-
lem, data is
cached at certain
servers, and for a
certain period of

time. But where, and for
how long, is not a trivial
problem. It is for this prob-
lem that the genetic algo-
rithms were developed.

The scheme could, at
some point in the future, be
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Trust busters

Recently, we decided to buy a
pack of VCDs from

Indiatimes Shopping.
Registration done, we were the

proud owners of a 15 per cent
discount coupon. A few clicks
and pages later, it was time to
enter the coupon number and
wait...  Imagine our surprise
when it threw up an “Already
used” error!
We then scoured the site for a

Customer Support link. There
wasn’t one. So we sent a whin-
ing e-mail via its Feedback
Forum. A week passed and a
month thereafter. No sign of a
reply. We caught sight of their
toll-free shopping number and
dialed to give them a ‘blast’. 

But no sooner had we
dialed than a curt, cold voice
(reminded us of ice) ‘informed’
us that we can just “place”
orders not “complain” about
one! Not cool at all.

Scientists in
Germany are
developing
genetic
algorithms that
would expedite
Internet
downloads 

GENDER 

BENDERS

Kartik, 19, commerce undergraduate, is confidence 
personified. He connects the mouse and keyboard in one
stroke. But he gets confused over why the monitor cord is
double-ended. Stalemate. It takes over a minute till he
solves the mystery. He inserts it into the right slot. Finally.
The machine hums to life after he switches on the mains. 

Kartik Iyer v/s Sapna Lokahnde
Connecting routine peripherals
—mouse, monitor and keyboard 

2 min 
50 sec.

3 min

Sapna Lokhande, 19, a commerce undergraduate, laughs
nervously before she begins. Did she expect something
tough? She does a mental toss-up, and chooses the mouse
first. The keyboard is also connected. But Sapna, too, is stuck
at the monitor cord. Finally, everything falls into place. 
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used to allow caches to auto-
matically “evolve” their
configuration. “Further
development could involve
different rules suited to
each individual host or
subnet involved in the 
internet,” says Pablo Funes
of the University of Karl-
sruhe. “One can even imag-
ine each host evolving its
own optimal rule.”

DVD COPYING

Sharing 
is not 
loving

Marking a shift in the
way the movie industry

has reacted to the threat of
online piracy, a group of
media and technology
companies, including
Microsoft and Disney, have
agreed to allow consumers
to make legal backup copies
of “next-generation video
discs”, and share the
content on portable devices.
Next-generation DVDs will
deliver superior video and
audio, although technology
and media companies
haven’t yet reached a
consensus on which compet-
ing DVD format will prevail. 

The announcement
comes in the wake of all 
the hubbub about piracy,
file sharing and copying 
of media.

The group of companies
also includes IBM, 
Intel, Matsushita Electric
Industrial Co. Ltd. and
Warner Bros.

Today’s DVDs are
protected by the CSS
(content scrambling system),
which prevents copying. The 
computer and consumer
electronics industry have
pushed to allow easier, 
more seamless sharing of
media between TVs, 
computers, and portable
players. The alliance has
named its yet-to-be-devel-
oped content protection
technology “Advanced
Access Content System
(AACS).” The system will 
be available for licensing

later this year.
The new AACS system is

logical. If you have a DVD, it
should be legal to have a
backup of it on your hard
disk, just as it’s legal to 
have a backup of a cassette
tape. But it’s anyone’s 
guess what this move will
do for DVD piracy, and how
far it will be successful in
maintaining legitimate use
of copying facilities.

INDUSTRY

Shalom,
India!

Intel and Motorola might
leave Israel in favour of

India and China as their
new international hubs,
Gartner’s Israeli representa-
tive said in Jerusalem 
last month. 

Baruch
Gindin, Gart-
ner’s Managing
Director for 
Israel and West
Asia, has warned
Israel’s Knesset
Science Commit-
tee that there is
a serious risk that the two
companies might leave
Israel in favour of the
“better” and “thriftier”
alternatives offered by 
India and China, Israel’s
Maariv International maga-
zine reported.

This seems to be an issue
of serious concern in Israel
right now, because of the
contributions that the two
companies currently make
to the Israeli economy.

Although nothing is
confirmed as yet, India

could well benefit from the
extremely strict tax laws in
Israel. India could also 
benefit because of its 
cheap labour.

A new report, released in
July, indicates that the
world semiconductor indus-
try is expected to record a
50.9 per cent increase in
financial expenses in
comparison with 2003, with
equipment expenses surg-
ing by 63.5 per cent. Gindin
made his remarks in refer-
ence to this report.

Gartner has recom-
mended that the Israeli
government resolve this
problem by changing tax
laws, and by launching a
global campaign highlight-
ing the advantages of the
prospective scene in Israel.

Israel is deeply
entrenched in the semicon-
ductor industry. It also
designs and manufactures

machinery used in
the manufacture
of semiconduc-
tors. The shares of
140 Israeli compa-
nies are traded on
the US stockex-
change. 

This is rated as
the highest from any 
non-North American coun-
try. So why the proposed
shift to India?

Apart from tax laws and
cheap labour, these compa-
nies also have a wider talent
base to choose from. It
remains to be seen 
whether the Israeli tax laws
will be changed soon, and
whether, therefore, this is
the beginning of a trend—
and in the meanwhile, Indi-
ans can look forward 
to more jobs. 

What is LinkedIn?
How many people in your
phonebook? 50? 350? Maybe,
even a thousand. How about
increasing that contact list to
more than a few thousand—
from across the world. LinkedIn
allows you to do just that. It is
safe too, since new contacts are
made only through trusted
connections. 

Who founded Linkedin?
Reid Hoffman is the man behind
LinkedIn. Currently on the board
of directors of four other
business consultancies and Web
sites, Hoffman is also an angel
investor with interests in
several sites.

When did LinkedIn begin?
Interesting story. Sometime in
2002 LinkedIn’s founder Reid
Hoffman spent five days looking
for a Flash designer for his
erstwhile company PayPal.
None of his contacts could send
him the ideal person. Finally, a
colleague suggested her friend’s
friend for the job. Hoffman
knew the time for a networking
site had come. 

Why choose LinkedIn?
In one word—credibility. Very
few sites have earned the trust
of its users, and LinkedIn is one
of them. 

Where is LinkedIn located?
Close to our best online friend,
Google, at Mountain View,
California. Networks are spread
worldwide.

How do I use Linkedin?
Create a profile on LinkedIn just
as you would create a profile for
an online email service. A
profile allows you to search for
people connected to your
through your network for job
listings, mentoring, financial
services and venture capitalists
from different countries and
sectors.

Intel and
Motorola, who
may leave Israel
soon, are eyeing
to set up hubs in
India and China

Linkedin.com
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Fuelling the pursuit of technology knowledge[DeXter]’s
Laboratory

30 Days With
Apple iPod42

Passion
Digital

Meera Vankipuram

eepak Pawar’s modest workplace in
Mumbai is like any event management
office—replete with executives scam-

pering to get the work done to perfection, tele-
phones buzzing incessantly, logistics
coordinators talking with their clients, and vis-
itors entering and leaving the premises with
elegant alacrity.

The office also has a peculiarity that most
workplaces don’t. It smells of obsession—
Pawar’s passion for all things on the bleeding
edge of technology.

Pawar, managing director of Midas Events,
craves for gizmos just as Sachin Tendulkar
craves for Pepsi—yeh dil maange more. His O2
Xphone, for instance: If technology were
fashion, then O2 is its Tyra Banks—sexy, hard-

working and intelligent. This smart phone
with PDA functionality, is pricey—at around 
Rs 20,000 in the grey market.

“I like to own stuff that no one else in India
has managed to get their hands on,” says the
35-year-old Pawar. “My motto is, if someone
else has it, I don’t want it.” 

His subsidiary gizmo list: A Compaq iPAQ
4850 pocket PC, a Nokia 7610 camera phone, a
digital guitar, a 30 GB Apple iPod with the
iTrip FM transmitter, and a Bluetooth and
WiFi-enabled IBM ThinkPad T41 notebook. 

A cool laptop is also something that Rohit
Gupta has—a Dell Inspiron 8500. In India,
where buying a laptop is still mostly deter-
mined by the company you work for, Gupta
decided to invest in one of his own. It’s cer-
tainly not at the top of the notebook charts,
but at $2,780 (approx Rs 1.3 lakh) it’s certainly

one of the most
desired. With a con-
figuration that goes
something like this:
Pentium 4 2.4 GHz
mobile processor, 512
MB DDR RAM, 60 GB
hard disk, 15.4-inch
wide screen with
WSXGA resolution, a
combo-drive, a 64 MB

nVidia GeForce4 4200 Go graphics card—who
wouldn’t.

Gupta, scion of the multi-crore Gupta
Group, a mid-level conglomerate that has
interests in finance and trade, says he is going
to attack the Nokia 6230 next. And a digital
video camera after that. 

Pawar, on the other hand, wants a smart
robot next; something that could take calls,
and perhaps even check email regularly and
report to him. “I had the Sony AIBO (the
robotic dog that made news a couple of years
ago), but I gave it away because it was just

D
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Gizmoland
Welcome to

Premium Nokia
handsets, Tungsten
T3s, Apple iPods,
high-end IBM
notebooks — just
some of the gizmos
that India’s tech
elite is buying.
Meet the men
behind the gadgets
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another expensive toy—not very smart.” When
it comes to technology, humility is not a virtue
that Pawar posseses.

And why should he, when his office and car
are enough to send a geek into a tizzy.

His office is WiFi-enabled, and his Mitsubishi
Pajero SUV is fitted with a Bluetooth-enabled
phone, a Waypoint GPS receiver, the iTrip, a Pio-
neer S1 audio and video player with digital sur-
round, and an unbreakable solar panel to
recharge batteries while on treks.

He uses his Waypoint receiver whenever he
is abroad—especially Europe (“Amsterdam is
my favourite place”) or in the US. When in
Europe, he uses the TOM TOM Navigator soft-
ware to get around, using his GPS reciever and
PDA. Pawar is also a regular visitor to CeBIT,
the world’s premier technology fair, held
annually in the German city of Hanover, where

he would have spent the rest of his life, had it
not had a closing date. “The people at the
stalls were a bit taken aback at my interest
and my inquisitiveness. My knowledge comes
as a surprise to them.”

He loves his old stuff, too. He has kept his
first ever PDA—a damaged O2 XDA—at his
office, as an antique piece. But he currently
uses a Compaq iPAQ Pocket PC. His favourite

acquisition is the
Nokia 7650 the first
phone with a one
mega pixel camera.

Another cool one
is the Yamaha digital
guitar—a gadget that
outputs both analog
and digital signals,
and thus can be con-
nected directly to a
PC to record and
create music.

Not surprisingly,
his event manage-
ment company offers
Web casts of high-pro-
file events. Pawar also
advises Bollywood big-
gies on which gadget
to buy, the next time
they are abroad. His

gizmos? Well, they come in “mostly through
friends, from all over the world.” 

On the other hand, Gupta’s Dell came
through an auction site. Like all of Dell’s prod-
ucts, Gupta could customise his laptop. He set-
tled for a configuration that cost him Rs 1.3
lakh. But he also got a three-year global war-
ranty from Dell. “I’d love to own all the gadgets
in the world, if I could afford them.”

Girish Mistry, veteran photographer and
Dean of the Shari Academy, one of the only
two professional photography institutes in
India, swears by his Canon EOS 10D. On its

Top Ten

1. 40 GB Apple iPod
with the iTrip FM
transmitter 

2. Bluetooth and
WiFi enabled IBM
ThinkPad T42p
notebook

3. Dell Inspiron
8600

4. Nokia 6600 
5. Nokia 7610

camera phone 
6. Sony Ericsson

P900
7. PalmOne Treo

600
8. PalmOne 

Tungsten T3
9. O2 XDA II 
10. Toshiba e805 

Pocket PC

Celebrities of all kinds—
from the Indian film

industry to corporate
biggies, find gizmo-buying
the ultimate aphrodisiac. Or
so it would seem, considering
the gadgets they sport: If
singer Shankar Mahadevan
takes his Sony Ericsson
P900 everywhere, actors
Amitabh Bachchan, Preity
Zinta, Shah Rukh Khan,
Abhishek Bachchan, Vivek
Oberoi, and  Kamal Hassan

are possessive of the
Apple Powerbook.

So are musicians A
R Rahman,
Sandeep Chowta
and Lucky Ali. 

The Apple
iBook is also
the hot
favourite of
Shammi
“Yahoo”
Kapoor, as

also for Kolkata-based ad
guru Ram Ray. 

Model-turned-actor Marc
Robinson owns a Nokia 3205,
while cueist Geet Sethi dotes
on his Palm
Tungsten T. 

Actors
Sunny Deol

and Shekhar
Suman are quite the gadget
freaks and have made their

homes wire-free. So has Anil
Kapoor, who uses Philips
Pronto, a home automation
device.  

Celeb
photographer
Atul
Kasbekar’s
gizmos include
a high-end
Hasselblad 503
CW, a Fujifilm
S2 Pro (35 mm) and a Nokia
6600. 

Fashion designer Rohit
Bal swears by his brand new
Nokia 7600, the eye-shaped
3G phone. 

iPod, the bestselling
personal digital music player,
has found fans in Sachin
Tendulkar, Shah Rukh Khan,

Infosys managing
director Nandan
Nilekani, DJ
Aqueel and
singer Lucky Ali .

If film world
biggies are on to
the gizmowagon,
can politicians be
far behind? Former Rajya
Sabha member Vishvjit
Prithvijit Singh, who ran
Congress’ e-campaign, owns
an Apple G-4 laptop, while
former IT Minister and BJP
spin-doctor Pramod Mahajan

is devoted to his
laptop and
mobile
phones. 

I’d love to own all
the gadgets in the
world, if I could
afford them
Rohit Gupta
Director, Gupta Group

Have Money, Will Buy

Shankar Mahadevan

Preity Zinta

Sachin 
Tendulkar

Shammi
Kapoor

Rohit Bal

Pramod
Mahajan

The Dell Inspiron 8500 can be customised to your needs

If someone 
else has it, I don’t 
want it
Deepak Pawar
MD, Midas Events
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own, the EOS 10D is just above the mid-range
professional series cameras, and costs about
$1,300 (Rs 60,000). However, it comes with the
amazing feature of a 90-degree tilt shift lens,
which means that the camera can swivel on its
axis, something that makes “impossible angles
possible,” Mistry says.

With a maximum aperture of 2.8, the
EOS 10D has automatic colour and
temperature bracketing and an individual
Kelvin temperature setting, per frame.
Auto-bracketing enables a user to shoot up to
three frames (cold, daylight, warm) at
once. “We can then pick the ambience of
our choice. This feature makes the colour
meter and the big box of filters redundant,”
he says.

His other little digicam gadget is a QP
colour correction card—another first in India—
to simultaneously colour correct an entire
batch of pictures. While processing the image,
the QP card helps create a digital image as
close as possible to the subject. 

His other favourite is the Ideazon
keyboard, again something that isn’t
available in India, yet. It has removable
sets of shortcut keys—one each for Photoshop,
3D Max, Dreamweaver, QuarkXPress,
and other such imaging and desktop pub-
lishing software. 

Aneesh Bhasin, a digital imaging profes-
sional from Delhi, says he is inseparable
from his Tungsten T3, the top-end
handheld from PalmOne, the same company
that makes the supersuccessful Treo 600,

probably the coolest PDA-phone you’d come
across today.

Bhasin carries his T3 everywhere he goes.
Yes, everywhere! The T3, which costs about
$400 (almost Rs 18,400, but available in India
for Rs 30,000), comes packed with a 400 MHz
Intel PXA255 XScale processor, and 64 MB
inbuilt memory. 

He even uses his T3 to connect to the
Internet. Says Bhasin: “My T3, phone and com-
puter are all Bluetooth compatible, so I can
also shift files from one gadget to another, dial
numbers and multi-task quite a bit.”

The T3 is power packed—it has Image
storage (“I click photos on my Nokia, and show
it to clients on the T3,” says Bhasin), a voice
memo recorder, a universal remote control,
the works. “The T3 is certainly more efficient
and convenient than a laptop. It does just
about everything,” says the 19-year-old.

The T3’s Omni Remote Pro feature lets  you
control any infrared remote controlled device
such as a television, VCR and even the air-condi-

tioner. Says Aneesh, “The Omni
Remote Pro has a longer range
than ordinary remote con-
trollers, so I can operate devices
from anywhere in the house!”   

The peripatetic Bhasin is currently working
on a book for professional photographers; and
his T3 features prominently in it. The book,
however, will not be on his obsession, but a
workflow management tool, sponsored by cor-
porates such as Adobe, Nik Multimedia, Corel,
Ideazon, Lowproe and Sandisk.

Pawar, meanwhile, sits in his office,
dreaming of his next big gadget. He promises
it will be the Motorola MPx100, a smartphone
that could just be next Treo 600 on steroids
causing more envy among Pawar’s tech-crazy
friends. But that is just the situation he would
love to be in. 

meera_vankipuram@thinkdigit.com

Price List

Palm Tungsten T3
www.palmone.com
Price Rs 29,900
O2 Xphone
www.o2.co.uk
Price $550 (Rs 25,300)
Apple iPod
http://www.apple.com/ipod
Price $499 (Rs 23,000) for 15 GB

Dell Inspiron 8500
www.dell.com
Price $2,780 (Rs 1,27,880)
Nokia 7610
www.nokia.com
Price $650 (Rs 30,000)
Canon EOS 10D
www.canon.com
Price $1,300 (Rs 60,000)

I click photos on 
my Nokia, and show
it to clients on 
the T3
Aneesh Bhasin
Digital Imaging Professional

An object of desire: The Palm Tungsten T3

My EOS 10D makes
impossible angles
possible
Girish Mistry
Professional Photographer

Ideazon keyboard: For all your graphics needs
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Solution

Price Rs 3,648

The text “Windows XP Professional” or “Windows
98” or “Windows 2000” is a bitmap image

embedded in explorer.exe. To edit this file, you will
need a tool called Resource Hacker. Download it
from http://www.users.on.net/~johnson/
resourcehacker/. Do back up the files you will be
changing before you proceed.

Start Resource Hacker, and open C:\windows\
explorer.exe. For Windows XP, expand the Bitmap
folder in the left pane, expand the 167 folder and
then click 1033. In the right pane, you will see the
bitmap image with “Windows XP Professional” on it.
Right-click 1033 in the left pane, and choose ‘Save
[Bitmap : 167 :1033]’. Enter a directory and filename
and click OK. For Windows 98 and 2000, go to
Bitmap > 157 > 1033 to find the bitmap.

Next,edit the bit map using an image editor
such as Photoshop, but do not change its colour
depth and dimensions. After you have made the
changes, save the file as a bitmap image.

Now, embed this new image into explorer.exe.
Keep Resource Hacker open and ensure that the
tree (Bitmap > 167 > 1033 for Windows XP, and
Bitmap > 157 > 1033 for Windows 98 or 2000) is

still expanded. Right-click on 1033 and choose
‘Replace Resource’. Next, click ‘Open file with new
bitmap’, point to the edited bitmap and click the
Replace button. Now, go to File > Save As and
save this file in another location. For example, we
saved this file in the E:\ folder as E:\explorer.exe.

Next, in Windows 98, simply restart your
computer in MS-DOS mode, and replace
C:\windows\ explorer.exe with E:\explorer.exe.

With XP or 2000, you will
need to make a few
changes to the registry. Go
to Start > Run, type
‘regedit’ and hit [Enter] to
open the registry editor.
Navigate to
HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft\
Windows NT\Current
Version \Winlogon. In
the right pane, change the
value of the ‘Shell’ key
from Explorer.exe to
E:\explorer.exe. This done,
restart your  computer to
view the results.

This
Month’s

Challenge
Can you overclock

your graphics 
card safely without

causing a crash?
The winner will get a

fabulous cordless
keyboard and mouse

Rules and Regulations
1. Readers are requested to
send in their answers by the
15th of the month of
publication.
2. Employees of Jasubhai
Digital Media and their
relatives are not permitted to
participate in this contest.
3. Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.
4. Jasubhai Digital Media is
not responsible for any
damage to your system that
may be caused while you are
solving the problem.

Every month, Digit will pose a question
that will set you thinking. Digit
challenges you to take a crack at the

problem. Send in your answers with your
full name, address and contact details to
takeacrack@thinkdigit.com. Digit’s Test
Centre will select the correct answers. In
case of multiple correct entries, the winner
will be decided by a draw of lots.
For starters, we have published the
solution to a specific challenge here.

Win!

Challenge
In Windows, the name of the OS appears vertically in the Start Menu.
Can you change this and put “Digit” there instead? Note that in XP, the
change can be seen only if you are using the Classic Start Menu.

Changing the
Windows Logo in
the Start Menu

Change the value of the Shell key using the registry editor

YOur Start Menu should
look like this

Test the edited explorer.exe before you edit the
registry in Windows XP or 2000. Press [Ctrl] +

[Shift] + [Esc] to bring up the Task Manager, switch to
the Processes tab, right-click explorer and click 'End
Process'. Now, go to File > New Task (Run…) and enter
e:\explorer.exe or the location of the edited file. If all's
well with the file, you see the changes immediately.
You can now edit the registry to make the changes
permanent. If you use Windows 98, and are unable to
boot after replacing the file, press [F8] while booting
and choose Command prompt. Here, replace the
edited file with its backup and restart the PC.

Caution!

Sponsored by



Aparna Krishnakumar

H
is girlfriends call it the “Disco
car” from the hit song in the
movie Kal Ho Na Ho. He just
calls it a fast, entertaining car.
And his nickname in the big
bad world of modified cars is
Landspeed.

To call Suren Joshi a car
freak would be under-rat-
ing the word—he is more
than that. He is devoted to
his car, and at an age when
his peers would be chasing
girls, or even jobs, Joshi spends half his time
modifying his car, and the remaining half in his
other favourite pastime—sleeping.

It helps that he, along with his mother, owns
a garments export business with factories in the
south Indian city of Tirupur, and Mumbai.
Money, therefore, is only the small matter of
how much to withdraw from the ATM.

He has always been different, this Suren
Joshi. Which is why when most people who want
to modify their cars with one screen for 
people to watch movies, he installed three in his
90-bhp Mitsubishi Lancer. Not satisfied with it,
he also installed a Rs 22,000 DVD player. And 
just in case people called him a visual person
rather than an audio enthusiast, he installed
2000-watt speakers with amplifiers, which cost
him a further Rs 57,000.

Joshi, now 21, has been a technology addict
ever since his teenage days when he hacked into
the servers of a local daily newspaper in
Mumbai, and then promptly called up the editor
to inform him about it. The editor did not waste
time hiring him and asking him to plug all the
loopholes in their information systems.

At 17, he was a Microsoft Certified
Software Engineer, and in addition
to his ethical hacking, Joshi says he
even helped the Mumbai Police solve
a kidnapping case by tracking down
the kidnapper’s whereabouts
through his email messages.

Two years ago, he gave up

studying for good ("I am just a 12th standard
pass") and left for the United States to do a course
in modelling. He came back with a diploma
from the Barbizon School of Modelling, a lead-
ing modelling institution. His latest passion is to
enter the world of fashion modelling full-time. 

In the meanwhile, the car receives as much
attention as a first-born would from her parents.
He recently installed an RPM Auto gauge that

monitors his gear move-
ments; a voltage meter
that allows him to
check the fluctuations;
steering wheel, gears

and hand control set from Momo, another world
leader in car racing accessories. He has even
installed neon light fittings to his clutch, brake

and accelerator pedals. 
He has spruced up the Lancer engine

into a 125 Bhp beast - thanks to a
Performance Filter with spark cables, a
sturtbar, a Zulex and HID lights. has
transformed his 85-90 horsepower
Lancer to a 125 horsepower flying one.
His analogue dials, however, elicit
“weird questions from my friends like

‘Why do you have so many
clocks in your car’,” says

Joshi. “I can only
laugh.”

By the way, the
rest can envy
Suren. 

aparna_krishna-
kumar@thinkdigit.com

Teck Shack

LCDs, DVD 
players, 2000
watt speaker
system, neon
pedals, NOS—
this aspiring
model has a car
that has his
neighbours and
friends drooling

I only laugh when people ask
me weird questions like  

‘Why do you have so many
clocks in your car?’

Suren Joshi’s Carisma 

Car
90-bhp Mitsubishi
Lancer

Audio System
Pioneer 2000 watt
Speakers with 
amplifiers- Rs 57,000
Pioneer DVD player- 
Rs 22,000

Other Droolware
3 LCD screens 
(Rs 46,000), HID
Lights- Rs 20,000,
American make NOS-
Rs 80,000, RPM Auto
gauge; voltage meter
hand control set from
Momo, neon light 
fittings to his clutch,
brake and accelerator
pedals.

Gadgets
Inside 21-year-old Landspeed’s “Disco car”
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Bhaskar Banik

nkjet printers have now
become standard equip-
ment with PCs: any new

PC comes with one. This has main-
ly been due to the sharp decline in
prices. Owners, too, have evolved
from using printers primarily for
printing text documents, to using
them for more creative and 
image-intensive purposes, such as
printing graphs, charts, pictures
and decorative banners. This
change in usage patterns has been
not just because owners need to
do more, but also because of
advancements in printer technol-

ogy that facilitate such needs.
Digital photography is taking

off in a big way: every other person
either has a digicam, or is thinking
of getting one. The idea of instant
photographs has caught everyone’s
fancy, too. These printers cater to
the segment of users that want to
print photos using their home
printers. Photo printers are opti-
mised for photo printing, and in
fact, text printing on these print-
ers could even be slower than on a
regular ink-based printer.

Underneath the skin
Ink-based photo printers differ
from regular ink-based printers in
a few critical ways. First, they

require a greater variety and num-
ber of colour cartridges. Most
photo printers support light cyan
and light magenta in addition to
the regular cyan, magenta, yellow
and black, making for a total of six
separate cartridges. The addition
of the light shades means that
more subtle variations in colour
can be reproduced accurately.

Second, there is a reduction in
the ink the printer sprays. This
increases precision and provides
more control, which in turn
improves picture quality—less ink
sprayed means there is less liquid
to smear the print. The thinner
layer of ink dries faster, and this in
turn means the ink doesn’t spread
from the point it was applied to.
The increase in printing resolution
means curves can be smoother,
colour gradients can be better 
controlled, and greater detail can
be brought out. 

Another, different technology
is thermal-dye technology, known
as dye-sublimation printing. This is
different from ink-based technolo-
gy, and is suitable only for photo
printing. A dye-sublimation print-
er has a long transparent sheet
made up of the four colours—cyan,

DIGIT AUGUST 2004

Photo Finish
Move over the usual 
ink-based printers, photo
printers are here to take
digital photography to a
new level
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magenta, yellow and black. This transparent
sheet is actually a film made up of the coloured
dyes. When a photo is printed, the print head
heats up. 

This print head consists of thousands of
heating elements, which heat the dye on the
film and cause it to vaporise and diffuse into
the glossy paper. The temperature on the print
head is precision controlled for each heating
element, and accordingly, the dye is vaporised
on the paper. 

This is what results in the varied hues and
colour tones. This technology has a definite
advantage over ink-jet photo printing—the
colours diffuse on to the paper, it does away
with the thin film-like effect that occurs 
with an ink-based printer. Photos printed 
with these printers also have a longer life span
since the colour has permeated into the 
paper—making the photo less vulnerable to fad-
ing and distortion.

What do you really need?
Before you buy a photo printer, first consider
some important factors:

Think about your usage pattern. If you need
mostly text prints, and printing photos is just a
new fad as far as you are concerned, you will be
better off with a good quality inkjet printer,
which would be more than sufficient for your
needs. When you need a quality print, just go to
your nearest digital photo shop and get one.

Plan your budget: look at the costs of 
consumables and try making a rough calcula-
tion of your expenses.

Decide on the technology you want to use. Do
you want the absolute best, or can you compro-
mise a little on the quality as long as you get 
a photo printer?

Photo printers are available in all shapes and
sizes, are based on different technologies, and
you have a range of manufacturers to choose
from. When it comes to buying a photo printer,
it can become pretty confusing to choose one.
We present you with a few buying tips:

Give speed a consideration. If two photo
printers, based on the same technology and
offering the same quality prints are compared,
and one printer offers faster printouts, it makes
more sense buying that one, even if it costs a 
bit more.

Check for the various available printing
options. Can you print borderless prints? Can
the printer print 4 x 6 prints as well as A4
prints? Does the paper tray support various
sizes of paper? Also check if the printer 
supports dual trays, which will reduce the 
hassle of changing paper types for documents
and photos.

Is portability your concern? Opt for a printer
that makes for less hassle and more usability.
You should be able to get a printout without
messing about too much with the controls.
However, be ready to spend a little more for a
portable printer.

Check if the printer supports memory cards
and printing directly off a digital camera. Some
photo printers are infrared-equipped, so you
can directly print off mobile devices such as
camera phones and PDAs. Of course, these
devices do not yet support really high-quality
images, but that may change soon.

Usability features on a photo printer should
include one-touch printing. This is not a fea-
ture you absolutely need, but comes in handy
in situations where you just want to print with-
out fiddling with the settings.

37AUGUST 2004 DIGIT

How a photo printer works

Cartridges
The extra cartridges
are the Photo Cyan and
Photo Magenta,
totalling eight
cartridges, giving your
photos their much
needed colour.

Print Head magnified
Arranged alternately are the
nozzles that spray ink droplets
that vary in their size. 5pl for
the normal and text prints while
precision 2pl droplets for photo
printing.

Print Head
The most intricate and the
most delicate part of the
photo printer. Shown are
the little microscopic rows
of nozzles that discharge
the ink on to the paper.

G
raphics Solom

on Lew
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Photos printed
using the 
thermal-dye
technology have
a longer life
span, and are
less vulnerable
to fading and
distortion
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Quality with consumables
The quality of your photo printer may be
excellent, but your investment can go right
down the drain if the consumables you use
are not up to the mark. If you are stingy in
choosing the ink cartridge and the paper 
that you want the prints on, you will have to
be prepared for poorer quality. Here are some
tips to make sure you don’t land up in a 
difficult situation:

Models available
Vendor

Hewlett-
Packard

Canon

Epson

Model

HP PS 7260

HP PS 130

HP PS 7960 

I905D

I990

CP-300

Photo830

Photo R310

Photo 2100

Technology

Inkjet

Inkjet

Inkjet 

Bubble Jet

Bubble Jet

Dye-sublimation

Inkjet

Inkjet

Inkjet

Price

Rs 6,499

Rs 8,999

Rs 16,999

Rs 21,995

Rs 25,995

Rs 16,995

Rs 7,500

Rs 13,495

Rs 54,900

Application

4 x 6 prints, borderless printing. Targeted towards
the home segment.

4 x 6 prints, borderless printing. Support for
memory cards. Home segment.

4 x 6 prints, borderless printing. Support for
memory cards. Home/SoHo segment.

4 x 6 prints, borderless printing. Support for
memory cards and PictBridge. SoHo segment.

4 x 6 prints, borderless printing. Support for
memory cards and PictBridge. SoHo segment.

Portable printer, only for photo printing. 4 x 6
prints. Targeted towards  the home user. 
4 x 6 prints, borderless printing. Support for
memory cards. Home segment.

4 x 6 prints, borderless printing. Memory cards
and PictBridge. Home/SoHo segment.
Photo printing only. A3+, A3, borderless printing.
SoHo/Professional segment.

Paper type
Make sure that the paper quality you have is
the best available for your particular applica-
tion. If you want a regular photo print, you
can use two types of paper—glossy or matte.
Both have their disadvantages. Glossy paper is
susceptible to accidental fingerprints after
you get a print done; matte paper will not
offer the finish that glossy paper does. It’s up
to you to decide. Regular matte paper starts at
around Rs 12 and goes up to Rs 100, depend-
ing on brand and company. If you order it in
bulk, a price reduction is possible. On the
other hand, regular glossy paper starts at Rs
25 and can go up to Rs 150, depending on the
quality and thickness. 

Paper quality
Check for the thickness of the paper and the
whiteness. Whiter backgrounds will result in
a high-contrast image print, which improves
the overall quality of the image. Thickness is
important—it can make or mar the image.
Some papers may be too thick for the 
kind of printing you do, while other papers
may be so thin that the ink permeates
through to the other side. This type of paper
is especially risky for dye-sublimation 
printers, which use heat to print different
colour densities on paper. Thick papers, on
the other hand, can cause the pick-up mecha-
nism to jam, especially when you want to
print cards or calendars.

1/2 Pg  H AD
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Photo printers are
available for home

as well as for
businesses. At
home, they serve
the purpose of
having a photo lab
as and when you
need it. Borderless
printing, which was
not possible except
in print labs, is now
possible at home. You
can print in regular
sizes, and also photo
print on stickers and other media.

For businesses, a photo printer may be advantageous 
if you need good quality prints regularly. For example, if
you need to send out a few exclusive, high-quality invites to
some clients, you may find it difficult to get it done from
your regular print shop. Photo printers can be useful for
creative designers, architects and engineers; there are
many applications, such as AutoCAD, which make a photo
printer a very handy thing to have.

Who needs photo printers?

Ink quality
A basic principle: Don’t ever be stingy with your colour car-
tridges. If you demand the best, use the best. Saving a few
rupees by using a fake or refilled cartridge will not give you
the output that you expect. Always use manufacturer-
branded or recommended cartridges and papers.
Technologies such as HP’s PhotoREt colour layering tech-
nology or Epson’s water-proof ink technology are not possi-
ble with refilled cartridges. 

What do I buy?
The HP 7960 is an interesting model. This printer gave the
best results for photo printing in tests, and, at Rs 16,999, is
targeted towards the mid to high-end consumer segment. It
comes with frills such as a memory card reader, and direct
connectivity to an HP digital camera, but lack of PictBridge
means non-HP cameras are not supported—PictBridge is a
standard that allows you to directly connect a wide range of
digicams directly to your printer.

The Canon i905D is comparable to the HP printer. It sup-
ports PictBridge technology, and is priced at Rs 21,995.
Image printouts turned out to be of very good quality.
However, it is not very good at text printing. The Epson
Stylus Photo 900 has decent image quality, but loses on 
connectivity options. Also, the prints lack tonal balance,
where the HP excels, and the Canon follows suit with
almost similar quality.

While all these are good desktop photo printers,
Canon's new portable solutions, the CP-200 and the CP-300,
priced at Rs 11,195 and Rs 16,995 respectively, are viable
options. These printers, based on the dye-sublimation tech-
nology, can provide you with instant photographs any-
where, since they can run on a portable battery. Since
portability is the main criterion here, both printers support
PictBridge technology, giving you printouts directly from
your digital camera. Dye-sublimation-based portable solu-
tions are also available from Sony, Epson, HP and Kodak.
Offering a variation in terms of both features and price,
these manufacturers have models that suit every budget. 

bhaskar_banik@thinkdigit.com

1/2 Pg  V AD
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Tomorrow

Ram Mohan Rao

hen Alexander Graham Bell invented
the telephone, the first thing he said to
his assistant who was two storeys away,

was: “Watson, come here, I need you.” In 1876,
that phone was the epitome of smartness. It
allowed you to do something that no one could
ever do before—talk long distances without
breaking your vocal cords.

One hundred and twenty-nine years later, in
2005, Bell’s invention will look something

like a gadget that might blow the
begeesus out of the loyal PC (and a lot
other gadgets). Your humble cell phone
will allow you to browse the Web at
high speeds, send e-mail, click photos,

scan pictures and send them 3,000 miles
across the globe, instruct your air-condi-

tioner to start 10 minutes before you reach
home, play high-end 3D games, watch TV,
replace your credit card by paying your bills at
the mall, help you locate your lost dog, read a
book of your choice while you are travelling, lis-
ten to your MP3s at high bitrates for crystal
clear sound... The list—and it is not even a wish
list—could go on and on.

Oh, by the way, you will also be able to talk
using the phone.

By the time you read this, we are already
half-way into getting such a smart device out
into the market. But that is the key phrase—
half-way.

Cell as credit card, and more
NTT DoCoMo, Japan’s premier mobile service
provider, debuted their cell phone-as-a-credit-
card prototype in June, but it will be some time
before cell phones replace the credit card.
That’s where the problem lies. The features are
scattered, and no single device has yet incorpo-
rated all the features. When that happens—and
it is only a matter of time—your laptop just may
become redundant. Perhaps a few other
devices, too.

Today’s high-end smartphones are equiva-
lent to the 486 PC you used eight years ago. The
new-age smartphone will
have immense process-
ing power, and play-
ing high-end 3D
games by the
end of 2006
will be passé.
This means
that RAM

The smartphone of the future will be able to play high-
end 3D games, let you watch TV on the go, replace your
credit card, help you locate your lost dog, have pro-level
video cameras… And yes, you will also be able to talk!

W

Petfrog

Petfrog, the device
featured in the

picture alongside, is an
‘Integrated Fusion
Device’ of the future as
envisaged by Frog
Design, a US-based
design company. Petfrog
is the first wireless
communication and
computing concept with
integrated hardware,
software, and content
user-interface. It is a
PDA, personal computer,
digital media player,
camera, karaoke
machine, and more. All
functionality converges
into one seamless
platform resulting in an
‘all-in-one gadget’.

Goodbye Laptop, 
Hello Smartphone!
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Rings a bell? 
The phone of the future will allow you to: 

Browse for movies, music, photos and slide shows right
from your TV. 
Listen to your MP3 collection on your home stereo. 
Watch feature-length movies from the Internet in the
comfort of your living room. 
Use catalogs to quickly access related content.
Synchronise - Connect to your Windows-based PC and
you can take your content on the go with you.
Publish - Using the Content Server on your PC, 
publish catalogs to other users. 
Browse - Browse through your content on more than
one PC or a network.
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capacity will shoot up, and we may see the
emergence of a graphics card that’s beyond our
current imagination of a mobile phone. 

Around the same time, the touch pad will
become de rigueur for most phones. A graphics
artist will have powerful image applications on
his phone, the compulsive document creator
will be able to create presentations on the fly

(you can do that even now, but with certain
restrictions), and the field executive will
have all the software needed for such
things as e-mail and contact informa-
tion. Good-bye laptop, hello smart-
phone.

By this time, voice would be the
default way to dial, not just numbers, but

also Web sites and e-mail addresses. The phone
cradle will evolve into a docking station capable
of communicating via Bluetooth, with all kinds
of devices: keyboards, mice, monitors, and so
on. The device will have expansion slots or
adapters for memory, other I/O devices such as
a touchpad, tablet, etc, an external camera, and
a game console. A pull-out module will have a
keyboard and trackball, and there should be a
slot for a laser projection keyboard. 

A large hard disk capacity should allow
users to record TV programmes as well as video-
conferences conducted using the phone. With
two displays, it will be possible to do more than
one thing at once—for example, talking while
surfing, or talking while jotting down notes.

Quad-band phones
Phones by then would have become quad-band, a
development that would not raise any eye-brows
whatsoever. A new chip allows phones to choose
what protocol—WiFi or 3G, for instance—is best
suited for communication in a certain area;
such chips will become routine, and phones will
automatically select the network that’s best to
talk to another device. Synchronising with PCs
will be seamless, and input will be Bluetooth-
enabled and seamless too: phones will feature a
wireless Bluetooth-connected smart pen for
handwriting-recognition, and a cordless headset.

The big question when it comes to enter-
tainment will be: will personal entertainment

devices become obsolete if phones become a
complete audio-video solution, suitable for
audiophiles and videophiles? A device that can
do this will double up as an MP3 player and FM
radio, iPod-style.

The second display will be a high-resolution
one, for TV, games, and so on. The camera,
meanwhile, will be capable of up to 6 megapixels
(and more, later) by end-2005. There will be a
slew of models that feature videocams, and these
will have an extra flip for the videocam preview.
High-quality stereo speakers will complete
the audio-video subsystem.

Scanners will also become part of the
phone, to help people instantly scan tele-
phone numbers, names, URLs and e-mail
addresses, in addition to barcodes.
Future smartphones may also incorporate
SIM chips that can be used to scan and pur-
chase items from supermarkets, with the correct
accounts automatically being debited or credited.

By then, the phone would have become part
of our clothing, and that would make conver-
gence take on a whole new meaning! 

ram_mohan@thinkdigit.com

The Indian Connection

It will not be long before India hops on to the
smartphone bandwagon. Officially, that is. Even

though it’s discouraged by authorities, the grey
market still brings in most of the latest products from
across the world. For instance, the Sony Ericsson P900
and the PalmOne Treo 600—both among the best in
the currently available smartphone category—were
already available in the grey market before they were
launched officially.

Officially, though, look out for the Panasonic X700,
which will be launched simultaneously in India and
Europe. LG is not far either: It recently launched the
G7100, the “first ever camera phone with a 270-degree spin screen and a
slide-mounted VGA camera”, according to P Valecha, Product Group Head,
mobile phones, LG Electronics India.

Harit Nagpal, chief marketing officer, Hutch, says it is a given fact that
smartphones will make it big in India. “The smartphone category is a niche,
albeit a growing one, in India. The mobile will become the single access
device delivering a host of wireless services—whether it is for voice
telephony, a stock trading desk, a game console, whatever you want. We
are seeing a movement towards a single access device.”

You are going to
have the
equivalent of a
persistent T1 line
in your pocket.
That’s it. It’s going
to happen 
Jeff Hawkins
Inventor of Palm Pilot

What and When... Digit peeks into the future

Late 2004
Camera resolution and
focus will improve, and
the 3-megapixel camera
would make an
appearance. Samsung
already has a prototype
out.
Phones will double up
as MP3 players and FM
radios, with hi-power
outlets for headphones.

Mid 2005
Videocams will become
part of standard
equipment.
Phones will be equipped
with scanners that  can
read phone numbers,

business cards, e-mail
addresses and URLs,
and dial them.
If RFID takes off, its
modules might be
incorporated into
smartphones, and you
will be able to read
barcodes with your
phone—and make
purchases from
supermarkets with the
accounts being debited
and credited seamlessly.

Late 2005
Speech modules will be
more comprehensive,
allowing for speech-
based typing, and

indeed, everything
that’s speech-based.
Applications will
become more advanced;
the move will be
towards ‘more of a
computer’, with hard
disks storing all data.
Pull-out modules with
keyboards and
trackballs will become
more common.
Chips that seamlessly
move between wireless
and cellular protocols
will become ubiquitous.

Mid 2006
Fingerprinting
technology to identify

the user of the phone
and preventing theft will
be more advanced;
currently, these systems
can easily be foiled with
the right knowledge.
GPS connectivity will
become a more
universally available
option, with maps being
displayed on the phone
that aid in driving and
even walking to your
destination.

Late 2006
3D displays will become
common.
Most phones will come
with a cordless earpiece-

mouthpiece combo.
Remote controlling of
household appliances
will be a feature that
several models offer.
The phone will be closer
to replacing laptops—the
device will dock to
peripherals wirelessly, a
la laptops, through a
docking station. Laptop
use will have reduced
dramatically.

2007
Advanced image-editing
and other such software
will appear. Virtual, or
projection keyboards will
be standard.

Sony Ericsson P900



30 days with...

The Apple iPod
Sachin Kalbag

A
week after the Apple iPod Mini was
launched in New York early this year, a
grand total of 100,000 pieces were
sold, easily making it one of the fastest

selling gadgets of all time. iPod Zombies were
just about everywhere. I hoped to the Lord
Almighty that I would become 
a part of this exclusive club.

Here is an account of my introduction to,
interaction with, and finally introspection of
the world’s coolest personal music player. 

sachin_kalbag@thinkdigit.com

Day 1

The iPod arrived today. My wife’s gift.

I said: “Oh my god, it is whiter than I

thought.” I also had mixed emotions—I have

the iPod, but it’s the 15 GB version. Only

3,700 MP3s. But as they say, a Rolls Royce is

a Rolls Royce, whether it is 10-ft long sedan

or a 25-ft limousine. I gulped my gigabyte

greed and accepted life. The 15 GB version

costs $300; a 20 GB comes at $399, and a 40

GB even more. Can’t afford it!

Day 2

Today was “Impress your Friends and

Colleagues Day”. The iPod made more news

at office than Sonia Gandhi. Thank you,

Mr Andy Warhol; I got my 15 minutes of

fame today. Even the big boss, who goes to

San Francisco with the same nonchalance

as others visit Bhopal, asked about it. 

The office walls looked green today.

Day 4

Time to load existing songs into the iPod.

First search for the USB cable. Damn! Wife

did not buy the USB cable. “The USB cable

would have cost $50 more.” Yikes! I had to

search for a FireWire port to insert the

FireWire cable. Finally found one. All I had

to do was transfer songs to that laptop, and

then listen at leisure. I will do it tomorrow. 

Day 5

The transfer from a Windows PC was not

easy. When installing the iTunes software,

I saw a Network Error dialog box. A network

error? I continued. The install stopped in

between. No dialog box this time. Remember

King Bruce and the spider? Tried again.

Success. iTunes installed. 

Day 7

I converted my audio CDs into the iTunes

format. Complicated process. Something 

new crops up. How do I create folders in

iPod? Hmm... 

Day 10

Transferring my “huge” collection of 900

songs took me 23 minutes. Finally, the 

sound of success. I rotated the touch-pad

dial. It gave me options, but I wanted to

keep it simple—I just played the songs at

random. I have heard good sound systems

before, but the iPod takes the cake in

personal entertainment.

Day 18

Tried creating folders again. Failure. How

do I do it? Think. Think. Looked up Amazon.

A whole new iPod industry has risen out of

nowhere. Blogs, review sites, fan sites,

assorted accessories, including the really cool

iTrip that converts your iPod into a local

radio station. How cool is that! It costs $40.

Someday, someday…

Day 22

I had almost forgotten my iPod. I refused to

let it out. What if it is 
endangered by

accidental falls? The iPod has a hard disk,

and can go kaput if it fa
lls.

Day 28

I revisited my iPod. Still pristine white. Look

at the scratches. Sacrilege! Almost had a

cardiac arrest. Never share the iPod. It also

began skipping five seconds. I was scared. I

used the Microsoft principle on an Apple

product—restarted. It worked. God exists!

Day 30

I finally figured out how to make folders.

It was raining outside. Euro 2004 was 

on. Rain outside, live football inside, iPod

music in my ears, and finger chips 

within reach. How’s that for a state of 

male nirvana?
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Geek Dreams

Thrustmaster Enzo Ferrari PC Gaming Wheel

Thrustmaster Force Feedback GT Racing WheelW
e don't yet know whether this beauty will become the Enzo

Ferrari of the PC gaming world. What we do know is that it

has some of the world's best Force Feedback effects, an 8

way D-pad, 9 action buttons, progressive gas and brake control with

two wheel-mounted levers and stable analogue foot pedals, two wheel-

mounted gearshift levers, and a central clamping system. Besides, it

also has a radio frequency unit to control the gadget, so you can might

as well say goodbye to the messy wires.

For a mere matter of a yet-to-be-decided price point (knowledgeable

sources say $100, or Rs 4,600), you also get the official Ferrari logo on

the wheel. Why? Because, my dear sir, this is the exact replica of the

original Enzo Ferrari wheel! 

Smell burning rubber, already?

DIGIT AUGUST 200444
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Wide The 1000 MB capacity captures your 
attention, but in truth the huge storage is
only the foundation for GMail. When

Rediff offers 1024 MB free, and Yahoo!, Hotmail,
etc. chip in with their few hundred MB sops, it is
not the same—they still have a folder hierarchy
based interface that will not scale. Google
throws away the folders in favour of Labels. You
can ‘apply’ several labels to a mail, as opposed to
‘putting’ the mail into one folder. Once you get
used to labels, folders will feel decidedly primi-
tive. The concept and the technology have been
languishing for decades, but Google is the first
to implement it on a scale that makes a differ-
ence. Score one for Google. 

The GMail interface is one huge JavaScript
file, weighing in at around 250 KB. Sign-in and
wait while this downloads. But once it is on your
computer, the interface is simply blazing. The
JavaScript processes all your clicks right on your
computer, instead of relying on the server to
decide what to do next. The only data needed
from the server is your e-mail contents. Contrast
this with almost all other Web-mail applications
that force a full page reload on every click.
Yahoo! recently bought Oddpost, the guys who
first made this concept work for e-mail way back

in 2000. This inter-
esting approach
does have it's acces-
sibility drawbacks
though, and Mark
Pilgrim does a great
job of presenting

them at http://snipurl.com/7ryx. These kinks,
too, will eventually be sorted out, and you can
safely credit Google with bringing yet another
useful technology to front and centre. Welcome
to the next wave of browser-based application
interfaces. 

Put a fast text-only interface, together with a
flexible cutting edge organisation model, bring
to it Google’s history of hackery and top it off
with “Invite Only” exclusivity and you have the
perfect recipe for a Geek popularity contest.
Enough has been said about the ridiculous
extents to which profiteers took this opportuni-
ty. Now that Google invites are worth about as
much as two free Yahoo! accounts, that side-
show is finally winding down. 

Meanwhile, the geeks who did get these
accounts early on have been busy making them
more useful. Soon after GMail launched, there
was an explosion of utilities, many for things
you could already do with existing Web-mail
services and some unique to GMail. Mark Lyons,
an independent programmer, says “As an e-mail
packrat, I jumped at the opportunity to have all
my e-mail easily searchable.  I decided to import
my old e-mail from Netscape Communicator 4.7
(which had messages in it dating back to 1994).
There was no upload feature included with
GMail, however. So I wrote one.” 

Even in using it as just another Web-mail
service, you will find the GMail bookmarklets
http://snipurl.com/7ryw handy. GmailTo will sim-
ply pop-up a GMail compose window, . GmailIt
goes a step further—it will set the subject line to
the title of the open Web page and put its URL in
the body. The tiny GTray utility http:
//snipurl.com/7ryt will sit in your system tray and
keep track of new mails in your GMail account,
like any e-mail notifier. 

If you like GMail enough to switch to it as
your primary Web-mail provider, you may want
to migrate mail from your existing Web-mail
accounts to GMail. One neat way to do this is to
chain a tool such as the free Yahoo! POPs
http://snipurl.com/7ryp with a mail redirection/
forwarding tool like the free Mail Redirect
http://snipurl.com/7rys. Mail Redirect will down-
load mails from your Yahoo! account through
YahooPOPs and transfer them to you GMail
account. Migrating from Hotmail is even easier
with the free GetMail for Hotmail http://
snipurl.com/7ryn, which does this in just one
step!

You can turn your GMail account into a stan-
dard POP3 account and download mail from it
using a regular desktop email client with tools

such as ‘Pop Goes the GMail’ http:// snipurl.com/
7ryj or FreePOPS http://snipurl.com/7ryl with the
GMail plug-in. Of course, that will completely
negate the advantage of the new e-mail inter-
face. Depending on your situation, moving your
mail from your local mail client to GMail might
be a better idea. Mark Lyons' GMail Loader
http://snipurl.com/ 7rx2 is probably the best tool
around for this. While it directly supports
Mozilla/Thunderbird, Eudora and many Unix
mail clients, Mark shows workarounds for oth-
ers such as Outlook.

Filling up a 1000 MB mailbox would usually
take some time, but Aaron Pratt filled his up in
about a month. He used his GMail account to
run a public experiment http://snipurl.
com/7rxh to test GMail’s spam filter. If you are
in a hurry to fill up your 1000 MB with some-
thing more useful than spam, you could try the
GMail backup script http://snipurl.com/7rxt. You
can use it to save files to GMail and download
them if the need ever arises. 

Put these tools to work and your GMail
account becomes much more useful than what
you got when you signed up, and they work
with standard Internet protocols and open-
source contributions—in keeping with the hon-
est hacker ethic.

But there is a little catch. You can’t legally
use most of these tools. The Gmail Terms of Use
states in Clause 5: “You also agree that you will
not use any robot, spider, other automated
device, or manual process to monitor or copy
any content from the Service.”

Google is just another big corporation,
after all. 

Angle  

Sumod Hajela

Sumod Hajela, Associate
Editor (Technology) is Digit’s
Alpha Geek. His pastimes
include creating new software
during lunch hours, and
mastering just about every
computer-related technology
that there is. Write to him at
sumod_hajela@thinkdigit.com

Google Gets the Geeks Going
Let alone leading the race for the
1000 MB storage space, Google has
been enterprising in replacing 
folders in the mail box with ‘labels’
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First Hand

Upendra Singhai

hiv Manas’ flat in Mumbai’s upscale
Colaba area could be just about any other
accommodation allotted to senior

government officials—his father, Damodar Das,
is chief marketing manager at Andhra Pradesh
State Road Transport Corporation. It is 
larger than most flats in Mumbai, is subdued,
and has the quiet elegance of any south 
Mumbai apartment. 

Shiv, 18, is a second-year engineering student
at a Navi Mumbai college. He has a lot of friends
in college, and spends most of his time with
them. His online nickname: [DeXter]. Yes, includ-
ing the capital X and the brace brackets. “I don’t
want to get into some copyright problems with

Cartoon Network,” he says tongue-in-cheek.
At home, however, he is a different creature.

On a day when there is no college, he spends
around 18 hours a day on his trusted PC. His PC
room is also his den, a place from where he
controls his home’s security system, which he
built on his own.

Guests at the Das household have gotten
used to ringing the bell and Shiv getting an 
e-mail notification, or an alarm bell ringing (if
the person at the door is expected beforehand,
then the PC is programmed in such a way that
the guest hears a welcome sound), or a call going
to the Das mobile phone if they are not at home.
Depending on Shiv’s whim, the PC also sends
him an SMS, pages him or sends him a fax.

He calls it a trigger-based security system—
he is yet to name his small innovation—and by
now his parents are so used to it that they don’t
even talk about it. 

All that Shiv uses is a joystick, an IVR soft-
ware and a little bit of programming.

How does it work?
The trigger-based security system is just that,
but it’s Shiv’s clever programming that makes
it what it is. 

If Shiv wants to step out of his house, he
enables the system such that whenever a door
or window opens or shuts, a switch or a trigger
attached to it—a joystick, in this case—gets acti-
vated, and PC reacts as programmed.

The triggers are connected to the PC through
the game (MIDI) port on the sound card. He has
also developed a program that detects any move-
ment by constantly monitoring the game port
for ‘On’ and ‘Off’ signals. Says Shiv: “An ‘On’
signal means the door is closed, and an open
door gives an ‘Off’ signal.” When someone enters

Laboratory
You know the cartoon character. Now meet his real 
life doppelganger. He guards his lab... er house 
with joysticks and writes programs to close windows
and doors!

S

The IVR Touch - Shiv’s Creation

[DeXter]’s

The user puts a call
through. The phone is
connected to the modem
on the computer

IVM, a software
from NCH Swift
Sound, plays the
role of an answer-
ing machine and
handles the call

Dialling a specific
access code makes
the software enter
the Interactive Voice
Response mode

The user can now execute
commands to run an anti-virus
scan, or even restart the
computer

IVM iterfaces with the
VB application as well.
Thus, a user can check
the status of doors-
which door is open,
and which is closed
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Shiv Manas

Write in

Assembled some-
thing just as geeky? 
Tell us about it. 
Write to firsthand@
thinkdigit.com



close a door if it has been left ajar due to wind. 
Get the PC to set off an alarm if an individual
uses the PC beyond the allotted time. 
Get a phone call if someone tries to switch off
the PC.

Future track
Shiv says that this system can be upscaled in
terms of hardware as well as ideas, although it
will be some time before this happens. 

For instance, it could ask, “Who is this?”
when someone enters the room. The person
could then speak into the system, which will have
a voice-recognition software that will convert
speech into text and send an e-mail to you. 

You could also control electrical appli-
ances through the PC, or a phone, or even
through e-mail. The possibilities are practi-
cally limitless. 

upendra_singhai@jasubhai.com
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a protected room, the trigger gets activated and
the program alerts the user.

The good news: this system is scalable up to
eight triggers from a single port. 

Manas has added a smart touch -- an
Interactive Voice Response (IVR) program that
alerts him if there is a ‘security breach’. The 18-
year-old explains: “When nobody answers a call
at home, the program picks up the call and
behaves like a regular answering machine.
However, when I dial a number assigned to the
security system, the program behaves like an
IVR system. I have a choice of either remote
controlling the computer or the security
system. The program then tells me whether
there has been a security breach or not.”

The program itself is customisable—you can
write it to sound an alarm, send an e-mail to a
predefined address, and so on. The activity log
lets you take a look at everything that’s been
happening since you left the room.

Customising can be done in great detail.
Shiv will be able to:

Receive an e-mail (or an SMS) every hour
detailing the scene at home while he is out
gallavanting.  

Disable the system via a phone call at a time
when a guest is expected. 
Program the system to identify window move-

ment in case it’s quite windy. Perhaps even

‘I want a laser-switch system next’

Why a trigger-based
security system?
My mom suggested the
idea of a burglar
system. As for the trig-
gers, I thought using
them would be inter-
esting. Ifelt it was way
out of the ordinary.
How long did it take
to put this together?
It took just a day.
Are you just another
geek?
When I don’t have to
go to college, I spend
16 to 18 hours on my
computer. But I have
other hobbies like

collecting coins and sports cards. I play the
piano and the tabla. I also dabble in painting
occasionally. Besides, I love to spend time with
my friends. Most of the time, though, we talk
about technology. And yes, I plan to become a
systems administrator.
When you are with your friends, do you use
technology terms as swear words?
(Laughs) Not really, but whenever I am irritated
by some conversation, I start reciting the value
of Pi (3.1415926… which goes on and on and
on). The person usually shuts up.
What’s next?
I want to put together a laser-switch based
security system—the stuff you see in movies. 

How it’s Trigger-Secure

First Hand

The door is connected to
an ‘on/off’ switch When a door is

opened, the circuit is
switched ‘off’ and the
signal is passed to the
joy stick

One joy stick can
handle 4 such doors.
It receives the signal
from the switch and
passes it on to the
computer

The Visual Basic applica-
tion receives the signal
and takes the predefined
action, such as ringing the
alarm, or sending an 
e-mail

ALARM PHONE CALL E-MAIL MUSIC
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Conmen using phony e-mail
messages and fraudulent

Web sites lure victims into
giving away critical financial
data online. Often, phish scam-

mers pose as PayPal, the popu-
lar tool for international online
commerce payment. Users are
fooled into revealing their 
credit card details when they
try to buy online on Web sites
that look real and have credi-

ble-sounding domain names.
On an average there are around
3000 phishing attacks across
the world every month, says
the Anti-Phishing Working
Group, a body sponsored by
Microsoft, among others. 

Phish Scam

Here’s my musketeer!: Shiv with his security system
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Saurabh Kumar

s the world goes belliger-
ent on outsourcing, and
big companies in India

make money that would make
traditional big ticket manufactur-
ing outfits cringe, a diminutive
company in New Delhi is quietly
creating a small revolution. It is
earning projects from across the
world—not by sending project
and account managers on whirl-
wind US trips, not by advertising
on prominent online sites, and
not by having a huge staff on it
business development team.

It relies on the old faithful—
the World Wide Web—for procur-
ing new projects and earning
money. In dollars.

At last count, Synapse
Communications, the
company in question,
had earned nearly
$85,000 through over-
seas projects using a
Web service called
elance.com, a Web site
that launched in 1999,
and is today an
acknowledged leader in the
Services Procurement and Mana-
gement market.

In English, this means that
you, as an individual or a
company, can bid for a project in
various categories—software,
creative writing, photography, 3D
graphics, image editing, Web site
design, banner ads, logo design,
the works. Think of any topic, and
Elance Online allows you to place
a project or bid for one.

Just about the right raw mate-
rial you need to jumpstart your
earnings—as an individual or as a
professional outfit. Synapse
Communications, for instance,

has been a software
development company
for over eight years, but
as Chief Operating
Officer Kapil Gupta
says, “Elance provided
us with a focused plat-
form. We have been
growing at a rapid pace,

and Elance Online has provided
us with good business opportuni-
ties.”

Elance was set up by an IIT
Bombay graduate Beerud Sheth
in 1999, a year after two Harvard
Business School scholars—
Thomas W Malone and Robert
Laubacher—published an article
in the Harvard Business Review
titled, “The Dawn of the E-Lance
Economy.”

Among other things, the
article spoke about how “the
devolution of large, permanent
corporations into f lexible,
temporary networks of individ-
uals” was already underway.
They also wrote about how the
Internet will lower business
transaction costs, and how
these lower costs will change
the “economic equation.” They
bravely predicted that this kind
of business will define work in
the 21st century.

Based on this philosophy,
Sheth (also a Massachusetts
Institute of Technology postgrad-
uate) and his Elance team created
their first product—the Elance
Online Service Marketplace—in
1999. Ever since, it has been the
link between thousands of busi-
ness and service providers from
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A Web of Opportunities
New Delhi-based firm Synapse
Communications earned more than 
Rs 40 lakh by bidding for 
worldwide projects online. 
Are you next?
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requires that payments be
routed through them. “But
Elance does not provide any
guarantees since they simply act
as a common meeting ground
between the service providers
and the buyers. About 40 per
cent of payments on Elance
result in defaults.”

On the positive side,
however, the site offers a well-
defined selection of the most
popular job categories—from
photography to developing .Net
applications. And since most of
the work is done through the
Net without any human interac-
tion, it does not really matter
how educated you are, or how
big your company is, as long as
your work is credible and is of
the highest quality.

Indians, especially, love this
site because western project
managers tend to give big proj-
ects to Indians, because they
quote rates that are 50-70 per
cent lower than their American
counterparts for the same qual-
ity of work, if not better. Sounds
familiar? The outsourcing
debate just got a new point

saurabh_kumar@thinkdigit.com
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Jumpstart

all over the world.
It is not easy getting a proj-

ect, though. For every assign-
ment, there are likely to be
several bidders, and the experi-
ence each time may not be a
pleasant one. Says Gupta,
“Getting projects on Elance
Online is a mixed bag. Because
the client is on the other side of
the world, and we never meet, it
does create issues at times.”

The process, although seem-
ingly easy, is not fixed; it varies
from project to project, and most

times you end up disappointed
as the project may be awarded to
someone else. Your experience at
Elance itself counts, and it
usually takes that one break-
through to get you set. As Guptra
says: “Each project and each
client is different. There is no
single way that can describe the
steps from start to finish.”

Not that Elance Online is the
only site that caters to free-
lancers from across the world.
For software programmers and
creative professionals, sites such
as Guru.com and renta-
coder.com have been around for
ages. Guru.com, for instance,
has a tie-up with remit2india
.com where you can collect
payments from clients abroad.
Rentacoder is free, but is
restricted to small projects that
could be executed by individual
programmers. This is one reason

why Synapse does not
bid on
rentacoder.com.

On Elance Online,
the cost of bidding
could be quite high,
even if the returns over
a period could be
higher. Prices range
from $12 (Rs 560) a
month for writing and
translation assign-
ments to $1,195 (Rs
56,000) a year for soft-
ware, technology,
design and engineering
categories. In addition,
there is an 8.75 per cent
service charge. Besides,

even if the first wire transfer of
funds is free, each incremental
transaction would set you back by
$10. This pricing mechanism
allows Elance Online to keep the
site free of any riffraff, although
there are still some who do not
honour their commitments.

Another problem, as Gupta
points out, is that Elance

Elance is all about open 
opportunities. There is no hard
and fast rule to get a project.
You need to keep on striving.
Kapil Gupta
COO, Synapse Communications Pvt. Ltd.
Used Elance.com to jumpstart his business
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Choose from a variety of projects from 
different fields

Browse
through the
open projects

Bid to work on a
project and quote
your expected fees

If selected, the buyer
pays the Web site the
fees, and you begin
work 

When work is
completed, the
buyer approves the

Completed work is
handed over to the
buyer

7
Web site releases 
payment to you minus
the service fees

The seller may
choose you or
other bidders



Enhance

Meera Vankipuram

un Microsystems’ Net
usability guru, Dr Jakob
Nielsen, calls the Internet a

procrastination apparatus. We
agree, and perhaps can even add a
corollary—it also teaches us to
always find the easy way out, more
so when it comes to research.

The World Wide Web is both an
information treasure house, and a
well-laid trap. 

Reliable, credible research
comes at a premium, and finding
the right place on the Web can be
tricky. Professional research sites,
hence, assume even more impor-

tance—they are credible and can be
quoted in your internal research
papers, presentations, forecasts for
market growth, etc. 

Since they are created by inde-
pendent industry experts, the
research is reliable. Academics, too,
publish journals that are posted
regularly on the Web. 

One research site that is not an
academic enterprise is about.com,
which has information neatly cat-
egorised, and each category and its
topics are lead by experts in a spe-
cific field—all of whom are care-
fully chosen through a strict
screening procedure. Unfortu-
nately, for most of us,
searching for anything on
the Web, starts and ends at
Google.

But Google, for its ver-
satility and immense
intelligence, has its
limitations (see box:
Five Reasons Why Google
Doesn’t Always Work).

Perhaps metasearches

and specific research sites make
more sense.

For instance, vivisimo.com, a
metasearch site that aggregates
content from various search sites
and collates them in order of rele-
vance. Researchers across the
world swear by it, and it was rated
second, only to Google, in a survey
by about.com, conducted in May
2004. Let’s focus on research sites,
however, and look at six sites cov-
ering different professional fields:

IT Papers
www.itpapers.com
Arguably one of the largest online
libraries for technical white papers,
Web casts, and case studies. Itpa-

pers offers free membership, and
lets you access downloads, detailed
descriptions, and personalisation
features. You can also request for
white papers from this directory,
and contact vendors directly as
well. Information technology
topics include data management,
hardware, Internet, networking
and communications, software,
security, platforms, OS, etc. 

Academic Research
www.academicresearchpapers.com

Its simple interface deceives
you—don’t let it! The site’s

zero-scroll home page has
76 primary topics of

research, and gives
access to thousands of
research papers and

documents in cate-
gories ranging from Asian
Studies to Architecture;
from Astronomy to His-

tory. This is a paid

site, though, and at $7 (Rs 330) a
page of 225 words, it seems expen-
sive. But, if you want to download
large documents, it would cost
you $133 (Rs 6,250). This site is
reasonably priced if you want
large documents that can be
accessed via e-mail, by fax, by
courier, or by postal mail.

S

For a cost that is astonishingly low, you can get the best 
research available to you at your fingertips. Here’s how
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Engineering and Commerce
www.ntis.gov/
The National Technical Informa-
tion Service (NTIS), a site main-
tained by the US Department of
Commerce, is a resource for scien-
tific, technical, engineering, and
business related information. The
site provides information on more
than six lakh information products
covering over 350 subject areas
from over 200 federal agencies. 

The products are available in a
variety of formats—online, multi-
media, CD-ROM, paper, and micro-
fiche. Archival records can be
accessed for a nominal fee. NTIS
offers information on computer
products, databases, multimedia,
IT-based publications and reports
and related information. 

Media and related issues
www.poynter.org and www.media-
management.org/
For most practising media profes-
sionals, Poynter is nothing short of
being the Bible. It has some of the
best resources you could ever ask
for—columnists, white papers,
skills upgradation workshops, ana-
lytical essays, and contributions

from the best journalists and edi-
tors from across the world. It has
extensive writing on publishing
design as well as media on the
Internet. For the most part, it is
free, funded by the US-based
Poynter Institute. 

Net Academy, on the other
hand, is one of the first sites set up
to collate research on media man-
agement, a concept so new that
there is no established common
body of knowledge. At the funda-
mental level, Net Academy is a net-
work of research communities,
each of which “accumulates, dis-
seminates and reviews academic
content and activities according to
its own organisational principles
and quality standards.”

Net Academy was established
by the University of St Gallen in
Switzerland to promote research in
media management, and will take
some time to achieve a high degree
of depth, but it is a beginning that
took a long time coming. 

Business Management
www.businessintelligence.com
Business Intelligence is a compre-
hensive management resource site
with extensive research on busi-
ness performance management,
reporting, analysis, customer rela-
tionship management and data
management. To access its research
papers, you need to register (it’s
free), after which you are sent the
requested paper via e-mail.  With
detailed sections on news,
research, various business articles
from the best magazines, Business
Intelligence is a complete business
management site.

meera_vankipuram@thinkdigit.com

Statistics related to India
www.indiastat.com
Even if information about India is
available at different sources, it is
difficult to collate credible infor-
mation. Welcome to Indiastat.com,
a comprehensive resource on India-
specific, socio-economic statistics
“culled from various secondary
level authentic sources.” The site is
a research aggregator, providing
analyses and condensed statistical
data from several sites. 

Indiastat.com is a paid site,
accessible only on to bona fide
researchers, academicians, aca-
demic institutions, NGOs, libraries,
government departments and cor-
porates. Topics include demo-
graphics, crime, foreign trade,
media, telecommunications, edu-
cation, geographical data, etc.

The good news is that there
are over five lakh pages of statis-
tical data that has been quantita-
tively analysed, and each can be
downloaded in MS Excel or HTML
formats. There are weekly updates
to most of the figures provided on
the site. All the new updates are
methodically presented on the
home page making it easy for any
subscriber to understand. 

Single user access on India-
stat.com costs Rs 8,000 for
researchers and academicians, and
Rs 11,000 for other individuals,
whereas two-user access for gov-
ernment departments and NGOs
would set you back by Rs 15,000.
Two-user access for individuals
costs Rs 17,500. 

IT research papers
www.bitpipe.com
Bitpipe Library, an award winning
site, has everything in IT, ranging
from white papers, product litera-
ture, Web casts and case studies.
Its modus operandi is quite
simple—it collects research mate-
rial and distributes it to over 3,500
worldwide vendors and maga-
zines such as Information Week,
Network Computing, Forbes, etc.

What’s on offer

Academic
Research Papers
lets you order
term papers
custom-written by
experienced
professionals

Bitpipe’s ‘Hot Topic’
section features
exhaustive information—
including white papers,
product info, and Web
casts—on a specific topic

Poynter’s Resource
Centre provides links to
archived news stories,
tip sheets, and other
media-related
information

Business Intelligence
provides access to
research papers on a
wide variety of business-
related topics
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More often
than not, free
research does
not carry
valuable up-
to-date
statistics or
specific
insights I am
seeking
Mohan
Krishnan, 
Content Specialist

Five Reasons Why Google Doesn’t Always Work

Google is not a meta search engine 
A meta search, simply put, is a search of
searches from various resources on the Web.
There are meta meta searches which search
meta search engines as well for greater detail.
Google takes only 10 words in its search field
Meta search engines have the ability to search
entire paragraphs, leading to greater accuracy.
Google searches based on PageRank
Google’s searches are based on how many sites
have linked to a particular page. This means
that new, yet relevant Web sites will get left out
of the initial search results.

Google throws up linear search results 
Google, for all its intelligence, does not
categorise search results, making it a uni-
dimensional search site. Try vivisimo.com, and
see how the results are multi-layered giving it
all the depth a research site needs.
Google does not have domain expertise 
This means that if you are researching Apple (as
in the computer company) or Cricket (as in the
game), it is likely that the results you get will
include the fruit or the insect. Get the picture?
Research sites, on the other hand, are domain
specific, and can throw up results most specific.
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Robert Sovereign-Smith

Finally! A dot-com (www.
irctc.co.in—dot-co-dot-in, in
this case), that actually helps

us commoners, those of us with
credit cards, or bank accounts with

Internet banking facilities. The
Indian Railway Catering and
Tourism Corporation (IRCTC) Web
site takes away the drudgery of
booking Railway tickets. Enter
details, such as your name, date of
birth, your home and office
addresses, e-mail
address, and
choose a user-
name and pass-
word. Log in
using your user-
name and pass-
word and start
the process. 

Click on the
‘Plan my Travel’
link under the
header Book
Ticket on the nav-
igation bar. Now
choose the ‘From’ and ‘To’ station
codes, if you know them. If you don’t
know the station code, click on the
little engine logo on the right of
each field to search for stations.
Once you find the correct station
codes, enter them and choose the
date on which you plan to travel,
then the Class you want to travel by,
and click on Go. Next, you’ll see a list
of trains to choose from, all span-
ning the stations
you want. Now
you can check
the radio button
next to the train
of your choice
and click any of
the buttons
below. The Book
Ticket button
takes you
straight to actu-

ally booking the
ticket; the Get
Fare button will
show you how
much you will
be paying for this
trip; Show Avail-
ability will tell
you whether
seats are still
available; and
finally the Show

Route button will show you all the
stations the train stops at, and at
what respective time.

Once you have checked the avail-
ability, and the fare, you can click on
Book Ticket. Here, you will have to fill
in the details of each traveller (up to 6
people), and choose either to deliver
the ticket to your home, office, or to
another address. After this, you have
reach the final step of the booking

process. Your
booking details are
shown, and if every-
thing is fine, click on
Make Payment. You
will see a popup that
will let you choose to
pay by credit card, or
by the various banks
that let you pay via
their Net banking
services. 

Netgain

If you choose to make the pay-
ment through the Internet Banking
facility, then simply choose your
bank in the window that pops up
when you click on Make Payment.
You will be taken to the Web site of
your bank, where you go through
the standard online payment proce-
dure. Once you are done, you can go
back to the IRCTC site and click on
Booked Tickets to see if the tickets
have been booked.

If for some reason you don’t see
your tickets there, click on the Failed
Payments to see whether your
transaction failed due to some
reason. In that case, you will have to
go through the above procedure
again. Hey, nothing’s perfect!

robert_smith@thinkdigit.com

IRCTC.co.in

Making the
payment
If you are paying
by credit card,
select either of
the three
options—ICICI
Bank’s gateway,
Citi Bank’s 
gateway, or the
American
Express gateway.
You’re taken to a
secure site
where you enter
your card
details. Your
order will be
confirmed and
then you’re
directed back to
www.irctc.co.in

Enter the travellers details

Choose your payment gateway

Delete the ordeal of
booking train tickets
from your memory…

Choose the train you want to travel by

Create an account to use the site



Rows to Column or 
Vice-versa

If you want to inter-
change the data in rows

to columns and vice-versa,
select the cells containing the
data and press [CTRL] + [C] to
copy them to the clipboard.
Now click the first cell where
you want to paste the data
and go to Edit > Paste Special.
In the dialog, enable the
checkmark Transpose and
click OK to paste. 

Separating Last Name
and First 

If you have a field that
contains entire names,

but what you need instead is
two fields containing the first
name and last name sepa-
rately, use the Convert Text to
Column Wizard. 

To access this wizard,
select the data and then click
Data > Text to Column. In the
first screen of the three-step
wizard, you will be asked to
chose if your date type is
‘Delimited’, or ‘fixed width’.
Check the choice applicable
and click Next. In the next
screen, if your date type is
‘Delimited’ choose the appro-

priate delimiter or the char-
acter that separates the first
and last names, and then
click OK. In the final step,
select the destination box and
click the destination cell, and
finally, click Finish.

If you are feeling adven-
turous, you could try either
for the following two com-
mands: 

1. =LEFT(A1,FIND(“,”,A1)-1)
assuming the name is in cell
A1 and the first name and last
name are separated by a
comma. 

2. =MID(A1,FIND(“,”,A1)+
2,255) to extract last name.

Want a 
Special Character?

The characters * or ‘ and
? have special meaning

in Excel. To locate them in
your Excel file, use the Find
and Replace dialog under
‘Edit’. Prefix them with a ‘‘ ’ in
the ‘Find’ field and search. For
example, if you want to find a
?, enter ‘?  in the find dialog.

Freeze the Title Row  
Use the Window > Freeze
Panes menu item to lock

specific columns and rows, so
that they are visible all the
time. Whenever you use this
command, the column on the
left of the selected cell, and the
row above the selected cell will
freeze. For example, if you
cursor is at cell B2, the first row
and first column will freeze.. To
reverse, simply click Window >
Unfreeze Panes.

Working on Multiple
Sheets 

If you want to enter cer-
tain data on more than

one sheet, opt for one of the
following ways:

1. Enter the data in one sheet,
copy and then paste into other
sheets. 
2. Press and hold the [CTRL]
key and click on the sheet
names near the status bar.
One you have selected the
sheets, enter data on the
sheet that is visible and it will
be entered to all sheets.
Similarly, you can use the
[CTRL] key to select multiple
sheets and then do many
other things, like running
the spell checker.

Using Validation Rules
You can limit the data
that can be entered in

cells. For example, you can
create a rule for entering stu-
dents’ marks, so that the

marks entered are within the
specified range. To set valida-
tion rules for this example,
select the cells and go to Data
> Validation. On the Settings
tab, in the Allow list, choose
‘decimal’. In the Data list,
select ‘between’. In the
Minimum and Maximum
fields, enter 0 and 100 respec-
tively. On the Input message
tab, you can specify what mes-
sage to display at the time of
entering data in those cells.
This message comes similar to
the tool tips and is unobtru-
sive. On the Error Alert tab,
you can specify the message to
display a wrong value is
entered. Finally, click OK.

Remove the Drawing
Canvas

In Word 2002 and later,
whenever you insert a

drawing object, a drawing
canvas is placed around it. It
was introduced to help you
arrange the drawings in the
document. If you prefer
working without it, you can
turn it off. One way is to drag
the drawing object out of the
canvas, selecting the canvas
and then deleting it using the
[DEL] key. There is a way to
turn it off permanently, too.
Go to Tools > Options and
switch to the General tab.
Here, clear the checkbox that
says ‘Automatically create
drawing canvas when
inserting AutoShapes’.

Change blank paragraphs
at the end of the page 

If a page ends with a
table, a drawing object

(such as a text box or text
frame) or a continuous section
break, it will be followed by a
blank paragraph. This para-
graph may force your docu-
ment to jump onto another
page. To keep your document
on one page, format the blank
paragraph:
1. Make the paragraph sym-
bols visible by pressing
[CTRL]+[SHIFT]+[8].
2. Select the paragraph
symbol you want to change.
3. On the Format menu, click
Font and then click the Font
tab.
4. Type 1 in the Size box, and
click OK.
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5. On the Format menu, click
Paragraph, and then click the
Indents and Spacing tab.
6. In the Spacing area, in the
Before and After boxes, type
the number 0.
7. In the Line Spacing box,
select Single.
8. Click OK.

Creating Styles
Using styles for format-
ting is recommended

over changing formatting
parameters like fonts, para-

graphs space  for individual
chunks of text. This allows you
to format faster and also
brings consistency across the
document.  To create a new
style, select the text that you
have formatted and want to
use as ‘style’. Go to Format >
Styles and Formatting. This
will open the Style and

Formatting task pane in
Word 2002 or later. Click
New Style in the task pane
and in the dialog that
comes up, enter the name
of the new style. Change
other options if you want
to, and click OK. You can
apply the style from the
Styles dropdown list on the
Formatting toolbar.

More text in less space  
You can fit in more
text in lesser space in

several ways. Perhaps, the
most obvious one is to
reduce the font size.
However, don’t make it too
small that it becomes
unreadable. As a rule of
thumb, anything below 9
point is a no-no. however, you
can accomplish tighter text
also by reducing the line
spacing to single, making
indents paragraph spacing
zero. You can get to all these
using the Format > Paragraph
dialog.

Using a Table of Contents 
A table of contents
comes in handy when

navigating within a docu-
ment—especially long docu-
ments. It creates and main-
tains internal hyperlinks
based on the formatting
styles used in the document.
Make sure you format the
document using the styles—
Heading 1, Heading 2, etc.
Now, move your cursor to the

beginning of your document
by pressing [Ctrl] + [Home]. Go
to Insert > Reference > Index
and Tables. In the dialog box
that pops up, go to the Table
of Contents tab. Click on the
Options button, and make
sure all the heading levels
you have used in the docu-
ment are selected. Click OK to
come back to the Index and
Tables. Now choose the
number of levels you want to
appear in the TOC and click
OK to create the table of con-
tents. You will have to press
[Ctrl] and click the hyperlinks
to follow them. To go back to
the TOC, click on the ‘Go to
TOC’ button on the Outlining
toolbar. 

If you are using Word
2002 or later, there is a sim-
pler way to navigate within a
large document. Simply click
View > Document Map and
the map of the document,
similar to Windows explorer,
will open on the left side of
document window. You can
then click the heading in the
document map to jump to
that section. It’s better to use

than TOC in many cases. 
Use Outline for entering
content quicker

Tackling both the
look and typing the

content for a presentation
at the same time can be a
bit overwhelming. Why not
try getting your thoughts
down first in the Outline
view and then build from
there? In the left panel of
the PowerPoint window,
click the Outline tab. Type
your thought and press
[ENTER]; that’s a new slide
title. You can continue cre-
ating slides and entering
slide titles by typing infor-
mation and pressing

[ENTER]. If you want to add con-
tent to a slide, press [TAB]
(instead of [ENTER]) and
PowerPoint records the text as
a bullet point. To add a bullet
within a bullet point, press
[TAB] again. You can create 
several levels of bullets, but
usually one or two levels do
the trick.

Template for repeated
presentations

If you are creating the
same presentation

layout over and over again,
you can turn your presenta-
tion into a template that you
or others can use fast and
flawlessly. A template saves all
the settings you have
selected—background images,
colour scheme, font selec-
tions, and so on—and ensures
that the presentations you
create based on that template
all have the same elements in
common. This is great if you
have a uniform companywide
look that you want all 
your departments to adhere
to. To turn a presentation into
a template:

Justify text beautifully in 
MS Word
When you apply Justify
formatting to a paragraph, Word
inserts spaces to adjust the
length of the line. Sometimes,
you may end up having too much
white space in between words. To
achieve alternative and more
presentable text justification, go
to Tools > Options and click the
Compatibility tab. In the
Recommended options for list,
click WordPerfect 6.x for
Windows. Then enable the
checkboxDo full justfication like
WordPerfect 6x for Windows
under the Options. Click OK to
close the dialog.  This spacing
adds and removes spaces, 
which normally results in
uniform spacing. 

Removing blank paragraphs at the
end of the page

Bet you didn’t know

MS PowerPoint

Creating a table of contents
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On the File menu, click
Save As.

In the Save as type list,
click Design Template.

Name the file and click
Save.

Another extra that can
really help: add instruc-
tions about special for-
mats, font choices, or video
clips in the Notes area
(under each slide), if others
will be using your 
template.

Creating a Photo Album
in PowerPoint 2002 

You can use
PowerPoint 2002 and

later to create a photo-
album presentation. To
create this, go to Insert >
Picture > New Photo
Album.  The Photo Album
dialog will open. Now click
the File/Disk button to add
any picture that’s stored on
your computer, or click the
Scanner/Camera to add pic-
tures from a scanner or
camera. Hold down [SHIFT]
to select multiple images.
Using this dialog, you can
choose the layout of the
album, convert pictures
into greyscale, adjust the
brightness and contrast or
rotate the image. When you
are done, click ‘Create’ to
create the presentation. If
you need to modify any of
these changes later, just go to
Format > Photo Album.

Reducing the size of 
presentations

When you add pictures
to presentations, the size

increases. To compress pic-
tures in PowerPoint, open the
presentation and click any
image. The images toolbar
should be visible now. If it
doesn’t appear, right-click on
any toolbar and choose
Pictures. On the picture
toolbar, click the Compress
Pictures button. If you can’t

locate the button, simply
hover your mouse over the
buttons and read the tool tips. 

In the dialog box that
appears, choose ‘All pictures
in document’ in the ‘Apply to’

field. Choose the appropriate
resolution, depending on
what the presentation is
intended for—if you don’t 
plan to print the slides,
choose Web/Screen option.
Click OK and the images will
be compressed.

Converting slides to
images 

You may want to convert
individual slides into

images, say, in order to e-mail
it to someone. All you have to
do is: open the presentation in
PowerPoint, scroll down to
that slide and click View >
Notes Page. Here you’ll see
that the slide occupies half of
the page as an image. Right-
click on this image and choose
‘Copy’. Now open any graphic
application such as MS Paint
or Photoshop, paste the copied
image there and save the file.

Colour code your Calendar 
Outlook provides ‘labels’
which allow you to

colour-code your appoint-
ments by choosing from var-
ious label types and colours.
So, with a quick glance you
get to see the types of appoint-
ments at hand.

Instead of the normal cal-
endar, your calendar can
look like the one in
labels.bmp.

To colour-code your cal-
endar, right-click an appoint-
ment, point to Label, and then
click the label you want. Or,

Schedule ‘Response to 
e-mail’ in MS Outlook
As much as you’d like to, you
can’t always respond instantly
to every e-mail message. If you
did, you’d never get any work
done. To make sure that you
don’t forget to answer
important messages, move
them to your calendar so you
can set aside a specific time to
respond, or add them to your
task list as a reminder. 
To turn an e-mail message into
an item on your calendar or
task list: 

1. Drag the message from
your Inbox onto the Calendar
icon or Tasks icon on the
Outlook Bar or onto your
Calendar or Tasks folder in the
Folder List. This will create a
new appointment item.

2. If you are moving the
item to the calendar, enter the
date and time you want to
reply and specify any
additional options you want.
(The body of the e-mail
message is automatically added
to the appointment.) 

3. Click Save and Close to
add the appointment to your
Calendar or Task list. 

4. You can drag items
between all Outlook folders,
including Inbox, Tasks,
Calendar, Contacts, and Notes.
For more options, right-click
before you drag.

Bet you didn’t know

Creating a Photo Album presentation

To
Start a presentation
Advance to the next slide 

Return to the previous slide

Go to particular slide
Make the screen blank 
Make the screen white 
Show or Hide the arrow pointer
Erase drawings on a screen
Change pointer to pen
Change pointer to arrow
Change pointer to eraser
Hide pointer and button
To get help on keyboard shortcuts

Press
[F5]
[N], Left-click, [Spacebar], 

, , [Enter], or [Page Down]
[P], [Backspace], , , or 
[Page Up]
Number followed by [Enter]
[B] or [.] 
[W] or [,]
[A] or [=]                                  
[E]                                         
[Ctrl] + [P]                                      
[Ctrl] + [A]                                      
[Ctrl] + [E]                                      
[Ctrl] + [H]                                      
[Shift] + [?]

Some useful keyboard shortcuts
Keyboard shortcuts help you work faster with any application.
PowerPoint has shortcuts too. Here are some of them:

Compressing pictures in
presentations

MS Outlook
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when you are scheduling an
appointment, click a colour in
the Label list.

Rules Rule
Outlook has a powerful
rules system to notify

when an important mail, such
as from your fiancé or your
boss, comes in. Additionally,
you can make Outlook auto-
matically move e-mail into
predefined folders such as
‘Mailing Lists’, ‘Family Mail’
and more. This will 
help de-clutter your inbox 
and make your e-mails more
manageable.

To create a rule, click
Rules Wizard. You can either
customise on the Tools menu,
one of the sample rules in
Outlook, or build one from
the scratch. Most rules
operate on messages as they
arrive or are sent, but you can
create a rule and select it to
run on messages in your Inbox

(or other folders). In fact, one
of the easiest ways to create a
rule is by using an existing

message in your Inbox. Open
the message, and on the
Actions menu click Create

Rule. The Rules Wizard will
include details about your
message, such as sender and

Readers’ Tips

MS Excel
Close Workbooks Fast

Need to leave your desk suddenly but
have 10 worksheets open in Excel? Try
this—Click the File menu while keeping
the SSHHIIFFTT key pressed on your key-

board. Excel will now reveal a ‘Close All’ menu
item, clicking which will close all open 
worksheets, while prompting for a save where
applicable.

Naveenchandran

MS Word

Customising Your “Normal” Template 
Does your work require sending large
number of letters on your letterhead? 
What you can do is open the normal.dot
template file from a path like

“C:\Documents and Settings\Saurabh Kumar
\Application Data\Microsoft\ Templates”.
Any changes you make in this document will
appear in any new documents you make in Word.
You can use the header/foother fields to add
custom letter head graphics, page numbering,
date/time etc. and these will appear every time
you open a new document.

Shortcuts to Useful Word Features 
Did you know that the status bar, that area at the
bottom of Word documents where the page
number appears, also provides shortcuts to a
number of very useful features? Here are a few
you may want to use: 

To open the Find and Replace dialog box,
double-click any location indicator on the 
status bar, such as the page number or section
number. 

To turn the macro recorder on or off, double-
click REC. 
To turn the Track Changes feature on or off, 
double-click TRK. 
To turn extend selection mode on or off, dou
ble-click EXT. 
To turn overtype mode on or off, double-click 
OVR. 
To change the language format of selected 
text, double-click Language. 

To resolve errors in grammar or spelling, double-
click the Spelling and Grammar Status.       

Smit

MS Outlook
Important Office data files

At the time of making your regular
backup, it is essential to know where the
important data files of MS Office are
kept. Here are the important ones:

.pab files are Microsoft Outlook address 
book files. 
.pst files are Microsoft Outlook mail, 
contacts, tasks and calendar files book files. 
.rwz files are the Microsoft Outlook rules wiz
ard files. 
Locate the file by using the Windows find tool.

Click SSttaarrtt  >>  FFiinndd  >>  FFiilleess  oorr  FFoollddeerrss. 
In the Named box type *.pab(or whatever you

are searching for from above) in the Look in box,
ensure it is looking on the drive that Microsoft Office
is located (generally the C: drive). Click Find Now 

This should locate the file you are looking for,
if present. Ensure that you have completely closed
your copy of Microsoft Office. Once this file is
located copy the file to an alternate drive or
backup media. 

Deep

MS Access
Automagically normalise tables

One of the most useful but unnoticed fea-
ture of Access is Analyze. It is divided into
three options. 

Table Analyzer: This feature attempts
to analyze your table for repeated data, recommends
and splits the tables to generate BCNF normalised
table structure. The tool is good for a quick survey of
the tables or for newbies, as its suggestions are usu-
ally good and based on logic.

Performance Analyzer: It analyses and suggests
modification in the structure of the database to opti-
mize the performance of database. The wizard will
attempt to locate logical errors such as incorrect
data types and more.

Documentor: This one is used to create the 
documentation of the database structure, which can
be useful and a real time saver for quick 
report generation.

waaznt

Colour coding appointments
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subject, already filled in.
All you need to do is choose
which criteria to use and
which action it should
trigger. And enter data in
steps till ‘Finish’.

Categorise to Track
Data 

Categories help you
manage your data

from various sources,  but is
a very under-utilised fea-
ture of Outlook. Each
Outlook item can be
assigned a category, either
from the Outlook’s default
set, or a custom one. Assign
your e-mail, meetings, jour-
nals entries, tasks etc. a cat-
egory, so that later, you can
easily retrieve all data
related to a particular cate-
gory, such as of your
clients’ names.

To categorise an item,
right-click the item, and
then click Categories. This
will bring up your current
list of categories. Select a
category from the Available
categories list. To create
new categories, click Master
Category List.

To view all the items that
belong to that category, you
can customise your view to
group items by category. Or
use Advanced Find to search

for all the Outlook items
related to a category.

In the Tools menu, click
Advanced Find, and then click
the More Choices tab.

Click Categories and use

the Available categories list
to select the categories you
would like to find. Click OK.
Then go to Find Now.

Search all Info Related
to a Contact

Few people ever ven-
ture past the first tab

in the Outlook Contacts
form. After all, if you are
storing information for
business contacts, just
about everything you need
is contained on the first
tab. Occasionally, you click
on the second tab to enter
a spouse’s or assistant’s
name. But have you ever
seen what the third tab,
the Activities tab, con-
tains?

The Activities tab
shows you all the Outlook
items related to that con-
tact: every e-mail, meeting,
journal entry, or task. It’s a
great way to review all
your communication with
someone or prepare for a
meeting with them. If
you’re overwhelmed by the
sheer volume of informa-
tion on this tab, you can
filter the information and
display only Contacts, E-
mail, Journal Entries,
Notes, or Upcoming Tasks
or Appointments.

Create a virtual 
business card

Use Outlook to extend
the ritual of passing

out business cards. Add a
virtual business card
(vCard) to your e-mail signa-
ture, ensuring that your
business contact informa-

tion is included in each e-mail
message you send. 
To include a vCard with your
e-mail signature: 

1. On the Tools menu, click
Options, and then click the

Mail Format tab.
2. Under Signature, click

Signatures, and then click New.
3. Select the options you

want, and then click Next.
4. Under vCard options,

select a vCard from the list or
click New vCard from Contact.

Archiving Stale Records
If you have a large data-
base, with records you

do not query regularly,
shifting them to a new table
will improve the efficiency of
your table. We will hence
archive records from one table
to another. You archive
records (instead of deleting
them) when you want to
remove unnecessary records
from the original table to
reduce its size. To archive
records in an Access database
(.mdb), build simple queries
that move the records from
one table to another. A macro
can be used to automate the
multiple queries used to
accomplish this task.

To periodically archive
records from one table to
another:

1. Use the Copy and Paste
commands to make a copy of
the table you want to archive.
Copy only the structure, not
the data. For example, copy
the structure of the Products
table in the sample database
to a new table called
Products_Archive.

2. Create an append query
that contains all the fields in
the original table and
appends records to the
archive table. Set the criteria
to specify the subset of
records you want archived.
For example, create an
append query called
Products_Append that
appends only discontinued

Delete Duplicate Rows in
MS Excel
To delete duplicate rows, you
filter a list for unique rows,
delete the original list, and
then replace it with the filtered
list. The original list must have
column headers. 

1. Select all the rows,
including the column headers,
in the list you want to filter.

2. On the Data menu, point
to Filter, and then click
Advanced Filter.

3. In the Advanced Filter
dialog box, click Filter the list,
in place.

4. Select the Unique records
only check box, and then click
OK. The filtered list is displayed
and the duplicate rows are
hidden.

5. On the Edit menu, click
Office Clipboard. The Clipboard
task pane is displayed.

6. Make sure the filtered list
is still selected, and then click
Copy. The filtered list is
highlighted with bounding
outlines and the selection
appears as an item at the top of
the Clipboard.

7. On the Data menu, point
to Filter, and then click Show
All. The original list is 
re-displayed.

8. Press the [DELETE] key.
The original list is deleted. 

9. In the Clipboard, click
on the filtered list item. The
filtered list appears in the
same location as the original
list.

Caution: Because you are
permanently deleting data, it’s
a good idea to copy the original
list to another worksheet or
workbook before using the
following procedure.

Bet you didn’t know

MS Access

Categorising to organised data
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items to the Products_
Archive table by setting the
Criteria cell for the
Discontinued field to = -1.

3. After appending the
records to the archive
table, you will need to
remove them from the orig-
inal table. Create a delete
query with the same cri-
teria you specified in the
append query. If you create
an append query that
prompts for a parameter,
you should also create a
delete query that prompts
for the same parameter.
Make sure you enter the
same values each time you
are prompted when you
run the queries. For
example, create a delete
query called Products_
Delete using the same cri-
teria as the Products_
Append query.

4. Create a macro that
first runs the append
query and then runs the
delete query. For example,
create a macro called
Products_Archive_Records
that uses the OpenQuery
action to run the Products
_Append query and then
uses the OpenQuery action
to run the Products_Delete
query.

5. Run the archive
macro each time you want
to archive your records. For
example, run the
P r o d u c t s _ A r c h i v e _
Records macro each time
you want to archive discon-
tinued products from the
Products table to the
Products_Archive table.

Lock for .ldb 
Sometimes when a new
user tries to access a

shared database on the server,
a situation arises causing
Access to delete the .ldb file,

but because of another user
also working on the file, the
.ldb files fail to get erased. This
is tried 15 times before Access
fails and gives up. This process
causes a performance hit.

To overcome this problem
you need to create a form on
the client side, which creates a

persistent connection with
the database by opening a
recordset. To do this:

1. Create an empty form.
2. In the code view,

declare a recordset variable
in the global declarations
section.

3. In the OnOpen event,
open a recordset against
any table.

4. In the OnClose event,
which will activate when
the MDB is closed, close the
recordset and set the vari-
able to nothing.

5. Ensure that you
always open this form
when opening the MDB.

Maintaining persistent
connections to linked tables
could improve performance
significantly because it pre-
vents Microsoft Jet from
constantly deleting, cre-
ating, and obtaining locking
information from the other
database’s locking informa-
tion file.

Open Database Objects
Faster

If a database has the
Name AutoCorrect

feature enabled, more
often than not, users will
experience a delay when
they try to open any of the
database objects. When
using a secured database
with Name AutoCorrect
enabled, the current user
must have design permis-
sions on the object to
enable Name AutoCorrect
to track, fix, and log the

binding errors when an
object is opened. If a user
does not have design permis-
sion on an object that Name
AutoCorrect is trying to
change, the changes occur
every time that the user
opens the object. This hap-
pens because the user does

not have permissions to ever
save the changes. 

To fix this, open the Tools
menu, select Options, and
choose the General tab. Then,
clear the Track name
AutoCorrect check box. 

Query based on User Input
Access allows you to
enter parametric

queries. Such queries can
accept inputs from the user,
while running to make the
query result conditional,
based on the user input. They
are useful because the query
itself does not need to be
modified by the query
designer. You can easily add
conditions to the query by
using the ‘Criteria’ box of the
Query Designer grid. Enter
some text to describe the
input enclosed square
brackets in the criteria box
query_pmt.bmp. Next time
you run the query, Access will
ask you for the input of the
field to complete the query on
the fly.

You can make your query
more complex. Example, you
may set the Between…And…
operator by entering some-
thing like “Between [min age]
And [max age]” in the same
criteria box.

If you have parametric

Add Stripe Patterns to a
Table in MS Word 
One way to modify the built-in
table formats that come with
Microsoft Word is to apply
your own stripe patterns. You
can select the number of rows
or columns to include in a
stripe pattern and apply your
colour choices to the pattern.

When you modify a table
style, all tables with that style
in the active document will be
changed.

1. To add stripe patterns to
a table, select the table.

2. Open the Styles and
Formatting task pane from the
‘Format’ toolbar.

3. In the Styles and
Formatting task pane, click
the arrow on the ‘Table style’,
and then click ‘Modify’.

4. In the ‘Apply Formatting
to’ box, select a stripe pattern
by doing one or both of the
following: Add stripes to rows,
Click Odd row stripes or Even
Row stripes.

5. To select a colour for the
stripes, click the arrow next to
Shading Colour, and then
chose a colour.

6. By default, the stripe
patterns are applied to every
alternate row or column.

7. To change the number of
rows or columns in a stripe
pattern, click Format, and
then click Stripes. 

8. Change the number of
rows in a stripe  or the
number of rows in a row 
band box.

Bet you didn’t know

Defining the order of user inputs
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Customise your DivX movie CD
Insert a CD and get DivX to autorun. Get a synposis of the movie. Browse online
film reviews. Play around with lots more by customising your DivX movie CD

Ripping a DVD movie to
DivX has now become
passé. It’s time to elevate

yourself to the next level.
Customize your DivX movie CDs
so that once you insert a disk in
your drive, it not only auto-
runs, but also provides you with
a menu so that you can do more
things related to the movie like
reading a synopsis of the movie

or launching a
browser to go
directly to
online reviews.
And no, you do
not require pro-
g r a m m i n g
knowledge for
accomplishing
this—just 30
minutes. 

To create
this menu we
will be using a
freeware tool
called Compact

Disc Autorun (CDA) available on
the web (www.utdallas.edu/~
jbs024000/software/cda.html)
and some other software 
that will make the menu 
look better, and display images
such as the DVD front and 
back covers. 

First, download the CDA
compressed archive,
and extract the exe-

cutable to the folder where
you have your movie. When
you run the program you
should see an interface as
shown.

Whew! That’s a lot of but-
tons. But don’t worry, once you
start, it’ll be a walk in the park. 

Click on the first button
and you will get a lot of
options to configure

that button. Here’s how we did
it. We chose to keep the first

button as the ‘Play Movie’
button. Provide the path of the
movie and that’s it. You’re
done!

Customising comes
next. Play around with
the buttons as you like.

If you want to keep a codec
pack handy on the CD, copy
the codec installer in the same
folder as the executable and
create a button for it. If you

have the images of the back
and front DVD covers create
buttons for them too. If you
have a small synopsis text file,
create a button for that. 

Our menu resembled this
box below.

Now for the final
touches. With the
buttons created,

click on Settings > Sound &
other option. This will let
you configure the options
for the main window. If you
want to display any images,
click on the Settings > Image
properties option and pro-

vide the path to the image to be
displayed. Then click on
Settings > Test Settings. This
will give you a status report of
the work that you have done
and whether anything is
wrong. If everything is OK,
click on Settings > Save to cur-
rent directory. Then click on
Settings > Create INF and finally
click on Settings > Make
Settings read only. 

Burn all the files that
you see to a CD. Make
sure that all the files,

including the movie and the
auto-run files are on the root of
the CD. If there are any folders,
make sure that you specify the
path correctly. Once you have
the movie on the CD, try it out
and let us know if your friends
are amazed to see what you
have just created!

Note: Find the software men-
tioned here and more similar
freeware on our DVD/CD. 

Each button can be customised to 
perform a specific function

The final interface that appears
when you enter the CD in the drive

The CD interface, with the buttons
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input on more than one of
the fields, then how do you
decide which input box
appears before which? In
that case, you can control it
by going to Tool > Query >
Parameters. Here, enter
the parameters with the
exact name. Be careful to
keep it in the order in
which you wish them to
appear. 

Arrest that Song!

You finally got a ‘broadband’
Internet connection. Stream-
ing audio beckons (stream-

ing video needs
the Indian defin-
ition of broadband
to change)! You are
sitting at your
c o m p u t e r ,
listening to your
favourite Internet
radio channel, and
a song you just
love is aired.
“Nooo! Damn! How
do I record this?”
you wonder. We
will show you how

you can record your favourite
Internet radio shows or just a few
all-time-favourite songs. 

You need to have a SHOUTcast
compatible player installed,
which supports the .PLS file
extension. We will use a player
called BOOMBox Online Radio
Player—a small and intuitive
online radio player. However, its
best feature is the bundled
streaming audio recorder.

Configuring this tool is a
snap: Once you start the software,
you can choose to either see a list
of radio stations by category, or
see a complete list that will give
you more options to choose from.
Click on the Refresh Radio List
button to get the latest list.

You will see a list of radio
stations displayed. Click on one,
and you are shown a brief
description, including the URL
and the current song that is
playing. Clicking on the Populate
Now Playing button will show you
all the songs playing on all the

radio stations in your list.
To listen to a station, click on

Tune In. This launches your
default media player, such as,
Winamp. The song doesn’t start
immediately, as it is buffered first
to enure smooth playback. 

Once playback begins, you can
configure the recorder. Go to
Recorder > View Recorder, which
opens the Recorder window. Click
on Advanced to see all the
options. An option is the
Advanced Song Change Detection
feature cuts the songs
accordingly to different parts. For
extremely advanced audio
editing, you’ll need to find
different software.

Once the recording is done,
navigate to the folder with the
recorded songs. The software

saves the recordings as MP3s. So,
you won’t have to worry about
converting uncompressed
formats, such as WAV into MP3. 

You can add radio stations to
your favorites list and one-click
recording. BOOMBox offers other
amazing features, for free. Here’s
to never having to do without
your favourite music ever again.

Record Internet radio
shows and your favourite
all-time hits—BOOMBox is
here for you

Click on ‘Tune in’ to launch the
default media player

ASCD (Advanced Song Change
Detection) records each track separately
on to your hard drive

Easy Access to
Frequently-accessed
Documents
The Work menu is a great
Word feature that few
people know about. You can
use the Work menu to keep
an easily accessible list of
your favourite Word files.
Here is how you can add
the Work menu to the
toolbar: 
1. Go to Tools, click
Customize, and then click
the Commands tab. 
2. In the Categories box,
click Built-in Menus. 
3. Click ‘Work’ in the
Commands box and drag it
to the menu bar or
displayed toolbar. 
4. With the Work menu in
place, you can add any
open Word document to
your list. Here are the
options: 
5. To add the current
document to the Work
menu, on the Work menu,
click Add to Work Menu. 
6. To open a document on
the Work menu, on the Work
menu, click the document
you want to open. 
7. To remove a document
from the Work menu: 
8. Press [[CCTTRRLL]]+[[AALLTT]]+[[--]].
Your cursor will look like a
large, bold underscore. 
9. On the Work menu, click
the document you want 
to remove.

Tip of the Month

A lot of the
content on
popular Internet
radio stations is
copyrighted.
Capturing this
content is illegal!
Make sure you
only capture
audio that isn’t
copyrighted.

Warning!
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Visual Explanation

Common ways viruses 
enter your system 5

1 You open unsafe attachments in 
e-mail messages

2 You keep the preview pane open in
your e-mail client

3 You open a Web page that contains
malicious code 

4 Someone sends you a virus-
infected file over a P2P network

5 You run an infected file from
removable media such as a floppy
disk or CD

The anti-virus
software, let’s
call him Buster,
constantly
monitors your
system. 
When Buster
detects an
infected file, or
when it sees
suspicious
activity, 
it uses three
approaches to
identify the virus

The Signature
approach
Just like the police trace patterns in crimes
back to a criminal, software engineers can
reverse engineer a virus to find the signature
it leaves. This signature is added to the
database, so, when Buster performs a virus
scan, each file is scanned for matches with
any virus’ signature

Removal 
of virus code
Removing the viral
code from the file, if
possible. This is the
best case scenario,
no harm is done to
the system

Quarantine of the
infected file
Buster tries to make
the file inaccessible
to programs, without
deleting it 

1

Deleting the
infected file
Buster deletes the
file if the code
cannot be removed,
or the file
quarantined

1 2 3

Buster checks
which virus is
affecting the
concerned file in
one of three
methods: 

5ways 
an 

anti-virus
software
removes
infected 

files

Text  Ram Mohan Rao Graphics  Solomon Lewis
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The Sandbox approach
A ‘Sandbox’ is an advanced program that

emulates an OS. A suspect executable file is
run within the confines of a sandbox, and

then the sandbox is examined to see what
changes were made. These changes are used
to determine which virus infected the file

The Heuristic approach 
This analyses a program for ‘seemingly’
malicious behaviour. Heuristics is effective
against undocumented viruses. The Buster of
the future might eliminate the need for
continual monitoring of new viruses 

Physical removal of
infected file
If the file is in use by
the OS, a user needs
to manually delete it
(if it is a non-critical
file), or manually
replace it from a
clean backup 

Seeking help
Viruses often make
changes to the
registry, and Buster
can’t always reverse
these changes. In
such cases, users are
directed to the
company’s Web site,
for help on what
registry keys to
change or delete

If these 
five methods fail, 
or if a critical 
OS file is
infected, Buster
boots via a
secondary OS to
access files being
used by the
infected OS

Approaches to
detect the viruses

2

3

4

5

3
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As Open Source seems poised 
to make a mark in the individual
and small business segment, you
should be looking to see which
Linux is best for you
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the OS. The audio and video chat
clients are disappointing, as there
is an inconsistency in the applica-
tions that are bundled along with
the various distributions. However,
text messaging remains consistent
with Gaim and Kopete.   

Getting used to the Linux envi-
ronment will be a bigger challenge
than the applications. Every now
and then you’ll want to switch
back to Windows. New adopters in
offices should opt for a dual 
boot system, so that they can tackle
critical situations. 

Users will find it difficult to use
software which appears radically
different such as GIMP, compared
to Paint. For example, in Paint,
pressing the ‘Print screen’ button

on the keyboard followed by [Ctrl] +
[V] gives you a screenshot. But the
commands are different in Linux.
Other applications, such as 
Office suite, aren’t radically dif-
ferent from Windows.

For a typical Windows user, a
personal finance manager
wouldn’t be common. Even if you
get one, it won’t be bundled with
the OS. But Linux comes with Gnu-
cash, a free personal finance man-
ager. You just need to run the
application and start using it.

Nero in Windows allows a
multi-session CD to be burnt with
disc-at-once option, which it
shouldn’t. This CD doesn’t work in
Linux. Also in Linux, the unclosed
multi-session CD can’t be read
without the help of a CD writer. 

Some people have a craze for
Windows applications, and they
want to use the same in Linux too,
which is actually possible. You just
need to install an emulator soft-
ware such Wine, Crossover Office
or VMware, and get started. But if
you use any proprietary application
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I
t wasn’t until too long ago
that Linux for your desktop
was inconceivable, not
because it wasn’t present
(there were hundreds of

options available even then), 
but because Linux meant geek. Per-
ceptions ranged from, “It’s not for
me” to, “I am not a NASA space sci-
entist.” Well, here’s the good news:
it’s not true anymore. 
Individuals and small businesses
are moving over to Linux—even if it
is only a small trickle—and finding
it as simple as Microsoft Windows.

Linux also has some other
inherent advantages—it is more

stable (although Microsoft 
Windows XP is as stable), costs less,
and has, literally, hundreds of free
software options. Most impor-
tantly, piracy issues are something
you’d never have to deal with
again—both as an individuals, or 
as a small business.

It is therefore pertinent to ask:
If you are moving over to
Linux, or thinking of set-
ting up your systems based
on Open Source, which
Linux is right for you?

Given the options
available, it is not a simple
task. Also, it will be some
time until Linux over-
comes some issues such 
as hardware compati-
bility, interoperability
with other OSes, and
weaning users away from
the Windows GUI. 

Digit looked at the var-
ious options available in
the market, and found out
which is the most appro-
priate one for your busi-

ness. You’ll also find a section on
LIVE CD distributions, which are
Linux distributions that can be run
straight off the CD drive, without
altering your existing set up.

Linux is best when it comes to
security. It is more or less immune
to virus threats. 

It has a bunch of GUI tools to
configure various devices such as
modem, network cards, and dial-
up connection. Similarly, it has
simple GUI tools for CD burning,
CD ripping, and audio file conver-
sion. Common office chores such
as dragging a file to or from the
network are really easy. Linux
shows the hidden shares, the
shares suffixed with a dollar ‘$’
sign at the end. Flash-enabled

Internet browsers, better than IE,
come with the Linux OS, with lots
of plug-ins—mouse gestures, etc.

Linux will disappoint you when
it comes to dealing with multi-
media applications. It plays VCDs,
but doesn’t play DVDs. There are
lots of legal issues, too, that need to
be tackled. Playing MP3s is simple,
but you can’t play other formats
such as OGG without using a plug-
in. The plug-in you have at your dis-
posal depends upon the choice of

It is stable,
costs little,
and has,
literally,
hundreds of
free
software
options

ELX BizDesktop
Price Rs 500
Company 
ELX Pvt Ltd
Phone 040-23551637
E-mail 
manojit@elxlinux.com
Web site 
www.elxlinux.com

Lycoris Desktop/LX
Price Rs 1,800
Company
G.T. Enterprises
Phone 080-6606093
E-mail 
sales@gtcdrom.com
Web site 
www.lycoris.org

Mandrake 10 Official
Price 2,350
Company
G.T. Enterprises
Phone 080-6606093
E-mail 
sales@gtcdrom.com
Web site 
www.mandrakelinux.com

RHEL Professional WS
Price Rs 3,250
Company
Red Hat India Pvt ltd
Phone 022-22881326
E-mail 
info-india@ redhat.com
Web site 
www.in.redhat.com

SuSE 9.1 Pro
Price Rs 4,857
Company
Seascope Infotech
Phone 022-26338484
E-mail 
info@seascope.co.in
Web site 
www.SuSE.com

Xandros Standard
Price Rs 2,250
Company
G.T. Enterprises
Phone 080-6606093
E-mail 
sales@gtcdrom.com
Web site 
www.xandros.com

Flavours Available

This GUI tool makes it easy to burn CDs and 
DVDs in Linux
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using the emulator, then you need
to obtain a license for the same.

Today’s Linux distributions are
well equipped with tools and 
applications to woo both home 
and office users.  Contrary to pop-
ular belief, everything that comes
with Linux is not free. Some 
applications, such as Crossover
office are shareware.

How and what we tested
We looked for ease of use, right
from the OS installation to auto-
mounting disks and attaching USB
devices, and ease of interoperability
with Windows. Everyone has used
Windows, and is familiar with the
ease of use it offers. So, a Linux 
distribution must do well against
Windows as well.

Another important thing is the
application bundle for the most
commonly performed tasks. We
checked to ensure that a good MS
Office replacement was present as
well as other business and commu-
nication tools.

In any office, the computer
rarely sits alone. It is essential that
a Linux-based PC behave well on the
network in making its resources
available, and in accessing the
resources of other PCs on the net-
work. Similarly, support for
printers and sharing installed
printers is very important. Not all
distributions do well on this front,
varying considerably in device sup-
port and software simplicity.

All tests were conducted on an
Intel Pentium 4 1.7 GHz processor
(Intel motherboard) with 256 MB
RD-RAM, an ASUS TNT2 VGA card,
onboard Network, a Seagate Bar-
racuda 40 GB, 7,200 RPM hard drive,
and an 8x Lite-on DVD Writer.

We tested six flavours of Linux:
ELX BizDesktop, Lycoris Desktop/
LX, Mandrake 10 Official, RHEL 
Professional WS, SuSE 9.1 Pro and
Xandros Standard. We also tested
three LIVE CDs: Knoppix LIVE CD,
MandrakeMove and SuSE.

DESKTOP LINUX
Starting out
All installations use a three-pane
interface for the installation
process, with the left pane broadly
listing the steps involved in the
entire process, and the right pane
shows a slide show highlighting the
important features of the product.
The bottom pane shows description
about the current status of the
installation process.

ELX lets you test the installation
media, CD or DVD, before you begin

the install—this reduces the
chances of the installation failing.
The older Red Hat 9 and the cur-
rent Fedora Core 2 provide this
option, but the Enterprise product
we tested does not.

Once the package selection is
done, Red Hat lists the distribution
CDs needed to complete the
install—for example, the ‘Personal
Desktop’ install requires the first

and the second CD.  Similarly SuSE
shows the CDs needed, as well as
the amount of time each CD will
take to install.

Partitioning
Partitioning the hard drive is the
biggest hurdle. For a brand new
hard disk with nothing on it, the
‘use free space’ option is your best
bet. This option has two parts to
it—auto and manual. The manual
option is complicated and not rec-
ommended for new users. Some
OSes such as RHEL, ELX Biz
Desktop, and Lycoris Desktop/LX
also provide a way to review the
partitions after the auto parti-
tioning is complete.

Mandrake gives you the 
added option of resizing your Win-
dows partition. You can reduce the
size of the Windows partition, up
to the limit of free space available,
and then use the free space to
create partitions for Linux. This
option is especially useful for those
who do not have free unallocated
space on their hard drive. We had
a 50 per cent success ratio with it—
when we resized a Windows parti-
tion it was a success, but when we
resized a Xandros Linux partition,
it was destroyed!

Type of installation
Generally, most of the distribu-
tions provide only a default (also
called express or standard) and a
Custom option. Mandrake does
not provide any install option

Contrary to
popular
belief,
everything
that comes
with Linux
is not free

There are a few Windows emulators,
which provide an environment in
which Windows-based programs can

be executed on a Linux platform. All you
need to do is load the emulator in Linux. A
few such emulators are Wine, Crossover
Office and VMWare.

Wine is an open source implementation
that can be downloaded for free from
www.winehq.com. It runs the Win 32 and
Win 16 API on Linux. Hence, you can 
execute almost all your Win 32, Win 16 or
DOS applications. It provides X11-based 
graphical support, DirectX support, as well
as a text-based console. Support for sound
devices, input devices, printing devices,
scanners and CD writers, are also included.
Even bug detection occurs similar to a
Windows PC.

CrossOver Office has a small set of
applications that can be emulated on
Linux. The list of applications supported
includes Microsoft Office, Lotus 

Notes, Microsoft Visio, etc. Its latest 
version, CrossOver Office 2.0.1, is available
at http://www.codeweavers.com/
products/office/.

VMware takes advantage of the Intel
architecture, which allows virtual machines
to be created at the hardware level,
enabling you to use more than one 
operating system on the same PC. It 
establishes a virtual network connection
between the operating systems, allowing
them to communicate with each other as if
they were physical computers, connected
via the LAN. So, you can access the Linux
virtual machine via Network Neighborhood
in Windows, and vice versa. The biggest
advantage is that it can have either Linux,
or Windows as the host operating system.

Though Wine is free, the bad news is
that the other two aren’t. Wine is installed
automatically with the ELX install, but not
in SuSE. Xandros steers clear of wine or
CrossOver Office.

Running Windows Applications on a Linux Box

Plugging in a USB device results in a popup 
notification, in Xandros
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except direct package 
selection, which is tedious.
Lycoris Desktop/LX installed the
entire set of packages on the
hard drive.

RHEL lets you choose
between Personal Desktop,
Workstation, Server and
Custom. The different options
have different combinations of
packages, and you can further
modify this package list.

Though the default boot
loader for most was Grub, you
can also opt for the older LILO
boot loader. Mandrake still
depends only on LILO. In a dual-
boot scenario, you can select

which OS it boots into as default. Xandros was the only one to
recognise another existing Linux installation and add it to the
boot menu.

Installation
For all the distributions, the install time is less than half an
hour—the only difference is with the number of CDs you have
to change. For example, SuSE has 5, Mandrake and Red Hat have
4, while Xandros, Lycoris and ELX have just one each. 

One excellent aspect of Lycoris Linux is that you can con-
figure various settings such as networking, printers, VGA, etc.,
while the packages are still installing. The bottom of the screen
shows the install status, and you can spend time configuring the
different components. If you’re done with the configuration
before the installation process ends, you can play Solitaire to pass
the time. Thus, installation isn’t a bore, and you save the time
you normally spend, after an install, configuring your devices.

Most distributions did well when setting up the display, net-
work, printer, keyboard, mouse, etc., but Xandros and Lycoris
caused a few problems on our test machine. 

Security
Only Lycoris demands the creation of an additional user account
during installation, for better security. Red Hat and SuSE warn
you not to use root as the daily account. Mandrake goes as far

as providing a ‘No Password’ button
for the root, allowing a blank pass-
word, a highly undesirable feature. 

While entering the root pass-
word, SuSE offers a choice of ‘DES’,
‘MD5’ and ‘Blowfish’ encryption,
and also warns you if you try to use
the username as a part of the pass-
word. ELX and Red Hat do not pro-
vide too many options, but allow
you to use MD5 encryption and
shadow passwords.

Mandrake offers four security
levels for the firewall, but in a lapse of security, leaves the fire-
wall off by default—bad news for Linux novices. ELX BizDesktop
does better, by setting the default firewall setting to ‘Medium’. 

Xandros gives you total security over data communication
by assigning users permissions to use dial-up connections, both
modem-based and LAN-based.

The popularity of Windows, is also its downfall—the
majority of viruses circulating the globe affect only the Win-
dows OS family. You could even start a virus collection on your
Linux box, and never worry about your computer crashing. Usu-
ally, Linux does not scan incoming mails for viruses, or block
attachments. This, however, will have no adverse effect on Linux.
You can set up anti-virus software on your Linux machine, to

The ELX desktop has icons
similar to those of Microsoft
Windows

1/2 page V AD



74 DIGIT AUGUST 2004

Test Centre

safeguard the vulnerable Win-
dows-based PCs on your network.
In fact, you can even set up your
Linux box to be a gateway, and
block unwanted visitors.

Post-install
Mandrake and SuSE have some
extra configuration options, such
as setting up the Internet proxy
immediately after installation, and
letting you connect to the Internet
immediately. Similarly, both allow
you to configure your modem
during this period. Mandrake
allows you to manage the default
services that start with operating
system, an excellent option for
advance users. SuSE offers to help
set up DSL, ISDN and VNC.

Only Mandrake, Red Hat and
SuSE help you update the latest
security patches during install—
patches could have been released
after the CD was distributed.

Hardware issues
The configuration we used to test
the distributions was described ear-
lier. Unfortunately, Lycoris and
Xandros refused to install on that
system due to poor hardware sup-
port. We used an older configura-
tion to test them—a Pentium II 350
MHz on a ZX board with 256 MB SD
RAM, LG 48x CD-ROM and a Sam-
sung 20 GB hard drive.

Lycoris has other issues with
hardware compatibility. If you have
to remove an optical drive time and
again, or if you frequently change
drive channels—from primary slave
to secondary slave, etc., you will
have problems accessing your
optical drive when running Lycoris.

Using Linux
Only, Red Hat and Mandrake warn
you if you try and login as ‘root’ in
GUI mode. This is important,
because one mistaken command
can damage the OS. 

ELX, Red Hat and Xandros have
a ‘First Run’ wizard. In ELX, this

wizard lets you set the default
system behaviour, set up the
default theme, as well as set up the
auto-mount option for Windows
partitions, if any. Another inter-
esting feature was ‘Eye-O-Candy’,
this is a slide bar which lets you
choose between performance and
effects—we recommend the lowest
setting for slower processors. Xan-
dros allowed left-handers to set up
the default mouse behaviour for
themselves. It then let’s you set up
a dial-up connection, network,
printers and system settings. The
system settings of ELX and Xan-
dros were the same. Red Hat’s First
Run wizard helped with config-
uring the sound card, installing
other software from additional
CDs (optional), and a patch update
via RHN. 

Mandrake is a shocker—it starts
with an absolutely blank desktop,
and doesn’t allow right-clicks on
the desktop.

Xandros, at the other extreme,
supports active user switching, just
as in Windows XP.

Applications
Word Processors,
Spreadsheets and Pre-
sentations are the
three most widely
used applications for
any SoHo user.
OpenOffice.org offers
a good set of applica-
tions for this purpose.
All the distributions
we tested had the
OpenOffice.org suite
of  applications. The interoper-
ability factor with Windows, 
in this case Microsoft Office, is
properly dealt with.

The two most common mes-
sengers that appear were 
Kopete and Gaim. Both of these
messengers are multi-network as
they enable a user to login to 
more then one type of service,
including both MSN and 
Yahoo! Messenger.

Except for Mandrake, which
does bundle an MP3 player, all the
others had an application to play
movies and MP3s. Mandrake can
acquire MP3 capability easily, by
downloading a plug-in, but then
again, it faced problems when con-
figuring the sound card. 

All the OSes include a
browser, e-mail client and dial-up
connection manager. The differ-
ence is the particular applications
that are bundled. Konqueror or
Mozilla are most common, but

Xandros also includes Opera 7.5.
All have important tools such

as file archiving software, PDF
readers, address managers, organ-
izers, and CD or DVD burning soft-
ware. You can forget about issuing
commands to burn CDs or DVDs—
thanks to the easy to use K3b GUI
application. ELX didn’t bundle a
fax application such as KFax.

CDs or DVDs burnt on a Linux
machine can easily be read on a
Windows machine, and vice versa.
You may not be able to read an un-
finished CD or DVD in Linux, but
K3b, the CD burning software, can
import a session, and also help you
finalise the CD or DVD. CDs burned
with the ‘track-at-once’ option can
only be read by K3b, and multi-ses-
sion CDs burnt with the ‘disc-at-
once’ option can’t be read on
CD-ROM drives.

SuSE has a taken a different
approach towards helping users
manage applications. It doesn’t
show the list of packages as the
others do. Instead, it provides a
search box—search for a string such
as ‘ftp’, and all packages related to
it appear. This list shows both the
ones already installed, as well as
those that aren’t. Additionally, a
‘Check Dependency’ button helps
find components needed by the
application. Red Hat follows the
same old package manager, which
lists packages under groups—
finding an individual application
needs experience or hard work.
Mandrake comes out on the top
here—its rpmdrake provides the
benefits of both SuSE and Red Hat.

CD ripping
There are many open source 
software available to rip an 
Audio-CD on to your hard drive.
Most distributions—except Xan-
dros—provided one. The most
common applications are GUI
tools such as grip, KAudioCre-
ator, etc.

SuSE doesn’t install the CD rip-
ping tool in the default install, you
have to manually install it later. ELX

installs its applica-
tion in the default
install, but the sur-
prise was Red Hat,
which doesn’t even
bundle a GUI-based
CD ripping tool. 

Multimedia
You’ll have a tough
time playing DVDs in
Linux. Multimedia
software such as

Except for
Mandrake,
these Linux
distributions
include
applications
to play MP3s
and movies 

The KDE Control Centre takes care of
tasks such as configuring a device, or
adding removing software
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mplayer, Kaffeine, etc., exist, but Kaffeine depends on
Xine, which doesn’t support DVDs. Xine-based players
such as Totem, Noatun, Caffeine, etc., lack DVD sup-
port. Red Hat doesn’t bundle applications to play
DVDs, or even VCDs. Not all distributions bundle video
conferencing applications, but there are lightweight
application easily available for download. ELX provides
Gnome  Meeting, which is compatible with Microsoft
Netmeeting.

Internet
Switching to Linux will mean abandoning Internet
Explorer (IE). Don’t lose heart though, according to a
CERT report (http://www.us-cert.gov/cas/techalerts/
TA04-163A.html), users have been requested to switch
to non-IE browsers—at least until Microsoft resolves
some major security holes. Other options include
Opera, Mozilla, Konqueror, etc.

Opera and Konqueror support flash, but Mozilla
doesn’t. However, Mozilla’s e-mail client is light, and
has good features. It’s no Outlook, but it will handle
your mail in a familiar way. Also, remember that you
won’t be able to transfer your Outlook mails to Evolu-
tion or Mozilla. This can only be achieved using third-
party tools, and involves a complicated process. These
clients still perform well, use much less system
resources, and imitate Outlook well.

Networking
All the OSes help you set up a LAN card during the
setup process itself, while providing a GUI configura-

tion interface. The only dif-
ference is how you access
the network shares of other
Linux, Apple and Windows
computers. 

SuSE has the best
approach. The file manager
itself is capable of browsing
a Windows network, and
showing members—as in
Windows Explorer. In fact,
it even shows hidden Win-
dows shares.  All you need

to do is double-click the share to open it. SuSE, unfor-
tunately, makes you copy a file locally before opening
it. It also only allows a user to share folders that exist
within his or her home directory. 

ELX comes in next with a similar browsing expe-
rience as SuSE, the only catch is that you can’t double-
click on a share and view its contents. You have to
right-click on the folder, and mount it, before you can
view the folder’s content. It also picks up ‘ghost’ shares
that aren’t accessible any more.

SuSE shows you the network workgroups, as in Windows
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Red Hat turned out to be the
worst of the lot—Samba isn’t
installed by default, so at first 
logon you can’t access a remote
share. Even after installing Samba,
you need to get down to the com-
mand prompt to enable sharing,
enable the samba server and
mount remote shares. It would be
better to just switch to Konqueror,
instead of the default file man-
ager, to graphically browse shares.

ELX offers the least flexibility—
if you want to share any folder, you
have to copy the entire folder 
to /home/public, which, in fact, 
is the only folder that is 
accessible to others. 

Sharing files has always been
a bane for Linux users. Advanced
users can edit the /etc/samba/
smb.conf file in order to enable 
file-sharing.

Xandros treats each LAN con-
nection as a dial-up. You can
specify this LAN-based dial-up to
connect at login, and also which
users are allowed to use this con-
nection—great for security.

Linux deals with networking
very efficiently. SuSE and ELX pro-
vide local network browsing, just
as in Windows. You can browse
through the network and even see
hidden Windows shares, also
called dollar shares. You can copy
files by dragging and dropping,
and view the details of the elapsed
and required time, as well as the
data transfer progress
in MB.

Printing
Setting up a local
printer seems to be an
easy task these days,
thanks to new GUI
tools, but connecting
to a remote printer is
still tough. ELX lets
you browse through
the network and

“Linux is more stable and
secure than Windows”

MAHITI SPECIALISES IN multi-platform, multi-lingual
Web, intranet, multimedia and kiosk applications.
Sunil Abraham founded Mahiti in 1998 along with
Sreekanth and Allan to provide appropriate and
affordable IT services to the voluntary sector. They
started by providing free e-mail service and Web sites
for around 20 organisations. They built over 50 Web,
Intranet, kiosk and multimedia applications for

clients—including Ashoka.org, Indian Foundation for the Arts, United
Nations Development Programme, National Law School University of
India, Tarahaat.com and Explocity.com.

Currently, Sunil is the team leader at Mahiti. His responsibilities
include marketing, client liaison, design, documentation, project
management, production and technical or non-technical training. 
We spoke to him regarding his company’s shift to Linux:

Why did you shift from Windows to Linux?
The primary issue was the licensing that is involved in procuring
commercial software such as Microsoft Windows.

How much did you save by switching to Linux?
It is very difficult to calculate, can’t say. When we used Windows, we had
only few shareware programmes. Now we have several mature
applications. The average Linux distribution comes with 
2,000 applications.

How much did you spend, training people to use Linux?
We did not spend any money as the training was handled by a
volunteer, Pramod R—a member of the local Linux User Group [LUG]
from Bangalore.

What are the immediate advantages achieved?
As a software development company, using Linux we spend less money
to procure third party licenses and therefore for the same revenue we
make more profit.

What were the problems during and after shift over?
Users were not used to the small differences between Linux and
Windows. For example copying and pasting, copying of files across the
network, installing fonts, etc.

Are you satisfied with Linux?
Yes, Very.

Five common problems that your people faced while using Linux?
1. OpenOffice.org is too slow
2. No application to replace software such as 3dsMax and AutoCAD
3. No easy tools to configure scanners, printer and the like
4. No applications for audio or video editing
5. No wizards for installing fonts, keymaps, locales

If Windows offered you a free license, would you switch back?
We will shift to Microsoft only for its office suite. Provided it is available
under GPL. But we will not shift from Linux as the operating system,
even if Microsoft becomes ‘free as in freedom’ and ‘free as in free beer’.
This is because Linux is more stable, more secure and completely 
virus free. We don’t have to keep giving three-finger salutes 
throughout the day.

How many people in your organisation?
We have 15 employees working here.

How many of them have a technical background?
Being a software development company most of us are programmers.

How many of them had already used Linux before?
Almost none had previous Linux experience.

What was the employee reaction to the switch?
Initially, the reaction was, “This is very difficult”, but they got used to it
eventually. The option I gave them was pay for your own software.
Needless to say, no one took that option.

Sunil Abraham

This scan button helps you browse through the network and
install remote printers

SuSE and
ELX provide
local
network
browsing,
just like
Windows

Case Study Mahiti
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select any remotely shared printer
that you want to use. The printing
configuration of Xandros in the
‘First Run Wizard’ was excellent; it
helped set up not only a local
printer but also a network printer
without any trouble. This GUI tool
was the best across all 
distributions—it even allows one-
click sharing of the printer on the
local machine.

Due to problems with Samba
for Red Hat, you may not be able to
install remote printers or share
your own printers. The configura-
tion tool doesn’t provide a scan or
browse button to add remote
printers. You need to manually
enter the domain, machine and
share names.

Recover it yourself
Even now, rescuing is done the old
way—using the command line. If
the system has only one Linux OS,
the rescue mode mounts the Linux
partition, by default, at
/mnt/sysimage. If multiple Linux
OSes are loaded, it has a tough 
time detecting the right one. RHEL
takes the safest way out by pre-
senting a drop down list; ELX
mounts, but with warnings, while
others such as SuSE and Xandros
do not take the trouble of
mounting a partition. 

Auto mounting CD-ROM
and floppy drives
Both Red Hat and Xandros auto-
mount a CD-ROM drive when a disc
is inserted—Red Hat provides a
shortcut on the desktop, while Xan-
dros opens the file manager with
the CD drive in focus. Other 

OSes auto-mount the CD drive
when the file manager tries to
access them. Surprisingly, SuSE has
changed the default mounting
location of CD drives and f
loppies from ‘/mnt’ to ‘/media’. Just
press the eject button—the CD-ROM
auto un-mounts and ejects the
disk. As for floppies, it’s best 
to mount when the file manager
tries to access it, and not after
inserting the disk.

USB reaction
Xandros has a pop-up notification
when it detects a printer 
attached to the USB port. For other
distributions, you get immediate
response for a USB keyboard or
mouse but for a printer, scanner 
or USB drives, you need to 
execute a few commands. ELX was
a disappointment—it does not 
support USB!

Dial-Up Connection
Xandros has an excellent GUI tool
to set up the modem and dial-up

Xandros ELXLycoris/LX SuSe 9.1 Pro RHEL WSDescription

Score Board

Ease Of Use (Weightage: 60%)
Installation (Scale of 5)
Partitioning (Scale of 5)
Auto mount Windows partition
Windows key support
Update process  (Scale of 5)
Number of CDs
Common applications (Weightage: 10%)
Address management
Organiser
Fax
Messenger
MP3 player
Games bundled
Networking (Weightage: 15%)
Configuration (Scale of 5)
Share folder (Scale of 5)
Access other remote share (Scale of 5)
Printing (Weightage: 15%)
Configuration (Scale of 5)
Share printer (Scale of 5)
Install remote printer (Scale of 5)
Final Score

35
3
3.5
Y
N
2.5
1
10
Y
Y
Y
Y
Y
Y
10.5
3.5
3.5
3.5
10.5
3.5
3.5
3.5
66

26
3
3
N
Y
NA
1
7
Y
Y
N
Y
Y
Y
12
4
4
4
12
4
4
4
57

45
4
4
Y
N
4
5
10
Y
Y
Y
Y
Y
Y
12.5
4
4
4.5
11
4
3.5
3.5
78.5

39
3.5
4
Y
N
2.5
1
6
Y
Y
N
Y
Y
N
11
4.5
3
3.5
9
3.5
1
4.5
65

38.5
4
4
N
N
3.5
3
9
Y
Y
Y
Y
N
Y
10.5
3.5
4
3
8.5
3.5
2.5
2.5
66.5

Mandrake

SuSE’s auto
update
indicates
whether a
patch is
critical or
optional 

1 col AD

As soon as you insert a CD-ROM, the File Manager pops 
up in Xandros

40
4
4
N
N
4
4
7
N
N
Y
Y
N
Y
10.5
4
3
3.5
11
4
4
3
68.5
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connection. You can even restrict
user access to the connection. Red
Hat also has a good GUI tool, 
but the rest only had command-
based configuration.

Update to date
All the distributions provide an
auto update facility, and make the
entire process effortless—SuSE gets
a bonus point for providing the
update package list with a flag,
indicating whether a patch is crit-
ical or optional. ELX failed to auto-
update despite continuous
attempts, possibly because of a
problem with the server.

Summary
Mandrake really irritated us while
testing: time and again it requested
the original CD to install some-
thing, it stalled; it even failed to
complete installation tasks.
Though Xandros, Lycoris and ELX
provided all the applications a typ-
ical desktop user would need, Red
Hat and SuSE offered even more.
RHEL would have won the laurels,
if only it could handle networking
and printing better, but we decided
that SuSE was definitely the best,
despite being more expensive.

Pricing factor
The Linux distributions tested here
can be bought by spending
between Rs 500 and Rs 5,000. ELX

BizDesktop costs just Rs 500, and is
not a bad choice at all for those
interested in getting a feel for
Linux. Lycoris Desktop/LX costs 
Rs 1,800, Xandros costs Rs 2,250,
RHEL WS costs Rs 3,250 and SuSE
costs the most at Rs 4,850.

Wait! This doesn’t mean that
SuSE is the most expensive! It actu-
ally works out cheaper in the long
run. It costs more initially, but you
don’t have to pay any renewal fees,
and get three years of patches free.
Red Hat, which has a five-year
product cycle, but not from the day
you buy it, but from the date of the

product launch. To keep updated,
you have to pay an annual charge
of 40 per cent of the initial price,
which works out to Rs 1,300 for
RHEL every year. You get Red Hat
updates only if you subscribe, but
as a subscriber, you can also down-
load a newer OS versions for free.

SuSE and Red Hat both offer 
e-mail/web-based support and
helplines, that is free for a short
while and then costs more. SuSE
has regional offices in the four
Indian metros and Bangalore,
where their support engineers also
provide onsite support but this
costs extra, of course!

Red Hat too has offices all over
India, and offers support in the
Metros, Pune and Bangalore. Red
Hat onsite support also costs extra. 

LIVE CDs
What’s a LIVE CD?
It’s like walking into a bike show-
room and taking that Harley
Davidson for a spin. You’re not
risking financial ruin (read: data
loss); if you don’t like it, you just
return the keys and go back to
driving your Ducati 999 (read:
whatever OS you currently run).

You don’t have to partition,
install, or risk corrupting the cur-
rent OS’s boot system, nothing! You
get stuck somewhere, you decide
that you don’t like Linux, all you
have to do is eject the CD and
reboot your PC to get back to your
OS of choice.  Also, think of it as
walking around with the power of
Linux in your bag. If a PC has a CD-
ROM drive, you can use your
favourite LIVE CD distribution on it.

It’s not all rosy though: you still
have to configure all your devices—
network card, modem, VGA driver,
etc.—every time the computer
boots. Also, the simplest solution to
saving data is to use a floppy. You
can save to the hard drive, but you
can’t carry your hard drive around
with you, which defeats the whole
point of LIVE CDs. Ideally, upload
the data to the Internet.

Who and how
We tested three LIVE CD installs—
one each from SuSE, Mandrake and
Knoppix. Here too, we tested for
application support, networking
and printing needs of a SoHo busi-
ness. The applications are a replica
of the full system, so they work the
same way as we have already seen
for the regular distributions. 

The SuSE 9.1 Pro LIVE CD was
a replica of actual SuSE 9.1 Pro, so
all operations such as net-

working, printing, etc., were sim-
ilar. SuSE did not auto-mount the
Linux or Windows partitions on
the hard drive, but Knoppix did.
Knoppix also provides a rich set of
tools for programmers and devel-
opers, and has more applications
packed into the CD than either
SuSE or Mandrake. Knoppix also
includes the Wine emulator, so
you can run some of your
favourite Windows programs
from within Linux. 

MandrakeMove requests some
user details during boot-up. It
also refuses to acknowledge the
existence of one-sixth of the

world’s population—when cre-
ating a dial-up connection, you
have to select a country code, but
India doesn’t figure on that list!
Hence, you will have to go
through a lot of trouble config-
uring it manually—not recom-
mended for beginners. 

mustali_kachwala@thinkdigit.com

Here are a few operations or tasks you might want 
to use a LIVE CD for: 

Helping you burn a CD or DVD, if your system has
the necessary writer 
Internet surfing, though you need to configure 
the modem or LAN card for the same 
Creating a document in the popular OpenOffice
application and printing it 
Maybe just transferring files over a LAN network
For a programmer it is like carrying your 
development center along with you in your bag
Quick scanning and printing work
Listening to music or watching movies

What Can I Use a LIVE CD For?

Products Tested

Suse 9.1 Pro (www.suse.com)
Knoppix 3.4 
(www.knoppix.org)
MandrakeMove 9.2 
(www.mandrakelinux.com)

Suse 9.1 Pro
RHEL

Professional WS
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Pulse

Secure impression

Fingerprint recognition is
fascinating. However, you have

to set it up right. Get it wrong,
and fascination turns into
frustration. The Biometric USB
flash drive is first detected as a
normal flash drive with 119.3 MB
of storage space. Run the bundled 
software and you’re prompted to
put your fingerprint on the flash
disc. If you complete this step
correctly, everything will run
fine; if you don’t, you might need
to go as far as formatting the disc
just to regain control. It’s still the 

best security around for your
data! 

Company RX Technologies
Price Rs 6,500
Phone 011-26295856
E-mail rxindia@vsnl.net

Apple G5 system

Biometric USB Flash Drive 

Antec Laptop Cooler 

Canon i80 
If you’ve got yourself a camera phone, and
are a trigger-happy self-styled photographer,
Canon just made your day- and your year as
well. The new Canon i80 makes printing
your pictures as simple as holding your
infrared-enabled phone in front of the
printer, and using its ‘Send to IR’ function.
It prints at a resolution of 4,800 x 1,200 dpi,
and on A4, 4 x 6-inch and 5 x 7-inch paper.
Add to that features such as PictBridge and
Bubble Jet Direct—
all in a unit no
thicker than a
book—and you get
must-have device.

Company Canon India Ltd
Price Rs 17,995
Phone 011-26806572
E-mail
Rajeev.Singh@canon.co.in
Web site www.canon.co.in 

Orite RAM-CAM
The Orite RAM-CAM is a USB 1.1 stick-cum-
Web cam, and stores 128 MB of data. What
can you do with it? Transfer data as with a
normal USB stick, use it as a Web cam, or
store as much video as the free space
allows. The video isn’t good enough
though—the 350 K CMOS sensor records at a
maximum of 640 x 320 pixels, at around 
20 to 30 fps. But, hey, it’s a USB stick-cum-
camera! 

Company Mediatech India
Price Rs 4,750
Phone 022-26361111
E-mail sales@mediatechindia.com
Web site www.orite.com.tw

Not hot at all

The way laptops are used, and
their compact (read: crammed)

packaging, adds up to heat galore.
The Antec Laptop cooler is a plate
with holes drilled in to dissipate
the heat that builds up
underneath a laptop. It also has
two fans that rotate at 2,500 rpm,
and draws only 2 watts of power
from a USB port. It doesn’t use up
the port though as it has a piggy-
back male connector. At just 750
gm, it doesn’t add too much
weight to your portable PC, and
keeps you from getting singed
thighs. 

Company Cyber Space Abacus Pvt Ltd
Price Rs 2,400
Phone 044-24917667
E-mail antec@theitdepot.com
Web site www.antec.com

It’s the coolest one!

Even Steve Jobs knows this is
one hot babe—Apple has

placed nine fans in the G5 to
keep it cool. Look hard at the
rugged industrial design, and
you’ll find a seriously classy
aluminium casing. Move, then,
to the 21-inch cinema display,
the dual 64-bit IBM PowerPC 970
2 GHZ CPUs, the  latest Mac OS X
10.3 with USB 2.0 and FireWire
800 ports, an FSB of 1 GHz and
an animated (yet smooth) GUI
that makes Windows XP look like
a Neanderthal gollywog. Now tell
us you are not impressed!

Company 
Apple International
Price Rs 2,38,700 (excluding the monitor)
Phone 080-25550575
E-mail indiainfo @asia.apple.com
Web site www.apple.com

Plantronics DSP300USB Stereo PC 
Headset
Here’s one for the audiophile gadget freak:
A USB headset! Install some software, con-
nect your headphones to a vacant USB slot
and enjoy your music. The drivers don’t
mess up your current sound configuration.
The inline remote lets you control both the
headphones and mic—the Plantronics USB
DSP does the rest. The headphones distort
at high volume, but are
decent otherwise. This
set’s ideal for
laptop users.

Company Mach
Communications Pvt Ltd
Price Rs 4,000
Phone 011-23724300
E-mail
sales@machcomm.com
Web site
www.plantronics.com 
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Impresses but drains

This feature-packed TV-tuner
card from Gainward connects

via a USB 2.0 interface. It accepts
composite as well as S-Video
inputs. Its versatile remote allows
access to all functions, and the
TV2GO software lets you edit
videos, add effects and burn to a
CD or DVD. The quality of the
captured content is good, but 
the device is quite a resource
monger.

Company Mediatech India
Price Rs 4,850
Phone 022-26361111
E-mail sales@mediatechindia.com
Web site www.gainward.com

It’s a small, small world

This tiny camera fits in your
palm, and has an 800 K pixel

CCD with 18x optical zoom. 
Its 2.5-inch LCD helps you keep
subjects in the frame. It records 
on a MiniDV tape, which holds 
up to 60 minutes of video. 
The MVx700i connects to a TV 
via the A/V port, and you can add
in a dash of style to your
recordings using the ‘Effect’
button.

Company Canon India Ltd
Price Rs 39,995
Phone 011-26806572
E-mail Rajeev.Singh@canon.co.in 
Web site www.canon.co.in

Canon MVx700i

Gainward Hollywood@Home TV2Go TV Tuner

Atek Tote-Remote

Plantronics MX150
The MX150 mobile headset works with only
a few Nokia models, such as the 6100, 6610
and the 7250. The Flexigrip rubber grip
helps keep the earpiece in place. You can
adjust the microphone by 180 degrees and
hence, wear the earpiece on either the left
or the right ear. A button on the cable lets
you receive incoming calls, and gives you
the hands-free
freedom that you
should have with
mobiles. 

Company Mach
Communications Pvt Ltd
Price Rs 999 
Phone 011-23724300
E-mail
sales@machcomm.com
Web site www.plantronics.com 

Kodak EasyShare LS743
This sleek-looking camera has a Schneider
Kreuznach 2.8x optical zoom lens, and
stores up to 16 MB of images and
movies alongwith audio. It
runs on Li-ion battery,
and comes with a
charger. Preset
settings make life
easier, especially for
novices—all you have
to do is select the
proper settings and click away. The
impressive image quality, at a reasonable
price, makes it a worthy digital companion.

Company Neoteric Informatique
Price Rs 19,500
Phone 022-24172600
E-mail sales@neoteric-info.com
Web site www.kodak.com 

Canon i9950
The Canon i9905 photo printer has a
whopping eight different cartridges, and
supports A3 printing. It performs decently
too: it prints fast in the draft mode, but is a
tad slow in the normal mode. Photo prints
are crisp, vivid, have a high contrast and
look  realistic. A must have for DTP houses. 

Company Canon India Ltd
Price Rs 31,995
Phone 011-26806572
E-mail Rajeev.Singh@canon.co.in 
Web site www.canon.co.in 

Hold over presentations

You won’t ever struggle to make
PowerPoint presentations again.

The Tote-Remote can start a
presentation at the touch of a
button, and lets you control slides
easily. It’s a Radio Frequency (RF)
device, and so has a range of 30 to
40 feet. It also has an inbuilt laser
pointer, making it a very useful
presentation tool. 

Company J.S.Equipment
Price Rs 6,000
Phone 022- 23810713
E-mail jse@vsnl.com
Web site www.antec.com

Please write to products@thinkdigit.com. The DIgit Test Centre will be delighted to
respond to your queries.

Looking for more information on any of the products featured in New & Notable?



The new Intel
Alderwood and
Grantsdale chipsets

offer the much awaited DDR
II and PCI Express standards.
Interesting features such as
Graphics Media Accelerator
900, Matrix storage, High
Definition Audio, Wireless
Connect technology and the
LGA775 (Land Grid array)
CPU socket are supported by
the new platforms. 

The Trusted Computing
Platform chip promises
uncrackable DRM (Digital
Rights Management).

Let’s see if these new
chipsets can deliver: 

Chipsets
According to Intel the i915
is targeted at the masses,

while the i925X Express is
for the performance
seekers. The tables detail
the various features of the
new chipsets.

Memory
DDR II, running at 533 MHz,
offers a total bandwidth of

8.5 GBps, which is nearly 30
per cent higher than cur-
rently available 875/865
chipset-based motherboards. 

Unfortunately, this extra
bandwidth is higher than
the bandwidth between the
CPU and the Northbridge.
So, the CPU can’t exploit this
increased bandwidth—not
until Intel’s 925XE chipset,
featuring support for CPUs
with 1,066 MHz bus speeds. 

Graphics
The age-old AGP8X bus will
be replaced by PCI Express
x16. Of course you’ll need to
upgrade your graphics card
to use the new interface. The
‘x16’ means 16-lane memory,
with each lane capable of
250 MBps speeds. This trans-
lates to speeds of 4 GBps in
each direction, or a band-
width of 8 GBps—almost four
times the 2.1 GBps speed of
the current 8X AGP standard.
Will it ever be used? Today
most graphics cards store
data in huge local memo-
ries—as much as 256 MB. So,

increasing bandwidth has no
effect on the graphics sub-
system…yet.

We ran our gaming tests

on the new integrated GPU
core, pitted against a
Geforce4 MX card—the
cheapest discrete card avail-
able. In UT2003, the
Geforce4 card beat the

onboard graphics by a
slender margin. Other games
showed similar results,
proving that though the new
core is better than the older
Extreme Graphics 2, it’s still
not a true 3D solution. 

Peripherals
Peripherals that earlier con-
nected to the Southbridge,
will now use the superior
PCIe x1 buses.

Each device connected on
this bus will have a dedi-
cated bandwidth of 500
MBps. Now, devices such as

Gigabit Ethernet, RAID
controllers, etc., can over-
come the bottleneck of
the older bus speeds of
133 MBps. 

The High Definition
Audio offers 192 KHz, 24-
Bit, 8-channel sound, and
compliance with every
possible current standard.
What’s interesting is the
multi-streaming support;
two users can use the
same soundcard for two

different purposes simulta-
neously—one watching a
DVD movie, while the other
voice conferences using
headphones.

CPU
The new CPUs will be offered
in LGA775 (Land Grid Array)
package, which should
replace the current Socket
478 gradually. The LGA775
has 775 pins as opposed to
478 on the older socket. In
fact, the new CPUs don't
have pins, and have flat con-
tact points instead. You have
to be careful when installing
the processor, you might
damage the pins on the
motherboard. 

Testing
Our test bed had a D915GUX
motherboard, Pentium 4 550
running at 3.4 GHz, 1 GB

Micron DDR2 533 MHz and
two 250 GB Maxtor Maxline
III hard drives. We ran
Windows XP with service
Pack 1 and all the latest
patches. 

In the Ziff Davis Content
Creation test, we got 31.8,
the best score we ever
logged, beating the older 865
platform by nearly 12 per
cent. However, in the
Business Winstone test, the
new platform was on par the
i865-based motherboards-
clearly indicating that in
daily office applications, the
boost is negligible.

Overall, from an Indian
perspective, these platforms
are still too new—they need
some time to become main-
stream. Though they outper-
form everything we’ve ever
seen, the scarcity of DDR II
memory modules, PCI
Express graphics cards,
power supplies, etc., will
make sure that the masses
have to wait before they can
actually go out and buy it. 
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Intel Grantsdale and Alderwood platforms

DDR2 533/400 DDR2 533/400 or DDR 400/333

Four x1 slots
6 PCI slots max.

1 ATA-100 channel, 4 SATA-150 channels
Support for 8 USB 2.0 ports

Supported on all 
Intel's High Definition Audio

Yes—PCI Express X16
None Intel Graphics Media Accelerator 900

None

Supported on all 

Intel Pentium 4 / Celeron D
800 / 533 MHz

New Kids On The Block

Onboard Graphics

Onboard graphics
Core speed (MHz)
Rendering pipelines
Pixel fill rate 
Pixel shader support
Hardware T&L
Memory bandwidth available

266
2
533 megapixels/sec
None
None
6.4 GB/Sec

333
4
1.3 gigapixel/sec
Pixel shader 2.0
None
8.5 GB/sec

Graphic Media Accelerator 900   Extreme graphics 2

Flavours of Southbridge that can be present on your boards

IICCHH66  
Standard

IICCHH66WW

Supports inbuilt WiFi

IICCHH66RRWW

Supports inbuilt SATA

RAID and WiFi

IICCHH66RR
Supports
onboard SATA
and RAID

CPUs supported
FSB frequency 
Hyper-Threading support 
Supported memory types
Integrated graphics
Discrete graphics slot
PCI Express slots
PCI slots
HDD interface
USB 
Gigabit Ethernet
Audio

IInntteell  992255XX

Intel Pentium 4
800 MHz

IInntteell  991155PP IInntteell  991155GG IInntteell  991155GGVV

DDR II memory: life in the fast
lane

The new Intel D925XCV desktop
board: PCI Express will speed
things up

The new CPU lacks pins

New & Notable



Smart SoHo

POWER
more attuned to your needs. 

Before purchasing a UPS you
need to consider your PC’s power
consumption. 

A regular Pentium 4
computer with a generic 17-inch
monitor consumes close to
400W or 560VA (Voltamps) of

power. We will
assume this
consumption if the
configuration has a
single hard drive, 256 MB
of RAM and a CD-ROM drive.
No printers or other external
power consuming equipment
have been considered. In such a
situation, it would be wise to go
in for UPS with 600VA rating. 

Also, a UPS falters if the load
on it exceeds its rating. So if a
500VA load is applied on to a UPS
that provides 500VA of power,
you will end up getting only five
minutes of back up time. Based
on this thumb rule, calculate the
VA rating for each device you
want connected to the UPS.

Here’s an easy way of calcu-
lating the VA rating for each
device that you have: 

1. List all equipment you
want connected to the UPS—
monitors, hubs, external hard

Choosing the right UPS for your SoHo can be a pain. 
Presenting solutions that will put you at ease

Bhaskar Banik

he story goes that a
Bangalore-headquartered
Uninterruptible Power

Supply (UPS) solutions company
hates the Mumbai market
because power rarely trips out
there, and as a result there are
few individual buyers.
Nevertheless, businesses—both
big and small, and whether in
Mumbai or elsewhere—have to
have UPS systems installed. 
They just cannot afford to lose
any data, or even time, due 
to power issues.

SoHo users, too, are not
immune to these problems. And
whatever power problem there
may be—a power cut or a power
surge—home office users would
do well to be prepared for any
eventuality. The commonest
solution SoHo users employ is a
spikebuster, used as defence
against power surges. But power-
cuts still pose issues. 

A UPS device is normally
bought as an afterthought, if any
money is left after buying the
PCs. But a UPS not only keeps
work going in case of a power-
cut, but also protects machines
as an advanced surge protector,
and a device that provides clean
power supply essential for a PC.
All this comes at just a small
price, but ensures that your valu-
able investment stays safe.

Calculate your power
needs
This is the tricky part. No matter
which UPS company you
approach, it would want 
to sell a high-end solution for
your home office or small 
business, while you will be better 
off with a solution that is much

T

I got the
POWER

Types of UPS

Offline
The most commonly used UPS,
with a pretty simple technol-
ogy. In the case of power fail-
ure, the UPS switches to a
battery back-up, and can be
used for PCs, given the low
cost and high efficiency levels
of such systems. This makes it
ideal for home PC users.

Online
Also called the true UPS, since
the load always runs on the

UPS, and the real (Alternating
Current or AC) power is only
used as secondary power
supply. Seems strange? It
does, but if the AC power
trips, the switch time is imme-
diate, hence leads to minimal
or zero loss of up-time.

Line interactive UPS
A type of offline UPS in which
the battery remains in charg-
ing mode when primary AC
power is on. When AC power

trips, the battery takes over
and provides power. It also
monitors voltage fluctuations
constantly, and in situations
where low voltage conditions
exist, the UPS adjusts the
power supply instead of
switching on to the battery.
This means that the UPS
works at high efficiencies.
This type of UPS is the 
preferred solution for SoHo,
small business and Web 
server scenarios.

Illustration Atul D
eskm

ukh
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person SoHo outfit would
require at least a 5kVA UPS
considering eight Pentium 4 PCs
with 17-inch monitors. 

This done, check the UPS
type you consider to be the best
option in your budget. We 
would recommend spending a
little more and get a good UPS
rather than go for an ‘in-the-
budget’ solution. A centralised
solution would cost you some-
where between Rs 75,000 to Rs 1
lakh. This solution could provide
you a battery backup time of
about 20 minutes. 

For a single PC home solution

with a printer and scanner,
considered with a backup time of
around 10 minutes, you will need
to opt for a UPS that provides at
least 700VA of power and will cost
you about Rs 5,000 and will vary
for the different options that we
mentioned above.

And some thoughts for
the road…
SoHo or home users can easily
opt for solutions mentioned
above. There are several UPS
brands available in the market,
and quite a few local brands have
earned themselves a good repu-
tation. Nevertheless, make sure
you go through the product
brochure and take some time to
understand the ups and downs
of the product. What may look
good at first sight, may turn out
to be bad oversight on your part. 

No matter what option you
pick—centralised or decen-
tralised—depending on your
budget and the priority and
importance that you assign 
to your machines, make an
investment that will last you
through the years. 

bhaskar_banik@thinkdigit.com

drives, in fact anything that
requires power and needs 
protection.

2. If any device has a power
rating given in watts, take that
figure and multiply by 1.4. This
gives you the device’s VA rating.

3. Check the amps and volts
ratings of the devices you have
listed. To get a VA rating, multi-
ply the amps by the volts.

4. Add the VA ratings of all
your devices to get a grand total.

5. Multiply this total by 1.2 if
you want to factor in one more
device later.

6. Make sure that whatever
type of UPS you opt for, your VA
total should not exceed the VA
rating of the UPS. It is always
recommended to buy a UPS with
a higher VA rating than your
cumulative VA rating.

Before you set up…
SoHo businessmen would typi-
cally face two scenarios when it
comes to UPS implementation—
whether to connect one big UPS
to centrally control all PCs at the
same time, or to have individual
UPS for every PC. Why only PCs?
Because connecting a printer
(especially if it is a laser printer)
to a battery output socket on the
UPS will cause considerable
power drain, which could instead
be used for another PC.

Based on our power calcula-
tion earlier, a modest eight-

Before you sign the cheque…

Check for the warranty offered.
Some UPS manufacturers provide
model specific warranties.

Pay attention to the
manufacturer's support agreement.
Do they have a replacement policy?
Do they have trained support
personnel? What happens in case
the UPS goes kaput? Do they have a
policy of providing standby UPS
machines? Ask your vendor these
questions before you buy.

What software do you get to
monitor the UPS? How effective is
it? Does it automatically shut down

PCs if it is low on battery? Does it
continuously monitor and give you
a status report of voltage
conditions and situations like
brownouts? Questions like these
would put to rest the doubts about
the software solution provided 
with the UPS.

The best possible situation is to
test the UPS at your location. Ask
the manufacturer to arrange for a
demo that will simulate your work
conditions and check if the claims
of the manufacturer match the
performance of the UPS.

Multifunctionality

Some UPS systems provide features that let you
connect a mobile charger or have an inbuilt

flashlight that can come in handy in case of 
power-cuts. Other features that you can probably
look for when buying an UPS is if it can let you
attach additional batteries, and if they can be hot
swapped at a time of emergency. Also look for
connectivity options such as serial or USB, power
monitoring and voltage conditioning options.

How UPSes Work?

Surge 
Suppresor

Filter

Battery
Charger Battery Invertor

Rectifier

Battery
Charger Battery

Transfer
Switch

Standby
DC to DC
Converter

Transfer
Switch

Battery

Charging Normal Discharging
(Power Fail)

Inverter

Standby Online Hybrid Line InteractiveStandby

Filtered AC input is the primary power source for the
transfer switch. It switches to the battery/inverter if
this source fails. 

If the AC power fails, the standby DC-to-DC converter is switched on.
Capacitors in the DC combiner ensures a smooth transition.

The battery-to-AC power converter (inverter)
stays connected to the UPS output. The transfer
switch opens the moment the input power fails
and the battery takes over.
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Aliasgar Pardawala

he most important
component of your busi-
ness may be your employ-

ees, but they’re only as valuable as
their data. This sounds clichéd,
but think about it: Imagine losing
all your company’s data in a freak
accident, or a virus attack.
Imagine the hundreds or thou-
sands of man hours lost. And
then, even more hours will be
wasted trying to recover or repli-
cate records, presentations, inter-
nal documents, etc. Sounds scary?
It is! 

We rely a little too much on
computers, or more precisely on
storage components. And compo-
nents will fail, sometime or the
other. Backup is the name of the
game, and you’re playing against
loaded dice, if you aren’t already
protected against a data disaster.

The SoHo segment is espe-
cially vulnerable to Internet
threats and disk failures. Backups
just aren’t considered a necessity

Backup solutions need not burn a hole
in your pocket. Presenting a guide that
gives you the right options

here. Contrary to
popular belief,
getting a backup
solution is not
expensive, and
doesn’t require
d e d i c a t e d
trained profes-
sionals. 

Hard disk drives
Most SoHo setups have a LAN, so
the simplest and cheapest solu-
tion is to have hard drive backups.
A large capacity hard drive can be
plugged into one computer—
preferably the highest configura-
tion PC in the office—to run as a
server. We’re looking at five to 10
people using this disk as a backup
device, so it would be better if the
LAN is switch-based, and not hub-
based. Over a switch-based LAN,
which runs at 100 Mbps, backing
up data as large as 100 MB would-
n’t take more than 15 seconds.

A Serial-ATA (SATA) hard drive
is preferred. SATA is a standard
feature on motherboards today,
and offers peak transfer speeds of
about 150 MBps. You also get 250
GB drives with an unbeatable
price-per-MB ratio. Maxtor and
Western Digital offer 250 GB
drives at a price-per-MB ratio of as
low as six paise and eight paise,
respectively. So, you’re only
paying 6 paise for every MB of
data you’re backing up—unbeat-
able. All that needs to be done is
to plug in the drive to a decent
system, create separate folders for
each user, and install backup soft-
ware on each client machine.

The backup software installed
should be scheduled to backup
data at particular time interval.
Ideally, this should be at least

thrice during working hours. This
will ensure minimal data loss, if
any occurs. Since this is a simple
setup, with no policy defined,
users will have to follow some
guidelines—backing up only
important office related files, not
music and movies. Also, users
shouldn’t save files directly from
the Internet, as these could be
infected.

External hard drive
External hard drives are another
option that can prove useful for
SoHos, especially in offices where
machines aren’t connected over a
LAN. External hard drives are
available as both USB and
FireWire drives, of which the USB
interface is more popular. The
USB 2.0 interface is hot right now,
because of the faster data transfer
speeds—480 Kbps. 

The advantage of external
drives is that they can be carried
to individual machines and hot
plugged. Another advantage is
that USB-based drives don’t need
drivers with Windows XP. Even
with older OSes such as Windows
98, the drivers need to be
installed only once, on each
machine. 

External hard drives are more
expensive than internal drives,

but are available in large capaci-
ties, and come bundled with
backup and restore software—
which if bought separately costs
much more. Some external drives
also have a hotkey for instant
backup. 

The price-per-MB of external
drives is about 20 paise to 33
paise, depending on the size and
interface. They are handy, but
involve a lot of manual effort to
take backups.

Optical storage
CDs and DVDs are the most
common choice for backups. CDs
are probably the cheapest solu-
tion. DVDs store a lot more, but
the media and writer are still
expensive. They are only viable
for designers and video profes-

Smart SoHo

Maxtor 250GB external hard drive
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sionals who have large amounts of data for frequent back-
ups. 

Though re-writable media are available, CD-Rs are still
preferred, and this means a new CD for each backup. Also,
CDs are subject to corruption via scratches and exposure to
the elements. Your precious data can soon become nothing
more than a coffee mug coaster. The price-per-MB for CDs is
the lowest—two or three paise per MB. This media is recom-
mended for situations where backups are not accessed
frequently—in fact only where backups are accessed rarely. 

Miscellaneous storage
Iomega recently launched Rev Drive—a hard drive intelli-
gently divided into two parts. This drive stores 35 GB in
uncompressed form, and 90 GB in compressed form. It’s a

good solution to backing up a
hard drive on its last legs. Rev
is available in the ATAPI and
USB 2.0 interface, and is quite
simple to use. 

The problem with such
proprietary drives is that users
are stuck with one format, as
was the case earlier with ZIP
and JAZ drives. You can’t
access your backup on

anything but a Rev drive, which is an Iomega standard. 
USB sticks are another option that can be used for

temporary storage of data. They are portable and conven-
ient, but the problem is they are expensive—a 128 MB USB
stick cost between Rs 2,500 to Rs 3,000. The price-per-MB
ratio is pathetically high, thus making it only good for
transference of data, and not backing up. 

The last word
Your data will never be totally safe, but you can use one, or
a combination of two or more of the afore mentioned
options to minimise the risk of data loss. In business, the
lower the risk factors, the better you will sleep at night. Look
towards securing your company records, and as a result your
business, by using an intelligent hybrid of hard drive and
optical backup solutions. 

aliasgar_pardawala@thinkdigit.com
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Backup software

Hardware is nothing without the software that empowers
it. This holds true for backup solutions as well. You need

software that will automatically back up your data, with the
least amount of human intervention required. The software
should also have extra features such as saving a specific
folder only, compressing the backups, timed intervals for
backups, etc. Consider some of the following alternatives

1. Secondcopy2000 (www.centered.com) Rs 1,380
2. Dantz Retrospect Professional (www.dantz.com) Rs 5,940
3. Securdat Pro 2.1 (www.pa-soft.com) Rs 1,100

1/2 P VAD

What I would buy

Even backup hard drives are components in the end, and can
fail. So should you have a backup for your backup drive? 

Yes—if your data is important enough, or if you are paranoid
enough. We suggest two hard drives configured to Mirroring in
RAID (Redundant Array of Inexpensive Disks). This ensures that
one drive is used as backup, and an exact copy is made on the
second disk. You can also convert an internal hard drive into an
external hard drive by buying a convertor kit. This kit costs about
Rs 2,000. We recommend a Western Digital WD2500 250 GB 
hard drive, which costs Rs 17,500.

Iomega Rev Drive



One fine day, the
boss woke up and
ordered: Let’s go
for a movie to
celebrate the
magazine’s third
anniversary.  
I was given the
responsibility of
buying tickets for
Lakshya for the
entire team. 
I had two choices
before me: to
book online or to
make the trip to
the theatre, and
stand in queue. 
I decided to
rough it out both
ways. Here’s the
result:
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Buying cinema tickets

From Nerul, in Navi Mumbai where our office is
located, I took the train to Wadala, a central
Mumbai suburb and the station closest to the
theatre—Imax Adlabs. I then cabbed it to Imax.

Time taken 40 minutes for the train journey,
25 minutes for the taxi ride

Visited the Imax Adlabs Web site, and registered
for their services. 

Time taken 3 minutes

It was a weekday, so the crowd didn’t resemble a
Rajnikant opener down south, where I come
from. If it were a weekend, I would have perhaps
felt at home. More luck—tickets were available.
Imagine travelling 65 minutes to find out that
there are no tickets!

Time taken to check availability 2 minutes

Selected the movie, date and time of our choice—
surprisingly, I could also choose the seats.
Remember the old days, when a grumpy old man
behind the ticket window would decide where you
sat? Slipping him a tenner would get you a better
seat though!.

Time taken 5 minutes

Stood in queue to buy 11 tickets (priced at Rs 130
each). There were just about 15 people in front of
me, yet each person took an aeon to decide which
seat he or she wanted. So I twiddled my thumbs
for possibly the longest I have ever done, since my
last exams.

Time taken in queue 25 minutes

Then, I had to select a mode of payment. I settled
for a credit card transaction. The site threw up a
transaction ID, along with the order details.  

Time taken 8 minutes

(I also spent 5 minutes presenting my Transaction
ID at Imax and collecting my tickets)

Total cost Rs 1,430 (This only applies to credit card
transactions; booking over the phone costs Rs 10
extra per ticket for home delivery)

My condition Happy! And, I never had to leave the
comfort of my chair at office

Total cost Rs 1,521: Rs 1,430 for the movie tickets,
Rs 21 (return train ticket—second class), Rs 70 (taxi
fare—to and from the theatre)

My condition: Exhausted! Oh, and I still have to travel
for a little over an hour to get back to the office.

Buying tickets over the counter Buying tickets online

1

2

3

4

Tech Way, it’s cheaper! Besides, I figured it’s not cool
to travel by train for so long, then cab it even

longer, and then stand in queue twiddling thumbs.
Instead just buy the tickets online, over the phone, or

even via SMS. On the other hand, if I had hours to kill,
and masti-seeking company, I might just decide to
make the trip to Wadala, for an evening of movie
magic—ticket counter mayhem included.

Photograph Jiten G
andhi

OLD
WAY

TECH
WAY

Total time taken 2 hour 37 minutes
Total cost Rs 1,521

Total time taken 21 minutes
Total cost Rs 1,430

And 
The

Winner
Is...

Meera Vankipuram meera_vankipuram@thinkdigit.com
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The defaults don’t change

I have a Pentium 4 2.60c GHz, an Intel D865
GBF motherboard, 256 MB DDR RAM, and an

80 GB hard disk loaded with Windows XP
Professional Service Pack 1. I am unable to change
the default folder settings. For example, when I
change the way the icons in a folder are arranged—
by date, size, etc—or if I change from the
‘Thumbnail’ view to ‘Details’ view, nothing is saved
past a reboot. My user account has administrator
rights.

Abhijeet Ghosh

To get rid of this, open Windows Explorer
and go to Tools > Internet Options > Folder

Options. Here, look for “Remember each
Folder’s View Settings” and uncheck it. This
done, all your settings will be in place the next
time you reboot your system.

Of stubborn shutdowns and
errors...

I have an Athlon XP 2000 processor running
Windows XP. I have three problems: 

Windows shuts down from all other user
accounts except from the one I created. 

Secondly, whenever I start Norton System
Works, or run ‘msconfig’, it automatically shuts
down after few seconds—this doesn’t happen with
other accounts. 

Lastly, whenever I log on, I get a message
“You or a program has requested uncanny.org,
which connection do you want to use” with
options to connect to the Internet. This message
reappears even if I hit Cancel. What do I do?

Rahul

Your user account seems to be corrupted.
you will have to delete it and create it anew.

Save your data before you do so. You will find
detailed instructions at http://support.
microsoft.com/default. aspx?kbid=811151, which
will guide you through the process of saving
your data.

As for your last problem, it’s a case of
spyware infection. Download and install SpyBot
(www.safer-networking.org) and AdAware
(http://www.lavasoftusa.com/software/adaware/)—
both free spyware-scanning tools. Run them to
remove any installed spyware, and prevent such
problems in the near future.

Dial modem dial

Here’s my system’s configuration: A Pentium
4 1.8 GHz on a Gigabyte motherboard, 128 MB

RAM, a 40 GB hard disk, and a 56 Kbps D-Link
internal modem, running Windows 98 and
Windows XP. I hear a ringing sound on my speaker
as I try to dial-up in Windows 98, but not from my
modem. With Windows XP, I hear the ringing sound
from the modem itself. How do I rectify this prob-
lem? Also, does my Pentium 4 1.8 GHz processor
have only 256 KB of L2 cache memory? 

S Riyaz

You haven’t enabled the modem speaker
volume in Windows 98. Go to Start >

Control Panel > Phone And Modem Options,
click on your modem, and then on Properties.
Next, click on ‘Advanced’ and then enable the
speaker volume settings for the modem and set
it to high.

Also, internal modems, especially the SM56
PCI cards, have a tray application that plays
sounds using DirectX. This is their way of
telling you about their activity, so it’s best to
leave it running.

Earlier batches of the Pentium 4 processors,
based on the Northwood cores, only had 256 KB
of L2 cache. Processors based on the Northwood
A core, which came in later, have 512 KB of L2
cache.

Service. What Service?

I have Windows XP Professional installed,
without Service Pack 1A. I tried installing

through Windows Updates, but every time I did,
either through Windows Updates or using the
Service Pack CDs, it shows “Service Pack 1 Set Up
Cancelled”. Why does it fail?

Secondly, I have a Pentium III 500, 128 MB RAM
and a 40 GB hard disk, on a 440ZX motherboard.
The motherboard doesn’t detect the hard disk in
the BIOS setup. Only 32 GB of the total disk capac-
ity is shown. How do I get it to recognise the
remaining disk space? 

Also, my PS/2 port is not functional. Can I use
an optical PS/2 mouse with a PS/2-to-serial port
converter?

Jayant

If you purchased an original Windows XP
CD, please get in touch with Microsoft’s

customer support to solve the problem. If you
have installed a pirated version of Windows XP,
no Service Packs will install.

You have a very old BIOS version—the 440ZX
chipset is over five years old. You’ll need  to
upgrade it to use hard disks larger than 32 GB.
Download the latest version from the board
manufacturer’s Web site, and follow the
instructions posted there to flash your BIOS.
Remember, this can render your motherboard
unusable, if it’s not done right. 

And lastly, yes, you can connect your PS/2
mouse to a serial port using a PS/2-to-serial
converter.

Your Questions, Our Answers

E-mail us your 
computing problems,
and we may answer
them here! Since we get
more mails per day than
we can handle, it may
take some time for your
query to be answered.
Rest assured, we are 
listening!

sos@jasubhai.com

Uncheck this option to
get consistent folder
views



A fragment of a problem

I
I have four partitions on my hard drive. Every

time I attempt to defragment my E: drive, I get
an error message that says, “Windows cannot finish
defragmenting this drive because it has encoun-
tered some problem....”. I run Windows 98 SE, and
all the other drives defragment properly. I even
tried to defragment in Safe Mode, and ran Scandisk,
but couldn’t find any bad sectors. What do I do?

Ganesh Magal

You can solve this problem easily. Right-
click on the desktop, and click ‘Properties’.

In the window that opens up, click Web > Folder
Options > Yes.

Here under View > Hidden Files, check ‘Show
all files’ and click OK. Now, go to Start > Find,
and click ‘Files and Folders’. Here, type ‘applog’
in the ‘Named’ box and opt to search the C:
drive. Check the ‘Include subfolders’ box, and
click ‘Find Now’. Open the applog folder once
it’s found, and delete all the files within it. After
this, you should be able to defrag your E: drive. 

Calling queries

I use a dial-up connection to connect to the
Internet. How do I know when someone’s call-

ing my phone while I’m online? Can I set my
connection to disconnect automatically when I
receive phone call?

Nataraj Das

There’s nothing you can do in Windows to
get your PC to prompt you about incoming

calls. However, you might be able to accomplish
this if you tweak your modem. You need to have
call-waiting enabled—get in touch with your tele-
com service provider for this. If you set ATm2 in
the Extra Settings box, the modem speakers will
always be on. You will get a hiss that indicates
data transfer, and frequent beeps will alert you
when you get calls. Generally, with this feature
enabled, a dial-up connection disconnects when
you receive a call.

Norton acts up!

Nothing happens when I click on the Norton
2003 icon. I tried uninstalling it from

Add/Remove Programs, but I get the following
message: Error 1606. Could not access network
location “C:\Documents and Settings\All
Users\Desktop”. On pressing Cancel, I get another
error message, “Fatal error during installation”.
The Auto-protect feature doesn’t work, and I can’t
scan for viruses manually.

Sandeep Kumar Dixit

To solve your problem, you will have to
uninstall Norton 2003 and reinstall it.

You’ll need to download ‘Msicuu.exe’ from
http://download.microsoft.com/download/office
2000pro/util20/1/NT4/EN-US/msicuu.exe. After
the installation is complete, click Start > All
Programs > Windows Installer Clean up. Here,
select Norton 2003, click ‘Remove’ and then
‘OK’ to exit the program. If this doesn’t add
Norton 2003 to the list, you’ll need to edit a
registry setting.

Click Start > Run, type ‘regedit’ and press
[Enter]. Navigate to the following registry key:
HKEY_LOCAL_MACHINE\Software\Microsoft\
Windows\CurrentVersion\Uninstall.

Here, you will see the product ID keys. To
find Norton 2003’s ID, click each ID and look
for ‘Norton 2003’ in the right pane. On finding
the Norton 2003 key, delete it and exit the
registry editor. You can now reinstall Norton.

A message from Nero

I have a Pentium 4 1.7 GHz on an 845 mother-
board, a 40 GB Seagate Barracuda hard drive,

and an LG 48X/16X/48X CD-RW, with Windows 98
and Windows XP as my operating systems.
Recently, when I ran Nero 5.5.8.3 in Windows 98,
my PC hung and gave a message “Scanning
SCSI/IDE BUS..... Please wait”. The program starts
out fine in Windows XP, but the system hangs
halfway through. Please help.

Nataraj Das

This problem occurs if the IDE-chipset
driver is not installed properly. Improper

DMA support causes Nero to freeze. To work
around this, download and install the latest
drivers from the motherboard manufacturer’s
Web site. If this doesn’t solve the problem,
disable DMA for the recorder and burn a CD. If
it persists, remove any USB device attached to
the system before burning a CD.

Fonts don’t install

I use a Pentium III 866 MHz PC, 128 MB RAM,
and a 20 GB hard disk loaded with Windows

98 SE. I can’t install new fonts. I don’t get the
‘Install new fonts’ option when I go to  the
Control Panel > Fonts > File menu. I tried to copy
them directly to the Font folder, but that didn’t
work either. I formatted my hard disk and rein-
stalled Windows, but I still can’t see the ‘Install
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A shell to solve

While connecting to the Internet via my network connection, I get a
message that says, “LSA Shell (Export Version) has encountered a
problem and needs to close. We have created an error report that
you can send to help us improve LSA (Export Version).” Whether I
click on ‘Send’ or ‘Don’t send’, either way I get an error that says,
“The system process E:\windows\system32\ lsass.exe terminated

unexpectedly with status code-1073741819”, and the machine restarts in a
minute! How do I fix this?

Samrat Roy Chaudhuri

Your computer has the Sasser virus. Download and install the
security patch from http://www.microsoft.com/technet/security/

bulletin/ms04-011.mspx. Also, update your virus definitions and scan
the entire hard drive to locate and clean infected files. To stop a PC
from shutting down in Windows XP, when you get the 60-second
countdown, go to Start > Run, type ‘shutdown -a’ and press [Enter].
You’ll now stay connected to the Internet and download the patches.

Question 
of the
Month
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new fonts’ option. What should I do?
Nehal Mehta

Getting the ‘Install new fonts’ option back
into the File menu will be tricky. You need

to boot the machine in MS-DOS mode, and go
to the Windows\System folder. Here, find the
Fontext.dll file, and rename it to Fontext.old.
Extract the Fontext.dll file from the Windows
98 installation CD to the same folder. Now,
restart the PC and check whether the problem
is solved. If it isn’t, your desktop.ini file is
damaged. Restart the PC in MS-DOS mode
again, and go to the Windows\Fonts folder. If
Desktop.ini exists, rename it to Desktop.old,
and extract a new copy from the Windows 98
CD. You can see the steps involved in extracting
compressed files from the installation CD at
http://support.microsoft.com/default.aspx?scid=
kb;EN-US;129605#5.

Sibling fight

I have a Pentium 4 1.6 GHz CPU on an Intel
D845WN motherboard, 512 MB RAM, a 40 GB

hard disk with three partitions, an nVidia Riva
TNT2 64 display card and a Creative SoundBlaster
Live 5.1 audio card, running Windows 98SE.
Recently, I installed Windows XP Professional with
a dual-boot option. Surprisingly, the default instal-
lation options installed it on my C: drive, which
also has Windows 98. Both worked fine for a while,
allowing me to choose an OS while booting.

Now, all of a sudden, I can’t boot into Windows
XP. After the XP loading screen appears, the PC
reboots. Should I reload Windows XP? Can dual
operating systems be installed on the same
partition?

Rajiv Raje

You have to use the Repair function from
the Windows XP CD. You are likely to face

the same problems again though, as both
Windows 98 and Windows XP share the same
Program Files folder. We suggest you install
both OSes on different partitions. 

BIOS upsets

I upgraded from a Pentium III 700 GHz to
Pentium III 1.2 GHz, but when my system

rebooted, it asked for the BIOS setup.  I mistakenly
entered the processor clock as Pentium III 1000.
Now my system hangs whenever I power it on—I

can’t even press delete to enter the BIOS setup.
My technician says I need to upgrade the Intel

810 motherboard since it doesn’t support the new
processor. Is there any other solution?

Arvind Verma

Yes, it is true that the Intel 810 mother-
board does not support the Pentium III 1.2

GHz CPU. This processor is a Tualatin core-
based processor (1.475V), with the same pin
count (370-pins). Hence, though this processor
fits into your motherboard, it will not function.
You have to upgrade your motherboard to a
D812EEA2 chipset-based motherboard. 

Driving off track

I bought a Gainward Ultra/860 LE
Powerpack that has an nVidia GeForce

FX5700LE chipset. I installed this video card
alongwith the necessary drivers, but the display
went blank after the mandatory reboot. On
reverting to my onboard graphics, I got an error
message saying, “The driver for the display
device was unable to complete a drawing opera-
tion. Please check with the device manufacturer
for a driver update.” 

I downloaded the latest drivers from nVidia,
but the problem persists. My PC runs Windows XP
Professional, and has an AMD Athlon XP 2000+
CPU and 512 MB DDR RAM on an ASUS A7N266VM
motherboard with the nForce chipset. The 
motherboard also supports onboard sound.
Please help.

Sandeep Pillay

A device driver conflict seems to be at play.
Here’s what you can do: Boot your system

from the onboard video
card, and then uninstall
all the video card driv-
ers. If possible, use
System Restore to get
back to a time when the
computer was working
fine, and then uninstall
the display drivers. 

Now, reboot your
computer and go into the
BIOS. Go to the Advanced
Options, and look for the
PCI display menu. Under
VGA BIOS, change the
adapter to AGP VGA. Save
the settings, shut down
the computer, and install
the new video card.
Reboot and install the display drivers. Your issue
should be resolved.

Alternatively, start the machine in Safe
Mode. Right-click on My Computer and select
Properties. Go to Hardware > Device Manager
and expand the Display adapters option.
Right-click on each entry under display
adapters, and select uninstall. It is imperative
that you install only the latest drivers for the
motherboard, and also ensure that your BIOS
is up to date.

Roll back your system to a healthy state using System
Restore
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Don’t panic if you run out of hard disk
space. Most computers can support
two or more storage units, so

expanding your storage space is easy. In
this workshop, we will help you make the
switch painless. 

To use a new hard disk, you need to
perform three tasks. First, physically install
the hard disk and connect the power and
data cables. Then, partition the hard disk to
define data storage areas, and finally,
format the partitions to allow the operating
system to read from, and write to the hard
disk. Before you begin the installation
procedure, confirm that you have met the
conditions outlined in the box “Pre-Install
Checklist”. 

Install the hard disk
Open your computer cabinet to allow
access to the components of your PC. Insert

the hard drive into the 3.25-inch bay near
the front of the case. Check for smooth
runners along the bays, which will let you
slide the drive in with ease. The hard disk’s
screw holes should be visible along the slit
on the side. The power and data sockets
should also be easily accessible.

Drive the screws in their respective
sockets, and make sure the drive can’t
move. Fasten screws on both the sides of
the hard drive bay. 

Make sure that you do not drop any
screws inside the cabinet on the mother-
board, and if you, pick them up before you
turn on the power.

Connect the hard disk data cable to the
free IDE connector on the motherboard. 

Connect the other end of the primary
IDE cable to the back of the hard drive (see
“Cables and Jumpers” in box “Pre-Install

Checklist”). This is very easy, and the red
stripe running along the edge of the cable
acts as a visual aid in doing this—the stripe
should be on the edge nearer to the power
socket. There is a notch on the connector,
which also makes sure that you can only
connect the drive the right way. Make sure
that you check for this notch, and insert the
cable carefully. 

Now connect the power cable to the
back of the hard drive. Notice the connector
is ‘D’ shaped-it only plugs in one way, so you
shouldn’t need to force it. Once the power is
plugged in, you are done!

If you are performing a master-slave
operation, here is what you need to do:

The above steps still hold good, but
you have to connect the middle connector
of the Primary IDE channel cable to the
new hard drive. Attach the power cable,
and you’re all done.

Create partitions and format
Verify that they are no loose components
or tools within the cabinet, replace 
all opened panels, and close the cabinet.
Depending on your operating system, 
the steps that follow will vary. We will
show you how to perform the remaining

tasks for either Windows 98 or for
Windows XP. 

On booting up, the OS recognises the
new hard drive. However, it’s unformatted
and not partitioned, so there’s more to do.

Go to Start > Control Panel > Admin-
istrative Tools > Computer Manage-ment
and click on Disk Management for informa-
tion about the drives connected to the
computer.

Right-click on the disk marked
‘Unallocated’, and click on the ‘New parti-
tion’ option to start the wizard. The first
time, choose ‘Primary partition’ and then
click Next.

Specify the amount of disk space that
you want to use out of the maximum size
shown. Choose NTFS or FAT32 as the file
system. If you run Windows XP, and do not
intend to use this PC with any other OS,
choose NTFS for better reliability. Check the
‘Perform a quick format’ option to speed up
this step.

Restart the computer and boot into
Windows XP. Your new hard drive is ready-
to-use.

Upgrade your Hard Disk
1. Backup all critical data. 
2. You should have a new hard disk, an IDE

data cable (looks like a long flat ribbon),
four mounting screws and small Philips
head (+) screwdriver.

3. Check that the power to the computer is
switched off from the switchboard.
Ground yourself by touching a metal
plate, or the side of the cabinet. This
takes care of any static electricity issues
during hard drive installation process.

Cables and Jumpers
If you do have a primary master hard drive,
with an optical drive connected as the
primary slave, don’t change this arrange-
ment. This reduces the connectivity fuss
considerably. Since all new drives come pre-
configured to be Master drives, you need
not change the jumper settings. Just
connect the drive as the secondary master
on the secondary IDE channel.

If your secondary channel is in use,
connect the drive as the slave on the
primary channel. For that, follow the
instructions on the hard drive itself, to
change the jumper setting. Commonly used
hard drives such as Samsung and Seagate
don’t need jumpers, if you are connecting
the drive as a slave drive.

Speed Tip
Most new hard disks follow a fast data
speed standard called ATA-100. To enable
this, use special ATA-100 cables, or your
speedy disk will crawl. ATA-100 cables are
easily distinguishable. Since they have 80
data wires running on the cable, they look
much finer in comparison to the 40 wires on
the slower ATA-66 cables.

The Disk Management tool lets you create an
extended partition

Use the New Partition Wizard to format the
partition

Set the jumper on the secondary drive

Install the hard drive in the bay of the cabinet

Pre-install ChecklistHow to...



Aparna Krishnakumar

o you know what really happens in
your company? Employee X takes
printouts on a regular basis for com-

pany correspondence. Often paper is wasted—
either because a few pages get caught in the
paper feeder, or when the toner runs out in

the midst of a large print run, spit-
ting out half-printed monstrosi-
ties. Then Employee X calls for
help, either from in-house tech-
nical support, or external
sources. Apart from the
obvious wastage, there is
also valuable time lost just
chasing a simple printout.
Now take the expenditure
that Employee X has cost you,
and multiply it by the number of employees
in your company. Can you see the currency
notes burn?

So what do you do? Why not let someone
else take that headache away from you? In one
word…outsource! The problem with outsourc-
ing is that it comes across as expensive, ini-
tially. It is, but only because you need to invest
a larger sum up front. In the long run, howev-
er, it’s proven to be cheaper. Hey, don’t take
our word for it! Ask Delhi-based Northern
Credit & Collection Business Private Limited
(NCCB), who have saved by outsourcing their
printing requirements.

The Company
NCCB is a credit evaluation and credit verifica-
tion services provider. In the 1980s, it was the
first agency of its kind in India to set up serv-
ices for collection and repo with its earliest
client Citibank. Their primary task is to help
in the processing and checking of forms for
loan applications and credit card verifications.
They also maintain defaulters lists to help var-
ious financial and multinational banks make
wise investments with minimum risks. The
company also undertakes collections for finan-
cial institutions and cellular operators.

The office has a staff of 180 and the place is
well equipped with laptops, projectors, 
intercom and Internet facility to provide 
efficient service to its diverse clientele, rang-
ing from MNCs, such as HSBC and ABN Amro,

to nationalised banks like State Bank of India
and Bank of Baroda.

The Problem
With liberalisation, the masses are talk-
ing more loans, and more banks are pro-
viding them. With a staff of 180, the com-

pany manages the increasing workload.
According to Managing Director Tarun Arora,
“The volume of forms handled is enormous, so
we have to invest in a buying a new printer
every second month.” The application forms
are sent to the company via the dealers. Plus,
the company also processes the online forms
that all credit card or cellular companies have
on their Web sites. So why did printing pose a
problem?

Arora clarifies, “The online application
forms have to be with our field executives as
well, so we need printouts. Not only this, but
the respective companies need copies of the
lists of people that we have verified. Often the
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We had a win-win
situation, so
considering the
cost, service and
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WeP and the
service it offered. 
Harkishan Kohli 
EDP Head, NCCB India
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Organisations often ignore the printing costs they
incur. But there are always ways to save money. Here’s
one...Outsourcing!
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a grey market for computer goods, but now
houses some of the best names in software.
Arora was on a casual visit to the place, and
encountered an acquaintance, who told him
about Wipro e-Peripherals (WeP). He was told
that WeP undertakes outsourced printing.
Arora knew of outsourcing, but for printing?

His EDP head, Harikishan Kohli, was
deployed to make more enquiries. Kohli was
so impressed with the concept, and the bene-
fits, that he convinced the management to
give the company an audience. When asked
what factors prompted them to choose WeP.
Arora answered, “WeP happened at a time
when we needed more printers, and at afford-
able costs, so I was willing to try the service.”
Adds Kohli, “From the presentation, it was
obvious that we had a win-win situation, so
considering the cost, service and efficiency
factor, we decided to experiment with WeP
and the service it offered.”

The Process
WeP charged according to the consumption of
paper on a monthly basis. NCCB and WeP
agreed to an initial monthly commitment of
10,000 pages charged at 95 paise per page.

Anand Thomas, Business Head and Chief
Technological Officer of WeP Peripherals,
says, “Initially, NCCB started with a personal
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dealers send the list of applicants as faxes, and
there are days we get 2,000 such forms which
run into 1,000 pages.” In addition, the compa-
ny has to generate reports like any service
organisation, for its clients as well as for itself.
All this formed the major tasks for the printers
in their office.

For the past two years, the management
observed the increase in printing. They had a
combination of dot matrix and HP laser print-
ers. The Electronic Data Processing (EDP) Head,
Harkishan Kohli observed that the output of
the printers was not only lower, but quite
expensive as they had to change a toner car-
tridge every second month.

They tried working more with dot matrix
printers, but they are slow, and can’t keep pace
with deadlines. So, NCCB decided to replace
them with laser printers. However, laser print-
ers for a small organisation are a huge invest-
ment. For an office set up, the laser printers

that are used are in the range of two to three
lakhs. For a small businessman, such as Arora,
the last resort was to ask the companies, which
are his clients, to sponsor printers.

A possible solution
The answers to problems often come when you
least expect it, and from the strangest of
sources. Nehru Place in Delhi is one of the
largest markets in Asia for IT goods. It began as

Business Outsourcing of Printing

Vendorspeak

Cost incurred before WeP
Cost of toner  . . . . . . . . . . . . . . . . . . . . . . . . . . .Rs 3,200
Initial refilling  . . . . . . . . . . . . . . . . . . . . . . . . . . .Rs 400   
Second refilling  . . . . . . . . . . . . . . . . . . . . . . . . . .Rs 400   
No of prints per month  . . . . . . . . . . . . . . . . . . . .20,000
Total cost per month   . . . . . . . . . . . . . . . . . . .Rs 14,000
Operating cost of a laser printer
Including initial cost dep./interest
and other overheads    . . . . . . . . . . . . . . . . . . .Rs 4,000 
Total cost  . . . . . . . . . . . . . . . . . . . . . . . . . . . .Rs 22,000

Cost incurred after WeP
@ 85 paise per printout
Total cost per month 0.85 x 20,000  . . . . . .Rs 17,000
Total annual savings  . . . . . . . . . . . . . . . . . .Rs 60,000

Statistical Figures

“Thirty per cent of our business comes
from outsourced printing. The printers
are allotted after a careful study of the
company’s requirement. Currently WeP
share of NCCB printing is over 60 per
cent.  We have two state-of-the art
manufacturing facilities in Mysore and
Hyderabad that have a combined
capacity to manufacture two lakh
printers and one lakh UPS per year.
This enables us to offer competitive
rates to our customers. Our service
ensures our clients only keep growing.”

Anand Thomas
WeP Peripherals 
Pvt Ltd

It is a relatively new concept for Indian
companies, with great potential.

Outsourcing has helped service sector
industries such as banks, financial
institutions and insurance companies,
BPOs (Business Processing Outsourcing),
software companies and E-Learning
companies.

Some companies have ventured into
the sector. In the complete business
outsourcing-printing segment, WeP and
Canon offer services to various segments
from SMEs to large corporations. This
means, once you avail these services,
you pay them on the basis of the paper
consumption. According to

Lakshminarayan Rao,
Assistant Director OSF
Value, Canon, “The key
consideration, when
selecting the printing
service for SMEs and
SoHos, is that the vendor
must have a wide
product portfolio that
allows one to choose
according to
requirements.”

The future of printing looks
promising. WeP has already set up a
network of public and private print
points, which will offer printing services

ranging from impact
printing to high-end
colour printing within
the next two or three
years. Mobile printing
is also on the anvil.
This means subscribers
to WeP printing service
would have the facility
of printing from any
smart device-PDAs,
Pocket PCs, and mobile

phones apart from tradition devices such
as Desktops, Notebooks and Tablet PCs.

Other companies are also likely to
follow suit. The outlook is bright alright!

Outsourcing for
printing comes
across as
expensive, but
only initally. In
the long run, it
can surely save
you quite a lot of
money

Illustration M
ahesh B

enkar



109AUGUST 2004 DIGIT

laser printer and within months
had all types of printers
installed in the organisation-
personal, workgroup, depart-
mental and centralised print-
ing.” For WeP, the competitive
costing to the clients came from
the fact that they had a huge
installed capacity and their
transactional operational costs
were low. 

So, how did this affect NCCB?
According to EDP head Kohli,
the efficiency improved. He says,
“We did not have to worry any-
more about either the mainte-

nance, or the service of the printers. Right from chang-
ing of toners to servicing the printer, everything was
taken care of by WeP.” He remembers the days before
WeP, when any of their printers broke down, endless
phone calls and reminders to the service people seemed
a routine. But with WeP, all this was taken care of. The
service was quick, and the turn around time was less
than two hours. The prompt service helped NCCB add to
its productive man-hours. 

The Present
According to Thomas, “NCCB from a stage of owning its
printers is now completely dependant on the services of
WeP.” It’s been a little more than year now, since NCCB
availed the printing services of WeP, and they are not
complaining. Arora says, “Last year I have saved more
than Rs 12, 000 after enlisting WeP’s services”. Recently,
WeP has reduced the per page rate to 85 paise for NCCB,
while the consumption has gone up to 20,000. Also, after
the successful implementation in Delhi, the Kolkata and
Mumbai branches of NCCB are all set to outsource print-
ing to WeP.

For Arora, outsource his printing requirements paid
off. Efficiency increased, there was no tension of main-
taining printers, but most importantly, it cut costs sig-
nificantly. Innovation is important, but information
even more so. In the end, it was information about a serv-
ice that saved the day for NCCB.

aparna_krishnakumar@thinkdigit.com

Customerspeak

“ The 15-year-old Xpress
Couriers had branches all
over Tamil Nadu. Like any
other courier company, their
printing involved addresses
to be handed to the delivery
staff. They used to generate
manual PoDs (Proof of
Delivery), which were often
inaccurate due to poor
handwriting. Ten months ago, a chance meeting
at the Logistics Exhibition of the Managing
Director Vijay Kumar with Mr Srinivasan of WeP,
led the former to outsource the printing to WeP.
The company set up a system whereby PODs could
be generated via the printer. This was more
accurate and quicker. Today, Mr Kumar saves an
average of Rs 25,000 monthly.”

1/2 Pg V AD

Vijay Kumar 
Xpress Couriers 
Chennai

I have saved more
than Rs 12,000
after enlisting
WeP’s services.
Tarun Arora
MD NCCB India Ltd
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Microsoft versus Linux
The argument can go on and on. Reliability maybe Linux’s forte while usability is Windows’

domain.  Here are two expert views on the matter

‘We have an assurance...’ ‘Microsoft fits perfectly...’
S B Patankar
CTO, The Bombay Stock Exchange, Dalal Street

Sanjay Sharma
Head, Information Technology, IDBI Bank

FACE-OFF
Photographs M

exy Xavier

Traditionally, our office has been running
Windows. We tested Linux on an experimental
basis. But, Microsoft fits perfectly with our

needs. Our office at BSE houses 500 computers, for as
many people. Here, user-friendliness and ease of
operation are big issues—Microsoft takes care of both.

We have a tie-up with Microsoft, and it comes
with a full suite of products and applications, which
make operations much easier. As a result of this tie-
up, Microsoft also takes special care of our
organisation with facilities such as patch
management. Networking is another major factor.
Given the work we do, we cannot afford too many
disruptions. Microsoft has fared well in this regard.

Although open source operating systems are
freely available, at low costs, we will continue with
Microsoft, its disruption quotient being negligible.
Though we can, we won’t switch operating systems,
since productivity and efficiency are more
important, not just the cost factor. As we are totally
used to working with Microsoft, changing from one
platform to another will be a laborious migration. 

As told to Syed Nadim Siraj

At IDBI Bank, we have been running Linux since
June 2002. We have more than 1,600 employees
across over 100 offices. We consider technical

issues and hardware resource requirements from the
perspective of server-sizing. We also consider on-going
maintenance cost such as Annual Technical Support
(ATS), Total Cost of Ownership (TCO), etc. Based on
detailed analysis of these parameters, we select the OS
for each application.

Linux fit the bill. Windows is easier to administer,
but it’s unstable and expensive. Linux is stable and
scalable. Our overall productivity has definitely gone
up. We achieved substantial savings on hardware, OS
and license cost. We purchased Intel boxes, which
could scale up to our requirements as the volume
grew, without any hardware upgrades. It was
definitely a case of much lower TCO for the bank. For
system administrators, we did a small review course. 

We have an assurance from Red Hat (Clover
Technologies) for support for our deployment too.
You shouldn’t buy a product or OS, based on who
the vendor is!

As told to Suprotip Ghosh
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Yeddanapudi Radhika

very year, there is a spurt in the
number of corporations that involve
themselves in informational non-

broadcast electronic media. Not all of today’s
information and news programs are for 
broadcast. In fact, many programs are
produced for the corporate non-broadcast
settings than in any other genre. You hear the
terms: corporate television, industrial video,
business television, closed-circuit television,
private television—they are all synonyms

describing the business of informational non-
broadcast electronic media. 

The question is, why? What do they
know that we don’t? How do corporates
use video technology? 

Though corporates recognised the
advantages of transmitting images,
two factors inhibited its use: cost
of production and delivery, and
technical complexities.
Production, in the past, did not
use the desktop and
needed specialised equip-
ment and facilities.
Similarly, delivery required special facili-
ties—bandwidth, for example—at other loca-
tions in order to make broadcast possible. All of
this came at a premium cost that made it
unattractive to the corporate sector. An addi-
tional expense was the necessity of techni-
cally skilled personnel, such as video
producers, Web masters and IT professionals. 

Technologies converging towards the PC,
reduction of costs, and an exponential
increase in user-friendliness has generated
immense corporate demand for stand-alone
video products, or video in conjunction with
print media. Compared to the cost of 
producing face-to-face meetings, events, 
training sessions or roadshows, the invest-
ment is actually small. 

With branches spread all over a particular
country, or even across continents, corporates
find video a cost-effective communication tool
to produce training videos, advertisement
spots, sales and publicity material and staff
orientation products. These can be directed at
clients, employees, franchisees and partners.
Video conferencing, and streaming video on

Web sites are among the more recent popular
cost-saving applications. Video has been used
for dissemination of information, about the
company and its people, to familiarise vendors
or sales channels with new products, to train
staff or employees in new skills or procedures,
to report new corporate developments or earn-
ings to industry analysts or the media, and also
to brief staff on recent company changes. 

Video conferencing
Video conferencing has emerged as the best
alternative to actual face-to-face meetings. By
adding tone, voice and visual cues to the 

E

... and other
colleagues using
video techniques
to train recruits,
handle
processes,
create archives—
And yes, save
some money,
too! 

Shoot 
Your Boss...
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mix, it helps employees understand what the
individual on the other side of the screen
intends to convey. 

Brian A Victoria, of the University of
Auckland, says, “Studies have shown that
people remember 20 per cent of what they
hear, 40 per cent of what they see and hear, but
70 per cent of what they see, hear, and do.”
Video conferencing helps reduce the cost of
travel, accommodation and the time taken to
travel. It’s also an ideal way of interviewing
candidates living in far-off places. 

Video Web conference can boost a business
environment. Corporations now leverage previ-
ous investments in intranets, extranets and the
Internet to create Web casts, which are 
significantly cheaper than any previous form of
video production. These events use video
streaming, either on demand an archived or on-
demand basis-participants no longer have to
participate in real-time. These video events
enable management to consistently put forth
their vision, or update employees about 
projects. Communication, being visual, is faster
and can be done on a regular basis. This 
can be extrapolated to include video content in
events, impromptu meetings and also to train
staff in informal sessions.

Convergence has ushered even more devices
into the scenario—mobile phones are one such
example. In Europe, testing is underway to check
the viability of promoting TV shopping channel
access on mobile phones. Mobile technologies
have taken large strides ahead and almost every
mobile device is equipped with a camera. Hence,
it’s not hard to picture a scenario wherein video
conferences will be held with participants on
the move, around the world.

Video in India
Web conferencing The concept of Web confer-
encing is rapidly being adopted. Indian corpo-
rates, including bigwigs such as Johnson &
Johnson, Infosys Technologies, MindTree and
Polaris, are realising the cost-effectiveness and
benefits of Web conferencing. According to
Business Communications Review magazine,
globally, 11 million individuals representing
13,000 customer organisations, either regularly
or occasionally, used Web conferencing in 2001.
This number is expected to rise to 79 million
individuals and 94,000 organisations by 2005. 
Streaming video Streaming video is also
slowly gaining acceptance around the world, as

a cheap way to disseminate information.
According to Jon Klein, former Executive Vice -
President of New York-based CBS News,
“Bandwidth costs alone have dropped so much
that it’s often cheaper  to post a video online,
than duplicate and ‘FedEx’ it to viewers.”

Improvements in the ability of content
delivery networks to deliver a stream of video
without interruption, has resulted in almost
broadcast-quality video to the desktop.
Streaming video also provides more informa-
tion on who’s watching what on a Web site, and
enables better targeting by companies.
Intracompany event promotion Companies
often use video to promote knowledge dissemi-
nation within their staff. For example, TiE, The
Indus Entrepreneurs, needed to promote its
annual retreat in Goa in 2003. The product was
aimed for staff and potential partners, and was
promotional in nature. 

Although created for a one-time event, the
video forms an important record of company
events, and can be used repeatedly to acquaint
new recruits to company culture, and provide a
basis to plan future events. 
Training This is one of the most popular uses
of video. Companies such as JC Penny, an online
shopping and advertising organisation, create
videos on a regular basis for staff on topics that
range from managing your pension plan to
understanding new distribution and procure-
ment procedures. Other companies use video to
provided training on conflict resolution and
sexual harrassment. Video is especially helpful
to train staff employed in different locations. 
It can also subsitute experienced staff to
conduct training sessions. 

To better understand the uses of video, let’s
answer a few basic questions:

Why video and not print products?
Today, most companies have a hybrid video-print
model in place. Combinations of print and video
products are packaged as marketing materials,
and complement each other. Similarly, video—
especially Web-based video—often contains refer-
ences to print publications and Web sites. Even
major newspapers continue with paper circula-

116 DIGIT AUGUST 2004

Smart Business

What can Video do for me?

Promote the company by including
a corporate image video (video
cassette or CD-ROM) in sales
materials and presentations.  
Train employees, and explain the
standard procedures and
responsibilities involved with
different positions.  
Provide a quick reference to
product portfolios for customers.  
Ensure continuous attention at

large events such as trade shows
and exhibits. 
Record one-off events, such as a
seminar or presentation, for replay. 
Produce creative spots that
maximise your advertising spends.
Encourage team building, by
providing visibility for staff by
putting up office or personal photos
in an attractive format with special
effects and music.

Honda and Saab-Interactive Video 

These companies perceived a gap in the
traditional use of video advertising—while it

showed images of the company, it did not permit
the viewer to interact with it.  They have since
begun using a format that has been termed as
companion interactivity. While the video
advertisement is running, they provide data
collection information as a response to consumer
inputs, and even direct consumers to navigate to
a particular page or site.  

PROS
Instant gratification; possibly instant sales
CONS
Deviates from advertising mantra of keeping
user glued to a particular site rather than
navigating away from it.

By adding tone, voice
and visual cues to the
mix, video helps
employees grasp the
idea that the
individual on the other
side of the screen
intends to relay 
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tion, but have Web sites that are able to provide
cutting edge news bites and interactive features,
which measure user needs and satisfaction. 

Is it the best use of my staff time
and resources?
Industryview.com, which promotes business
information and corporate profiles through the
innovative use of videos, has this to say:
“Businesses must communicate! The right
medium for one company may not be right for
another. It all depends on the scope and 
objectives of a marketing plan.”
Industryview.com, which is based in the US,
illustrates, through comparison, the costs and
benefits of media services that are used to
communicate corporate information.

The table below offers a cost comparison of
traditional print brochures versus streaming
media. Streaming media is often misunderstood

as a service that is either too expensive, or only
meant for larger companies. The example 
below illustrates that a streaming video product
can, in many cases, be less expensive and more
effective than its print counterpart.

So what do I need?
First, you need a video camera. With various
models to choose from, there is a wide range of
prices. Sony offers a series of models for the
mini-DV format, ranging from Rs 22,760 to 
Rs 45,520. A Canon mini-DV format camcorder
costs anywhere between Rs 36,420 and Rs
2,04,840. For the JVC, Sharp and Panasonic
models of the same mini-DV format, prices
range from a modest Rs 12,750 to Rs 36,420.
While Sony offers its DV Handycam for Rs 41,250
to Rs 45,520, Panasonic’s DV camcorders range
from Rs 35,280 to Rs 39,140.

You may need additional hardware—Firewire
cards for digital cameras, or analogue capture

Description
Creation cost
Audience/copies
Postage/distribution
Printing costs
Response rates

Total Cost

Suggested reading
http://www.mediatechpro.com/uses.htm
The Next Generation of Corporate
Communications–Jon Leland
Why Corporations are using interactive
multimedia for sales, marketing and
training–Traci Hukill–E Times.com
Better, Bigger, Faster–Seana Mulcahy.
Work–Stephen Porter. 2003
Networked Multimedia-Video Applications: 
Are we crossing the chasm?–Christine 
Perey–Business Communications Review, 
March 1999

cards for analogue camcorders. Note that video
comsumes tons of space when converted into
digital data. Also, capture video at the correct
resolution—capturing at a resolution of 640 x
480, and then resizing it to 352 x 288, amounts
to you doing the entire job twice.

Your PC should have enough processing
power, memory and hard disk space to deal 
with video jobs. You may not need a top-of-the-
line system, but a current generation system 
is recommended. 

Equally important is the software you will
need to edit and compress your video.
Depending on the amount of video that you
capture, and the way you transfer it to your
computer, you can use software such as Ulead
VideoStudio 8 or Adobe Premiere. These offer
integrated solutions that let you capture 
video from the source and transfer them to your
hard drive. You can edit them, add your effects,
put in an audio track, watermark your videos,
and compress them to formats such as
Quicktime and RealMedia.

Conclusion
Technicalities and price tags aside, using video
cameras in your office, though a relatively new
idea today, can serve a substantial number of
purposes for any business house: Orienting
recruits in one mere hour; archiving invaluable
presentations and meetings; promoting busi-
ness in a visually maverick style; reliving
moments of fun in office, and much more.
Simple and incredible as it sounds, all you need
is a video camera for the office to make this
magic happen.

digit@thinkdigit.com

Video broadcasts that
take the form of Web
casts make for a
formidable option of
communication when
you have employees
scattered all across
the globe

Streaming profile
2-minute low-end video
Rs 4,000
10,000
Rs 25,000 
-
Measured directly as 
actual viewers

Rs 29,000

Marketing brochure
2-page multi-colour
Rs 2,000
10,000
Rs 60,000
Rs 35,000
Varied based on 
delivery method

Rs 97,000

Print vs Video
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your phone dies on you. If you are within the
range of a cell phone jammer, you will neither
see any signal information on your handset, nor
the name of your service provider. However, all
calls coming to your phone will be diverted to a
voicemail service—if you have activated this
facility for your phone.

The cell jammer we reviewed—Suresafe SH-
066BM2B-R—only blocks signals of the 900 and
1,800 MHz frequencies. It cannot block CDMA or
TDMA and 800 MHz GSM signals. Of course, you
do get cell jammers that block these signals. The
Suresafe SH-066BLCC is only one such example. 

Businesses can easily activate cell phone
jammers during important events, and all at
easily affordable prices. Here are few places
where cell phone jammers are essential, and
could be implemented:

Confidential meetings
Cell jammers, such as the SH-066BM2B-R, cost
about Rs 35,000. This may seem expensive, but
that's a small price to pay to prevent nasty deeds
such as corporate espionage.

Corporate espionage has many manifesta-

tions, and the Short Message Service (SMS) is
surely one of the easiest ways to get information
out of a locked board room—information, which
could be a goldmine to your competitors, can
filter out through a cell phone, without anyone
even noticing it. The threat assumes greater
significance because your rivals may know of

your decisions
faster than your
own employees.

I n f o r m a t i o n
can also be leaked
out if someone
dials the competi-
tor’s number, and

keeps it connected while announcements are
being made. This is smarter than SMS, and no
one would ever be the wiser. 

Hotels
Hotel owners can use cell phone jammers in 
and around their conference rooms, to 
prevent hosted seminars and conferences 
from being disturbed. A cell phone jammer 
will force peeple to exit the conference 

Etiquette demands the 
switching off of mobile phones in
certain situations, but most people
choose to ignore this. Here’s how
you can make sure that your
business doesn’t suffer because 
of the mobile menace

Aliasgar Pardawala

ome months ago, in Mumbai, Hindi
theatre actor Vikram Gokhale walked
out of a play that he was performing in.

The reason? Despite a request to the audience,
from the play’s actors and producers, to switch
their cellular phones off, a phone did go off
during the performance. It raised the hackles of
the actor, who is one of the seniormost actors on
Mumbai’s Marathi theatre circuit. He returned
to perform only after the man whose cell phone
went off, apologised to Gokhale back stage.

Cellular phones, though equipped with
enough potential to change the way we live our
lives, can turn into major irritants. And it only
takes an untimely call during a business confer-
ence, or inside a library, to remind us of the
minor havoc it can create.

Enter Stage Right, cell phone jammers—
devices that emit the same low frequency radio
signals as cell phones, neutralising each other’s
signals. This means that your phone is unable to
receive signals from your service provider’s base
station. Usually it takes a few seconds before

The Suresafe 
SH-066BM2B-R cell 
jammer guarantees a 
no-ring zone 
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rooms and use 
land-lines to make
the calls. 

Training
A training session is
an active breeding
ground for unneces-
sary phone calls, as employees rarely switch off
their cell phones during these sessions. A
session strength of around 20 or 25 employees
nearly guarantees you a regular cell phone beep.

This not only puts off the
faculty, but also means
that the session’s produc-
tivity decreases, resulting
in a training session being
converted into an exercise
in time wasting.

Medical centres 
Most hospitals use super-

sensitive medical instruments to treat their
patients. Any interference from cell phone
signals can wreak havoc to life-support systems.
To prevent people from damaging instruments,
yet avoid hurting their
feelings, cellular
jammers can be used.
But, also confirm that
the jammers do not
interfere with the exist-
ing signals.

Cinema halls
Want to spend some quality time with your
family or friends? Go watch a movie. But, there’s
no way you can do that today—there’s always a
spoilsport who thinks narrating the movie plot
over a cell phone in real-time to a friend is a fun
thing to do. Even cinema hall owners can’t really
do anything. Patrons blame the management for
any sort of disturbance,
and chiding people about
mobile phones loses
them customers. Cell
phone jammers can
prove to be a gift from the
heavens in such cases.

Libraries
Librarians can’t “shush” the world anymore. In
an age where book readers are a minority, librar-
ians find it tough to ask members to switch off
their phones, lest they walk off and cancel their
membership. Cell jammers eliminate this

awkward interaction. 
If you do decide to use

these methods to help your
business, we suggest you
prominently display a notice
informing your patrons that
you use such devices. This will
prevent uncomfortable situa-

tions, such as doctors thinking that they’re
within reach, while hospitals desperately re-dial
their numbers.

aliasgar_pardawala@thinkdigit.com
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Cell jammers
can open the
gates to 
productivity and
corporate
privacy by
cutting out
unnecessary cell
phone usage

Illustrations M
ahesh B

enkar
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Visual Explanation

Arm Your Mobile Workforce
N A MANICALLY mobile world, just how do you keep your workforce equipped, apart from
the regular laptop, to get the best out of them—both in terms of productivity and quality?
Here, we present some affordable ideas that will make productivity curves skyrocket

Laptop battery
If your laptop frequently runs out of
battery charge before your day long
presentation is over, consider investing
in an additional laptop battery, which
you can swap immediately when needed

Price: Depends on your laptop

USB pen drive
You want to copy a presentation to your
client’s PC; or, your client needs to send back
a 50 MB file. No need to open his PC and
connect your bulky hard disk drive there. Just
use a tiny USB pen drive to easily transfer
files between computers

Price: Rs 1,600 upwards

Infrared and Bluetooth
More and more mobile devices, including
mobile phones, need either an infrared or
a Bluetooth port for wireless data
communication. If your laptop does not
have this onboard, you can use a USB to
Infrared or Bluetooth connector to add
the capability

Price: Rs 1,400 to Rs 1,800

I
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Phone backup software
To a sales and marketing
professional, contacts are
everything. Software such as
Oxygen Phone Manager will ensure
that critical phone contacts and
data are backed up

Price: Rs 2,250 upwards

PDA or Pocket PC
A PDA is lightweight and allows
you to keep you personal
information arranged, keep
track of appointments, take
notes and more. You can also
access the Internet if you have
GPRS enabled. This can be used
as a ready reckoner when with
clients

Price: Rs 7,000 upwards

Data lock
The Virtual HDD Key ensures that even if you
leave your laptop unattended, nobody can
fiddle with the valuable data on it

Price: Around Rs 2,600 

Text Saurabh Kum
ar, Photograph M
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Data cable for a mobile phone
A data cable—easily available on e-commerce or
auction sites—can mean instantaneous connectivity
to the Net, especially if you have a laptop. The cable
also doubles up as a phone charger. You need a
CDMA or GPRS ready phone for Net access

Price: Rs 200 upwards 

WiFi adapter
So your client decided to talk
over coffee at Barista, but your
Laptop is not WiFi-enabled.
Don’t worry, With a USB to
WiFi adapter, you can
easily add that capability
to your laptop

Price: Around Rs 5,250



118 DIGIT AUGUST 2004

Test Centre

Sanket Naik, Aliasgar Pardawala and 
Deepak Dhingra

ou are running your business well
only if every resource is fully utilised,
and every possible inch of real estate is put

to good use. Part of making your business a suc-
cess, is getting people and components to multi-
task. The people we can’t help you with, the
components we can.

In any office, paper-related devices are widely
used. Printers are the most common peripherals;
copiers, fax machines and scanners are also pop-
ular. Any office will have at least three of these
components, and all probably strewn about, wher-
ever space is available. Today, you don’t need to
settle for multiple devices; instead, you can get a
Multi-Functional Device (MFD) that can multi-task. 

Choosing the right MFD
The MFD market has evolved to provide 
multiple verticals that provide a solution for
the varied needs. We divided the devices into
three categories—Personal, Workgroup and
Heavy-duty devices. 

The Personal MFDs category contains
devices that are sheet-fed and have limited scan-
ning abilities. Most are monochrome scanning
devices, and restricted to 256-colour greyscale
scanners. Some of these are actually fax
machines, with laser printer and scanning
capabilities built around them. They are best
suited for very low print volumes, as the cost
per page is high. 

Workgroup MFDs utilise a laser-printing
engine. The consumable used is a unified toner
cartridge. The toner life is usually rated at
3,000 pages, and a drum is said to last for
7,000 pages. This is in a sealed cartridge,
so when your toner is used up, you have
to replace the entire cartridge—
including the half-used drum. 

Heavy-duty MFD technology is the same as
copier machines, which are quite rugged. 
Here, the toner is stored in a separate cartridge
from the drum; so you only replace what you
use up. Typically, a drum is rated to last for
50,000 pages, and the toner lasts for about
5,000 pages. So, a copier-based MFD actually
works out cheaper in the long run.

Personal MFDs
Devices with a smaller footprint are preferred over
the huge machines in small offices. Due to the
absence of a flatbed scanner, sheet-fed MFDs score

in terms of space, and do the same job as their
bigger counterparts. Here, we looked at three such
MFDs from HP, Samsung and Brother. Both the HP
and Brother, can print decently, scan, copy and fax,
whereas the Samsung is primarily a fax machine
that’s been souped-up to work as a printer and
copier. The Samsung 5100P even comes with a
handset—typical of standalone fax machines.

Features
The HP LaserJet 3015 impressed us with its feature
list. This MFD is just 426 mm in width, and has an
unusual vertical box shape design. All the neces-
sary buttons are on the top-colour scan, copy, fax
and print. The USB and Parallel connectors are at
the back. The milky white Brother MFC-9660 is just
as good looking, but a little larger. It has all the

Fax Machine
A typical fax machine for
your office will cost you
about Rs 12,000

Multi-Functional Device
The prices of MFDs range from Rs 15,000 to
Rs 15,00,000, depending upon the features
they come with

Scanner
A typical stand alone 
scanner between Rs 5,000
and Rs 15,000

Y

While the world debates about convergence, Multi-Functional Devices are already 
creating a small revolution in the office. A copier-printer-fax-scanner combo spells huge 
savings not only in terms of money but also cuts the clutter

The All-rounders



necessary buttons such as the fax dial pad, menu
setup, scan, copy, etc. on the control panel. Sam-
sung, on the other hand, sports a regular fax
machine design, with the handset integrated. This
means that it can be used as a tele-
phone unlike the HP and Brother
units.

Fax
The Brother MFC-9660 can store only
32 speed-dial numbers, whereas
Samsung stores a maximum of 90
speed-dial numbers with 10 speed
dial hot keys. The HP offers 120 speed
dial numbers, but with just seven
hotkeys. The Brother MFD can store as much as
500 pages in its memory—the Samsung stores 160,
and the HP only 110 pages. The MFC-9660 lets you
send a fax broadcast to as many as 182 locations,
whereas the HP only allows for a group dial func-
tion to a maximum of 120 entries. The Samsung,
which is primarily a fax machine, only allows a
hotkey entry (a two-digit entry), which translates
to a total of 99 recipients. So, the HP and Brother
actually offer better fax features than the Sam-
sung! 

Printing
Both the HP and Brother have laser-based printers
devices. Both printed at the claimed speed of 14 to
15 pages per minute (PPM). The Samsung, however,
is primarily a fax machine, and thus prints at a
slow 6 PPM. In our speed tests, the HP took the
crown—taking just 11 seconds to print our test doc-
ument. It also managed to yield crisp results—the
Brother took twice the time to finish the same job.
In our mixed document test (text, graphics and
images), the HP managed to print the document in
just 19 seconds. The Brother took 25 seconds for
the same job.

Brother’s huge 250 sheet capacity, dominates
the 150 sheet capacity HP and Samsung. The Sam-
sung MFD has a top loading paper tray, while both
the HP and the Brother have the laser printer style,
front-loading cassette. The Brother scores again
over the others, because of its sliding paper cas-
sette and manual-loading slot for envelopes, labels
and transparencies. 

Scanning
Scanning is where the HP 3015 stands out. It’s the

only MFD in this category with a 600 dpi scan res-
olution, and 24-bit colour depth. The test scans
were decent—it picked up 19 out of 22 shades of
grey, and also did well in the colour deviation test.

Brother scans in monochrome (256
shades of gray) at 600 dpi, which
means you’ll have to invest extra to
buy an external colour scanner.
Samsung can only scan at a quality
acceptable for a fax machine. We did
not run the scanning tests on the
Brother and Samsung models.

Both HP and Brother scan docu-
ments at 100 dpi, by default. In order
to scan at 600 dpi, you’ll need to use

the ‘scan to image’ function and use your PC to
import the image via the TWAIN driver. 

Brother MFC-9660 has three hotkeys for Scan
to e-mail, OCR and image. HP has a ‘Scan to’
button on the control panel that can be config-
ured to Scan to e-mail, OCR, Folder, or other pro-
grams, using the software provided. This feature
is handy, as you can set the scanner to quickly scan
to whatever choice you use most often.

Copy
HP claims to copy at 15 ppm, scanning at 600 dpi,
but our tests showed that it copies at about 12
PPM—the first copy took 14 seconds. The Brother
claims similar speeds, but only managed 10 PPM.
You should keep in mind that these speeds will
vary, depending on the contents of the documents
you want to copy. 

Verdict for Personal MFDs
All three MFDs have their areas of strength, and
weaknesses. HP has a small footprint, a better
scanner and a faster printer and copier. Brother
has 32 hotkeys for speed dial and offers a straight
paper path option for printing envelopes, trans-
parencies, etc. The Samsung offers a handset to
make telephone calls without wasting extra
money and space on a phone instrument. It is
small, but priced too high at Rs 27,000—especially
considering the below average feature set and
slow printer module.

Brother offers the most features, but lags
behind HP because of the monochrome scanner
unit. Brother MFC-9660 is priced at
Rs 31,400, beaten by HP’s price of Rs 22,500. HP
seems to be the obvious choice here.

Workgroup MFDs
For a low to medium volume of printing and
copying, MFDs based on laser printer engines are
preferred. These are generally deployed as shared
resources in departments.

A total of 10 MFDs fell into this category with-
three each from Brother and HP, two from Sam-
sung and one each from Xerox and Canon. Almost
all the vendors have a base model without fax as
well as upscaled versions that have the same
printer and scanner units with fax added on.

Design
Brother MFDs sport an elegant and sober look
that should go well with any office décor. The
off-white body panels, large four-line backlit
LCD and the subtle use of blue panels make it a

Photocopier
A typical heavy-duty office
copier can cost upwards of
Rs 40,000

Printer
A good laser or inkjet
printer will cost 
Rs 15,000 upwards
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Multi-Functional Devices - Buy / Do Not Buy
Small footprint and 

cost-effectiveness Instead of
having to buy four or five different
machines—and maintain each with
different replacement toners, drums
and other parts—you can purchase a
single machine whose printing,
scanning and copying functions use
the same cartridge 

Network considerations Adding
one device to the network instead of
four separate devices, with all the
associated cabling and driver
software is easier. Four devices is

four security problems and four
service warranties, whereas one
engineer can support an MFD

Quality An all-in-one machine may
not offer the same high quality in
each of its functions as separate
machines

Breakdowns If one of the
functions breaks down, the entire
machine is unusable. To preclude
such a disaster, several
manufacturers offer warranties with
24-hour express replacement, 
on-site exchange or fast repairs 

The HP 3015
stands out when

it comes to
scanning, with a

600 dpi scan
resolution, and 

a 24-bit 
colour depth

Photograph Mexy Xavier Imaging Solomon Lewis
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great-looking machine. HP uses its traditional
navy blue body with grey panels, colourful but-
tons and throw in a dash of style with some
flashy lights. The major difference between HP
and Brother is that the former’s models are
more compact. Canon uses sky-blue with milky-
white panels and ends up looking the best of the
lot. Samsung and Xerox have the smallest foot-
print. Canon iC D680 is a heavyweight at 22 kg,
while HP's LJ3030 and LJ3020 are the lightest at
12 kg. All models in this category have an LCD
display. Brother scores with a great four-line
backlit LCD. The rest have a single-line LCD that
displays limited information.

Printing
Barring a few differences in specifications, all the
devices are evenly matched in terms of features.
The printer engines support a maximum of 600
dpi-more than enough for a typical business sce-
nario. All have a 250-sheet capacity-except HP's
LJ3020 and 3030, which have a capacity of 150
sheets. All HP models and Samsung 4216F support
additional paper trays-the rest lack this flexibility.
The output paper trays on HP's 3030 and 3020 are
a bit flimsy. Coming to one of the most important

features-buffer memory-HP and Brother MFDs
have 32 MB of it, while Xerox comes second with
16 MB. Samsung opted for just 8 MB of buffer
memory, and Canon makes do with a mere 2 MB.
More the memory, faster is the printing process,

and entire documents can be spooled into
the printer’s memory. 

We ran a multitude of tests that
stressed each of the three major sub-

systems of an MFD, i.e. Printing, Scanning
and Copying. We did not conduct
performance tests on Fax capabilities, and
only evaluated their features. The test
computers used were two ACi Emerald Pro
laptops with an Intel Pentium 4 2.66 GHz
processor, 256 MB of RAM, a 40 GB hard
drive and Windows XP with the latest
updates as our Operating system.  We
called for MFDs costing below Rs 1 lakh for
the comparison. 

Printing
To test the speeds of the printing units, we
used three different documents--a plain
text document covering 25 per cent of the
page, a combination-document of text and
some graphics covering 35 per cent of the
page and an image file. We logged the time
taken by the printer units to print them. To
determine the printer output quality, we
analysed the test prints taken from the

printer unit during the speed test. We
looked for jarring edges in text, and how
well images were reproduced in black and
white—whether there was any banding
across the image, etc. We also looked at the
smallest possible font that the printer unit
could print. 

Scanning
To test scanning speeds, we used an A4
photograph that was scanned at 600 dpi
with 24-bit colour. Before any scans, we
accounted for the time taken for a scanner
unit to warm up, by taking five previews
before scanning anything. We logged the
time taken to scan the document and
display the output in Photoshop. 

Testing the scanning quality involved
an assortment of tests, the two most
important being:-
IImmaaggee  qquuaalliittyy  tteesstt  uussiinngg  IITT88  ccaarrdd::
Professionals all over the world use IT8
cards to gauge the colour purity of a
scanned image. This card was scanned at

300 dpi, and the colour reproduction in
both light and dark spectrums was noted. 
IImmaaggee  QQuuaalliittyy  tteesstt  uussiinngg  aa  rreessoolluuttiioonn  cchhaarrtt::
This test determines which device is better
at picking up minute details. A resolution
chart with lines was scanned at a
resolution of 300 dpi; we then used the
magic wand feature in Photoshop to
analyse the scanned blocks. Marks were
awarded to MFDs that could differentiate
the maximum number of lines. 

Copying
In order to test copying speeds, we used a
text document consisting of varying font
sizes. We placed the test printout on the
scanner, and noted the copies per minute.

Features
We noted all the features that a device
offered in terms of usability in everyday
life. Special features such as poster-
printing, duplexing, auto-resize, etc, were
also assigned the appropriate importance.

How We Tested

Among the
workgroup
MFDs, the
elegant Canon
models are
ahead in the
race for
good looks. 

Test Centre

Samsung SCX 4216F

Workgroup MFDs

AUGUST 2004

This compact device
is the most capable

all-rounder
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HP’s LJ 3380 dominated the printing perform-
ance. Though rated to print at 20 PPM, it managed
a fast 18 PPM. It was the only device to break the
10-second barrier for the first printout, taking just
9 seconds. The Samsung’s 4216F came in second. 

Scanning 
All the MFDs have scanners with a maximum
optical resolution of 600 dpi. This is enough to
enlarge a 4x6 inch photograph, and print it
without any visible graininess. HP and Brother
MFDs support 9,600 dpi ‘enhanced’ resolution,
whereas Samsung and Xerox top out at 4,800 dpi.
All except Canon have the ‘Scan to PC’ feature so,
you can not use it as a PC scanner.

All the devices use a flatbed scanner with 24-
bit colour depth. These are better than the sheet-
fed variety, since they can be used with a variety of
sources, and generally produce better scans. Most
of the MFDs also come with Automatic Document
Feeders to facilitate scanning multiple sheets. 

Nothing beats Brother in terms of scanning
speed. The Brother models were nearly four times
faster than their slowest competitors-Samsung and
Xerox. The Brother MFDs, also yielded superb
colour reproduction and saturation. The devices
from Samsung and Xerox were able to match the
Brother only in terms of spatial resolution. 

Copying
All these MFDs permit a maximum of 99 copies of
a document. Standard copying features include
Reduce or Enlarge, magnification up to 400 per
cent and standalone copying. Collation is another
feature that is common to all of them. 

The models from Samsung and Xerox have
additional special features such as clone, poster,

auto-fit, etc, which add value. Though these may
not be used on a day-to-day basis, they definitely
come in handy to print posters, banners, etc. As
for copying speeds, HP’s 3380 convincingly
thrashed all the other MFDs in this category to
walk away with top honours. 

Faxing
Faxing was limited to Brother’s MFC 8820D,
Canon’s IC D680, HP’s LJ3030 and LJ3380, Sam-
sung’s SCX-4216F and Xerox’s PE16. Brother-MFC
8820D saves up to 500 fax pages in memory for you
to retrieve them later. In comparison, Samsung
and Xerox both accommodate 320 pages and HP's
3380 stores up to 250 pages. All of them have fax
scheduling to send pre-timed faxes automatically.
Brother, Samsung and Xerox models offer ‘On
hook dialling’ to monitor the connection, handy
in the absence of a telephone handset. 

Verdict for Workgroup MFDs
All said and done, Samsung's SCX-4216F scored
over its competitors with its decent performance,
good set of features and an acceptable price.
Though HP's LJ 3380 was by far the best performer,
it lost the overall crown owing to its high price tag.
If performance is your concern, opt for HP.

Heavy-duty MFDs
Heavy-duty MFDs are good for high volumes of
printing and copying. They have low running
costs, are rugged and offer longer duty cycles. 

Three models from Canon, and one each from
Samsung, Sharp, Ricoh, Toshiba and Xerox
fit into this category. Depending on your

Before Buying an MFD
Consider your Usage Pattern: If you print and copy more, choose a copier
engine-based MFD. If you print more and copy less, opt for a printer
engine-based MFD. If fax is your main concern, opt for a specialised
Laser fax that doubles as a laser printer and scanner
Look for handy features, such as paper capacity, buffer memory, duplex
printing, toner save, etc. 
Make sure the MFD can print on the kinds of paper products you use,
such as envelopes and index cards
Pay attention to upgradeability and scalability. Upgrade options will
extend the life of the device, as your needs grow
Check the type of warranty offered. Laser MFDs are bulky and 
heavy—lugging them around is not feasible, so make sure your model is
covered by an on-site warranty 
Try the console interface to figure out how to operate the device 
Check out the control panel. It should have a good LCD panel to display
status messages and warnings

HP LJ 3380

HP’s LJ3380
dominated the
printing
performance
tests. It clocked
18 pages per
minute and
broke the 
10-second
barrier for the
first printout

AUGUST 2004

The speedy printer
makes it the top

performer, but at a
steep price

Workgroup MFDs
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requirements, you can choose a machine that
has either an A4 or an A3 format. Out of the
eight MFDs, the models from Sharp, Ricoh,
Toshiba and Canon sported the A3 format, while
the rest were standard A4 machines. MFDs of the
A3 format form a niche segment, and are a

viable option for DTP processes and marketing
departments that need to print or scan large
brochures. We sub-divided this category on the
basis of the paper sizes supported-A4 and 
A3. First, we take a look at a more popular 
A4 category. 

Workgroup MFDsCategory

FE
AT

U
R

ES

Brand
Model

Printing
Printing technology
Resolution (dpi x dpi)
Paper capacity for default tray
Additional paper tray facility
Scanning
Max optical resolution
Bit depth
Scan image directly to mail client
ADF 
Copying 
Stand alone copying 
Document management
Collating
Multiple copying in 
standalone mode

Faxing 
Memory for storing (No of pages)
Hook up dialling
Broadcasting features
Misc
Weight (Kg)
Input buffer (MB)
Memory upgrade possible (Y/N)
Dimensions (H x W x D) (mm)
Cables provided
Interface 
Other Features
Software bundled 

Build Quality
Networking capabilities
Ethernet port provided (Y/N)
Optional LAN interface 

Printing
Speed test (Scale of 15) 
Image Quality
Scanning
Speed Test (Scale of 4)
Image quality evaluation 
using IT8 card (Scale of 10)
Resolution test (Lines Pair
Per Inch test)—(Scale of 2)
Copying  (Scale of 10)

Price
Overall

Score Board

Brother 
DCP 8025D

2255..1122
4
Laser
600
250
No
7
600
24
Yes
Yes
1
Yes
2
Yes
Yes

0
NA
NA
NA
9.42
18.1
32 
Yes
461x541x452
No
USB
2.2
MFL-Pro 
Suite

0.7
1
No
Yes
3300..7722
12.86
9.96
2.9
10.23
1.66
6.97

1.6

7.63
11.84
Rs 36,500
6677..6688

Brother
MFC 8820D

3300..1144
4
Laser
600
250
No
7
600
24
Yes
Yes
1
Yes
2
Yes
Yes

5
500
Yes
Yes
9.44
18.1
32 
No
469x532x444
Yes
USB
2.1
MFL-Pro 
Suite

0.8
1   
No
Yes
3300..1188
12.34
9.44
2.9
10.21
2.3
6.71

1.2

7.63
9.58
Rs 45,100
6699..9900

Canon
iC D680

1144..7722
5
Laser
600
250
Yes
2
600
8
Yes
No
1
Yes
1
No
Yes

0
79
No
No
4.92
22.6
2 
No
352x475x442
Yes
USB
0.7                     
Drivers

0.8
0
No
No

2200..4477
12.84
9.94
2.9

0
0
0

0

7.63

11.37
Rs 38,000
4466..5566

HP
LJ 3030

2288..1155
4
Laser
600
150
Yes
7
600
24
Yes
Yes
1
Yes
2
Yes
Yes

3
110
Yes
Yes
9.35
12
32 
No
378x498x401
Yes
USB
1.2
HP Toolbox,
ReadIris OCR,
HP All-In-One
setup assis-
tant, drivers
0.8
1
No
Yes

2277..1111
12.86
9.96
2.9

7.65
1.67
4.78

1.2

6.6

15.6
Rs 28,500
7700..4422

HP
LJ 3020

2255..1155
4
Laser
600
150
Yes
7
600
24
Yes
Yes
1
Yes
2
Yes
Yes

0
NA
NA
NA
9.35
12
32 
No
378x498x401
Yes
USB
1.2
HP Toolbox,
ReadIris OCR,
HP All-In-One
setup assis-
tant, drivers
0.8
1
No
Yes

2277..1111
12.86
9.96
2.9

7.65
1.67
4.78

1.2

6.6
17.63
Rs 24,500
6699..8899

HP
LJ 3380

3311..7711
5
Laser
600
250
Yes
7
600
24
Yes
Yes
1
Yes
2
Yes
Yes

4    
250
No
Yes
10.91
15.7
32 
Yes
495x546x521
Yes
USB
2.2
HP Toolbox,
ReadIris OCR,
HP All-In-One
setup assis-
tant, drivers
0.8
1
No
31.71

3322..1155
14.89
11.99
2.9

8.82
2.74
4.88

1.2

8.44

7.89
Rs 54,724
7711..7755

Samsung
SCX 4016

2266..5599
4
Laser
600
250
No
8
600
24
Yes
Yes
1
Yes
2                     
Yes
Yes

0
NA
NA
NA
7.97
13
8 
No
436x417x474
Yes
USB, parallel
2.7
SmarThru

0.8
1
No
Yes

2277..5522
12.94
10.04
2.9

6.58
1.22
3.76

1.6

8
17.28
Rs 25,000
7711..3399

Samsung
SCX-4216F

3322..5599
5
Laser
600
250
Yes
8
600
24
Yes
Yes
1
Yes
2
Yes
Yes

5
320
Yes
Yes
7.97
13
8 
No
436x417x474
Yes
USB, parallel
2.7
SmarThru

0.8
1
No
Yes
2277..5522
12.94
10.04
2.9
6.58
1.22
3.76

1.6

8
12.34
Rs 35,000
7722..4455

Xerox
PE-16

3311..5599
4
Laser
600
250
No
8
600
24
Yes
Yes
1
Yes
2
Yes
Yes

5
320
Yes
Yes
7.97
13
16 
No
436x417x474
Yes
USB, parallel
3.2
ControlCentre

0.8
1
No
Yes
2255..1166
12.48
9.58
2.9
6.59
1.33
4.06

1.2

6.09
13.94
Rs 31,000
7700..6699

Brother 
DCP 8020

2255..1122
4
Laser
600
250
No
7
600
24
Yes
Yes
1
Yes
2
Yes
Yes

0
NA
NA
NA
9.42
18.1
32 
Yes
461x541x452
No
USB
2.2
MFL-Pro 
Suite

0.7
1
No
Yes
3300..7722
12.86
9.96
2.9
10.23
1.66
6.97

1.6

7.63
14.64
Rs 29,500 
7700..4488

PE
RF

OR
M
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A4 format heavy-duty MFDs
The four MFDs in the A4 format were Canon's
iR1270F and iR1210, Xerox's M15i and Samsung's
SCX-5315F. Both the models from Canon are iden-
tical save just one difference: the iR1270F has fax
functionality thrown in. The iR1270F and iR1210
look better than Samsung and Xerox. Had it not
been for their differing control panels, Xerox's
M15i and Samsung’s SCX-5315F would have
looked like twins!

Printing
When it comes to features, there's hardly any dif-
ference among these models. All have a native
printing resolution of 600 dpi—more than suffi-
cient for most business needs. The paper trays pro-
vided with these MFDs have a capacity of 550
sheets. Canon, however, lets you increase the paper
capacity by adding more trays for a complete 'fill
it, shut it and forget it' operation. Samsung and
Xerox don't offer this feature. 

The models from Canon are rated to deliver 12
pages per minute and they come very close at 11
PPM. The Samsung and Xerox MFDs are both rated
to deliver 15 PPM-Xerox delivered 14 PPM, and Sam-
sung 13 PPM. In most of the printing tests, all the
devices showed no significant difference in the
results. However, in the combination-document
printing test, the Canon MFDs were significantly
faster, taking half the time as compared to the
Samsung and Xerox. It's the same story in the
photo-printout test. Though these devices aren't
suited to print photographs, what's interesting is
their behaviour while printing large files. This

clearly indicates that the Samsung and Xerox
printer units will slow down under heavy loads.

Scanning
Canon seems to think that large businesses don't
need a dedicated scanner, so there's no 'Scan to
PC' function in their devices. This means you can
print and take copies, but you can't use the
scanner for applications such as OCR, scanning
images to PC, etc. The Xerox M15i and Samsung
SCX-5315F have decent scanner units, with nearly
all the features of a standalone scanner. They also
scan an image or text directly to an e-mail client,
or OCR software, and come bundled with basic
document management software.

To simplify your scanning needs, an automatic
document feeder is provided on all except Canon's
IR1210. These multi-sheet document feeders come
in handy when copying many documents, or
when using scheduled  fax. 

Canon's MFDs lack a 'Scan to PC' feature, so we
could not analyse the scan quality. However, when
we made copies, we couldn't find any noteworthy
defects in them. The scanner units on the Sam-
sung and Xerox are almost identical, and do a
superb scanning job. But be prepared to be
assailed by a loud screeching noise as they scan!

Copying
The Canon units allow you to take a maximum of
99 copies in one go, whereas the Samsung and
Xerox units allow 999 copies. Quite a few features
such as auto-fit, clone, poster, side-by-side copying,
etc, are exclusive to Samsung and Xerox. These

add value to the units. Side-by-side
copying helps you save paper by taking

Other Functions You Can Expect From Your MFD
Scan multiple documents in batch processing mode and, optionally, OCR
them
Save the received fax on the computer and print only the needed faxes.
Some MFDs may not provide this feature
Scan photos and e-mail them
Auto fax/phone switch: If you have one line for phone calls and faxing,
some MFDs will switch to the fax function when a fax is incoming 
Broadcasting: Sends faxes to several different numbers simultaneously. 
Dual access: The ability to use the MFD for a second function while
another function is being performed 
Fax memory: If your machine is out of paper, or the ink cartridge is low,
faxes will be stored. When the paper tray is refilled or the cartridge
replaced, the faxes stored in the memory chip will be printed. Some
MFDs can store up to 500 pages 
PC faxing: Sends faxes directly from your computer’s modem without
having to print the document and feed it manually into the fax machine 
Quick scan: Scans a document into memory so you can retrieve your
document without having to wait for it to be processed 
TWAIN: Allows importing graphics without leaving an application

Canon MFDs can
print 99 copies
at one go. In
contrast, the
Samsung and
Xerox units can
print a
remarkable 999
copies. This
apart, there are
quite a few other
features such as
auto-fit, side-
by-side
copying, etc,
that are
exclusive to
Samsung 
and Xerox

Samsung SCX-5315F

Great performer, with a
software bundle that

pushes it past the the
Xerox M15i for the crown

AUGUST 2004

A4 Heavy-duty  MFDs



124 DIGIT AUGUST 2004

copying on both sides of a page, but you need to
use the ADF. The Poster feature scans an image,
and then copies parts of the image onto nine pages
that you can stick to get a huge poster. The Sam-
sung unit comes with three buttons for Toner Save,
Power Save and Paper Save that work!

Faxing
All, except the Canon iR1210, are capable of faxing.
The fax consoles are extensive, allowing one-touch
dialling, auto-dialling, searching, etc. None of the
units have a telephone handset. Samsung has
incorporated an 'On Hook' button that informs you
if the machine on the other end is engaged. The

Samsung and Xerox MFDs can store 200 pages of
faxes in their memory. 

Verdict for A4 heavy-duty MFDs
Samsung and Xerox have a generous software
bundle, but Samsung’s SmarThru, is quite useful
in day-to-day business. SmarThru allows you to
control every function of the MFD through a
single interface. The interface has tabs for
printing, scanning, OCRing, send to e-mail client,
etc. Overall, both the Samsung and Xerox MFDs
were on par with each other in performance.
What went in favour of Samsung was its superb
software which ultimately saw it clinching the

The Samsung
and Xerox units
can store 200
pages of faxes in
their memory.
Even if you run
out of paper, you
can still receive
the faxes

A4 size heavy-duty MFDs A3 size heavy-duty MFDsCategory
PE

RF
0R

M
AN

CE
FE
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U

R
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Brand
Model
Features Score
Printing
Printing technology
Resolution (dpi x dpi)
Paper capacity for default tray
Additional paper tray facility
Scanning
Max 0ptical resolution
Scan area
Scan image directly to mail client
ADF 
Copying 
Stand alone copying 
Document management
Collating
Multiple copying in standalone mode
Faxing 
Memory for storing (No of pages)
On hook dialling
Broadcasting features
Misc
Input buffer (MB)
Memory upgrade possible (Y/N)
Dimensions (HxWxD) in mm
Weight (Kg)
Interface
Other features

Software bundled

Build Quality
Networking capabilities
Ethernet port provided (Y/N)
Optional LAN interface 
Performance Score
Printing
Speed test (Scale of 15)
Image Quality
Scanning
Speed test (Scale of 3)
Image Quality Evaluation using IT8 card
(Scale of 8)
Resolution test (Lines pair per inch test)
(Scale of 4)

Copying  (Scale of 10)
Price Score
Price
Overall Score

Score Board

Canon
iR1210
22
8
Laser
600
500
Yes
3
600
A4
No
No
1
Yes
2
Yes
Yes
0
Na
Na
Na
7
2
No
326 x 475 x 352
24
USB, parallel 
2 on 1 image
printing

Drivers

1
1
No
Yes
18.44
10.8
9.8
1
0
0
0

0

7.64
1155
Rs 55,000
5555..4444

Canon
iR1270F
28
8
Laser 
600
500
Yes
4
600
A4
No
Yes
1
Yes
4
Yes
Yes
3
255
No
Yes
7
2
No
326 x 475 x 352
24
USB, parallel
2 on 1 image
printing 

Drivers

1
1
No
Yes
18.44
10.8
9.8
1
0
0
0

0

7.64
99..1177
Rs 90,000
5555..6611

Samsung
SCX-5315F
35
6
Laser 
600
550
No
5
600
A4
Yes
Yes
1
Yes
4
Yes
Yes
4
320
Yes
Yes
14
4
No
456x560x429
22.85
USB, Parallel
Duplex Copying,
Autofit, Clone, 2
page on single
sheet

SmarThru3

1
1
No
Yes
22.69
9.46
8.46
1
5.75
0.96
3.69

1.10

7.08
1122..6699
Rs 65,000
6699..9988

Xerox
M15i
32
6
Laser 
600
550
No
5
600
A4
Yes
Yes
1
Yes
4
Yes
Yes
4
320
Yes
Yes
11
4
No
456x560x429
22.85
USB, Parallel
1-2 sided 
copying, Clone,
Autofit, N to 1
printout

ControlCentre
5.0

1
1
No
Yes
23.17
9.68
8.68
1
5.74
0.98
3.46

1.30

7.75
1144..2222
Rs 58,000
6699..3399

Canon
iR1600
24
8
Laser 
600
500
Yes
3
600
A3
No
No
1
Yes
4
Yes
Yes
0
NA
NA
NA
7
16
Yes
560x615x631
37.8
USB, parallel
NA

Drivers

1
1
No
Yes
18.07
10.57
9.37
1.2
0
0
0

0

7.05
88..2255
Rs 1,00,000
5500..3322

Ricoh
Aficio 2015
34
8
Laser
600
250
Yes
5
600
A3
Yes
Yes
1
Yes
4
Yes
Yes
0
3MB
Optional
NA
15
16
NA
420x550x568
35
USB
Scan to specific
IP address,
Network card
built in,
Landscape or
Portrait printing
of A4 media
SmartDeviceMo
nitor, Web
SmartDeviceMo
nitor, Web
ImageMonitor,
DeskTopBinder
V2 Lite
ScanRouter V2L
1
1
No
Yes
22.36
13.66
12.06
1.6
0
0
0

0

8.7
88..6622
Rs 95,700
6644..9988

Sharp
AR-M160
35
8
Laser 
600
250
Yes
6
600
A3
Yes
Optional
1
Yes
4
Yes
Yes
0
NA
NA
NA
15
16
Yes
470x590x577
31.3
USB
Autofit, offset
stacking,
Centre/Edge
erase

Sharp
Desk/Button
Manager, Drivers

1
1
No
Yes
22.63
7.01
5.41
1.6
7.98
2.37
4.01

1.60

7.64
88..2299
Rs 99,500
6655..9922

Toshiba
e-Studio 160
24
6
Laser
600
550
No
3
600
A3
No
Optional
1
Yes
4
Yes
Yes
0
NA
NA
NA
9
32
Yes
554x530x600
50
USB optional
8 to 1, 4 in 1, 2
in 1, sorting,
magazine sort

Net Panel

1
1
No
Yes
0
0
0
0
0
0
0

0

7.08
00
NA
3311..0088
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Test Centre

Best Buy Gold award. Xerox's M15i is an equally
good performer and if you can overlook the soft-
ware bundled with Samsung SCX-5215, you will
end up saving a hefty Rs 7,000. 
A3 heavy-duty MFDs
Four different machines from four different man-
ufacturers were slotted in the A3 form factor.
These are more rugged than the A4 machines, and
offer heavy-duty capabilities. Since these
machines are large, you will have to make some
space in your office. They look like the old copier
machines-huge and heavy. Toshiba was mon-
strous, and Ricoh and Sharp were not much
smaller. Canon's iR1600 managed to save on space.
Toshiba e-studio 160 also follows a modularity
approach: the base unit is huge and comes with
just the copier. The scanner and printer unit are
added on demand and cost over a lakh, which inci-
dentally was the price limit for all tested MFDs.
Hence, we  couldn’t test them. 

Printing
All these machines use laser-printing technology
and are rated at different speeds. The Canon MFD
is rated at 16 PPM, but managed 13 PPM. The
model from Sharp was a disappointment-it's rated
at 12 PPM on a USB 1.1 interface, but just about
managed a pathetic 5 PPM, leaving no room for
doubt that its printing engine is much inferior to
that of Canon's. Ricoh's Aficio 2015 was able to
print at 14 PPM-undeniably speedier than both,
Sharp and Canon. All these machines are designed
to offer a lowest cost-per-page-between 35 and 45
paise. We could not test the performance on the
Toshiba MFD, but from the copying speed it does
not look like a couch potato either.

Scanning
Sharp's AR-M160 has a decent scanning unit that's
the best in this category. The accompanying soft-
ware also adds to the practicality of the unit. Akin
to the other MFDS manufactured by Canon, the
iR1600 lacks the 'Scan to PC' feature. One inter-
esting thing to note is that the Aficio 2015 from
Ricoh offers only network-scanning and supports
256 shades of grey-no colour scanning. The same
applies to Toshiba's e-studio 160: this clearly indi-
cates their lineage-copier machines. All said and
done, in terms of scanning performance, Sharp's
AR-M160 stands tall. 

Copying
Sharp's AR-M160 is a notch above Canon's iR1600,
when it comes to usable features. Features such as
enlarging or reducing, zooming, auto-exposure,
etc, are present on both MFDs. However, copy-
auditing, offset-stacking, etc, are a few features
that Sharp offers, which add value to the bundle.
The copy-auditing feature allows administrators
to track usage on a per-user basis-specific people
get accounts and need to enter a password before
making copies. Similarly, offset-stacking stacks dif-
ferent jobs separately so that they don't get mixed.
Other advance features such as copying 4 pages to
one page, rotation, margin shifting, etc, can be
enabled by optional accessories. These features are
also the hallmark of Ricoh's Aficio 2150 and
Toshiba's e-studio 160. Canon offers an optional
stapling unit to staple multi-page documents

automatically, thus helping you avoid a mix-up.
This happens to be more effective than offset-
stacking.

Sharp has six buttons that can be assigned to
launch specific applications. For example, if you
are OCRing a document, just press the button
that's assigned to the OCR software. The scanned
image opens in the application directly, thus
speeding up the process. Sharp's AR-M160 was the
only unit to bundle a colour scanner in this cate-
gory. 

Faxing
Faxing units on all these machines are optional,
hence you will need to pay extra money to buy
them.

Verdict for A3 heavy-duty MFDs
Nothing beats the Sharp AR-M160! The features it
offers and its reasonable price tag, wins it our Best

Buy Gold Award for this category. Its slow
printing speeds might be a deterrent, and

you might want to look for a USB 2.0 expansion
card. Ricoh's Aficio 2015 was equally impressive,
but lost valuable points in the scanning depart-
ment. If printing and copying forms the bulk of
your needs, and you can overlook the lack of
colour scanning, the Aficio 2015 is a good choice.
That also qualifies it for our Best Buy Silver Award.

sanket_naik@thinkdigit.com
aliasgar_pardawala@thinkdigit.com

deepak_dhingra@thinkdigit.com

Caution 
Don’t get carried
away by pages per
minute (ppm)
claims. They vary
depending on the
coverage area of a
page 
Humidity affects
the working of a
Laser MFD, so
make sure you
have a cool dry
place for it in your
office

Progress Publishers, Delhi-
based publishers of school

textbooks, have been using laser-
based MFDs for over five years.
For the last two years, Anant
Gupta, proprietor, Progress
Publishers, has been using the HP
LaserJet 3300. It is shared by four
or five users, and prints
approximately 6,000 pages a
month.

Gupta decided to buy an MFD
for his office to get the benefits of
a photocopier, without actually
paying for one. He feels that the
scanner in an MFD is not critical
enough. He says, “The cost per

page is between 75 paise
and Re 1 per copy, but I
save a lot of space that
an extra scanner would
take. The print quality
is satisfactory. It has all
the basic features that all
the products in its class have,
such as printing modes—economy,
600 dpi, 1,200 dpi, memory, etc.”

However MFDs do have their
set of disadvantages. Says Gupta:
“For originals with Photos and
Text the result is barely
satisfactory. Multiple trays aren’t
available, and the existing one can
hold only 250 pages.”

Why I use an MFD

Sharp AR-M160
Loads of useful features
and plenty of expansion
options make the Sharp

a good long-term bet

AUGUST 2004
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Trend

Live Life
WIRELESS FIDELITY OR WiFi is being touted as the next big thing to
happen to India after the mobile boom. However, a study conducted by
IMRB last year found that low awareness coupled with high installation
costs prevented it from being widely accepted in the Indian market.  We
spoke to five decision makers in their respective domains about their
WiFi experience.

The need to go WiFi was prompted by the
desire to match international standards
in hospitality.  The Bay-View lobby and

Geoffrey’s, the pub, are the WiFi hotspots
within the hotel that use the 802.11b version.

Our foreign guests, and others who have
Centrino laptops, are delighted at being able to
use the WiFi facility. There has been increase in
the number of official lunches and presenta-
tions using the Net connection. Since the speed
is high, and the connection uninterrupted, we
have several guests from neighbouring hotels
too. I see a WiFi future, where hotel operations
such as ordering in restaurants, inventories,
maintenance reporting, and also security mon-
itoring, would be a lot easier.

We are a global leader in supply chain
management, providing customer
focused solutions to a wide range of

manufacturing and retail industries. 
With varied clients, such as Mercedes Benz,
Unilever, GE Medical and Levi Strauss, and
with multiple offices in five cities, going WiFi
was more a need than a fancy. The main
visible benefit is the ‘uptime’ of links. Our
uptime is close to 98 per cent, and there is
less manual monitoring required, which
ensures that IT support personnel can
concentrate on other areas; switching to WiFi
is a long term solution.

Suresh Subramanian
Deputy General Manager,
IT Exel India Limited

Anurag Bajaj
General Manager Hotel
Marine Plaza, Mumbai
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Prashant Jain
Director, Pathways School
New Delhi

Wirefree

Two years ago, the institute faced a
problem of an inverse student-computer
ratio. The number of students taking

admission to management courses was
increasing, and the computer centre was
barely able to support everyone. To counter
this, and also to be one of the first to usher
in the new technology, we opted for WiFi.
Our students use laptops, and with WiFi,
they can access the Net anywhere—this
reduces the cost of maintaining a huge
computer lab with its peripherals. Also,
guests find it useful to be always connected.

Sumedha Sabharwal
Head of Computer Centre
Welingkar Institute of
Management, Mumbai

It’s been a year since the Collectorate office,
the Collectorate Camp Office and the
Superintendent of Police (SP) office were

WiFi enabled-with 802.11b. We opted for WiFi
because it does not involve civil work, takes a
short time to become operational, helps me
stay connected to all sites nearby, and most
importantly, has provision for VoIP—which has
reduced my phone bills. Activities, such as
updating reports, online data entry,
conducting online training classes and being
constantly connected to the Hyderabad head
office, are easier than before.

PS Ramakrishna Rao
Collector and District
Magistrate, Guntur, AP

Computers isn’t a subject at this school,
it’s a tool for education. Our teaching is
project-based, and WiFi gives a student

flexibility to work from anywhere—the school,
hostel or even the library. The whole campus
is a WiFi hotspot—802.11b, with a speed of 11
Mbps. For the school, being WiFi is
particularly valuable within the classroom or
laboratory, where seating plans and furniture
distribution change constantly to reflect the
multiple needs of the curriculum, after all
‘Anytime, Anywhere’ learning is the essence
here.

As told to Aparna Krishnakumar and Suprotip Ghosh



Garfield D'Souza

f he ever featured on a
music television count-
down show, its producer

would put Tausef Syed in the
“bubbling under” segment.
Tausef is 15, and like most
teenagers his age,
likes Aishwarya Rai
and Hrithik Roshan.
He loves mathemat-
ics at school, and he
wants to be a pilot
when he grows up.

Tausef works in a
garage.
His enthusiasm
belies his financial
status—his father,
Latif, is a contract
labourer and just
about earns enough
to feed his family.

Tausef’s energy
and zest for life
could well be because he is con-
fident his education costs—pen-
cils, books, paper—would be
taken care of by Apnalaya, a
Mumbai-based NGO that 
specialises in child welfare 
and education.

Swapnil Dhamankar is 19.
He quit school when he was in
the seventh standard, but he
plans to live life on his own
terms. His ambitions are, well,
not even ambitions really.
Swapnil wants to become a
good tailor, and spends most of
his time “studying” for his tai-
loring course. He also earns a
stipend of Rs 500, and says he

will earn more in the future.
Much more.

Swapnil is deaf
He is gung-ho about the future,
though—he has the support of
the National Society for Equal
Opportunities for the
Handicapped (NASEOH).

What connects the
two is a Web site
called GiveIndia.org,
an online channel
that lets people
donate to the NGO
and the cause of their
choice. Various NGOs
get listed on the site
so that people can
donate to the NGO of
their choice.

It is an idea as sim-
ple as they come—a
supra NGO that lists
various NGOs after
carefully going
through their creden-

tials. Says GiveIndia director
Venkat Krishnan: “Our hope was
that a channel like this will give
small, relatively unknown NGOs
a chance to reach out to
donors all over India and the
world. The emphasis is also
on promoting giving in a
transparent, efficient and
effective manner.” 

Every NGO has its
financial statements
listed, with a break-up
of how the donated
money would be used.
They are also classified
according to states and
various social causes. 
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A Site to Give
Swapnil Dhamankar and Tausef Syed are just two among the thousands 
of NGO beneficiaries in the country. Here’s how technology connects them

I

Touched by Tech

Take your pick. GiveIndia, in a
way, represents the new face of
the Indian NGO—professional,
transparent and committed to
the cause. 

Says Sudha Balachandra,
director general, NASEOH,
agrees: “Online donations are a
methodical way of getting
funds, and GiveIndia is 
transparent in their 
functionality.”

Adds Apnalaya
head Leena Joshi:
“Most of the visitors
to the site are casual
surfers. But for NGOs
like us, awareness is
of prime impor-
tance.” Dr A
Goswami of Child
Aid Foundation, an
NGO based in
Vijayawada, Andhra
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I’m not sure
what I plan to
be in life, but

work I will
Swapnil

Dhamankar
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Pradesh, echoes the point. "We
wanted our name to be identi-
fied with a very-well known and
respected brand.”

The reason for this healthy
respect is simple: All NGOs have
to comply with strict norms and
regulations to be included on
the Web site. For instance, one
selection criterion is that no
NGO with a political link is
allowed to be on the site. The
rules also state that at least half
the people benefiting from their
projects should be economically
underpriveleged. 

GiveIndia also does an
appraisal of the organisation to
see whether they meet
Credibility Alliance norms.
Credibility Alliance is a world-
wide association of organisa-
tions and networks that aim to
improve governance in the vol-
untary sector.

The last step, but probably
the most important is when the
GiveIndia team visit the NGO
and see their activities them-
selves. It is not easy to qualify
to be featured on GiveIndia.org.
Apnalaya, for instance, found it
tough to get in, even if its list of
donors includes celebrities,
such as, cricketer Sachin
Tendulkar.

Says Joshi, who founded
Apnalaya in 1979, “Qualifying to
be registered with GiveIndia was
not an easy process. But we felt
it was good to get ourselves eval-
uated by an outside agency. The
evaluation process helped us
take a second look at ourselves.”

The response has been
tremendous, says Venkat. For
instance, organisations such as
Child Aid Foundation,
Vijayawada, manage to get Rs 2-3
lakh through GiveIndia. “That’s
50 to 60 percent of its annual
budget. However, the same
amount translated to just 25 to
30 per cent of the finances for
organisations such as the
National Association For 
The Blind.”

On the other hand,
Apnalaya’s 2001 earnings were
Rs 40 lakh, as listed on the site.
But since its online launch on
GiveIndia, Apnalaya has been
earning a small amount of its
funds through this channel.
“Online donations are sporadic
in nature,” says Joshi. “Many of
them are one-off instances.” 

NASEOH’s Balachandra says:
“There is no uniformity in the
nature of donations.”

Adds Armine Damodiwala,
head, Indian Council for Mental
Hygiene (ICMH): “They are nei-
ther a huge flood nor a trickle.
They ride on a medium wave.”

Most contributions usually
come in to sponsor individuals.
Apnalaya found that projects
such as community clinics that
involve getting doctors to per-
form routine checkups do not
have many takers. These little
problems notwithstanding,

NGOs (and there are more than
100) on GiveIndia say that the
concept of online donations was
picking up, and they were glad
they took the plunge.

Online giants, such as,
Google and Rediff have given
free ad space to GiveIndia. For
instance, if you type in “India
charity” on Google, the first
sponsored link you get is the
GiveIndia site, as part of the
Google AdWords scheme.

Donors, too, have a good
word to put in. Says Aarti
Madhusudan, a UK-based Indian,
in an e-mail to GiveIndia: “I am
sure you hear this from many
people and all the time, and it is
probably superfluous, but I felt
like saying that it is remarkable
to set up something like
GiveIndia, and I am honoured to
be part of it, even if my dona-
tion is really small. I wish I
could do more.”

Swapnil and Tausef, just two
of the hundreds of beneficiaries,
are not really aware of who is
donating online to fund them—
be it Google or Aarti. But they
couldn’t care less—they just
want to be a tailor and a 
pilot. And with it, give some-
thing back to the society that
helped them. 

garfield_dsouza@thinkdigit.com

What can I donate?
Just about anything, and in any
manner. Apnalaya, for instance,
lets you contribute to its Corpus
fund, General Fund as well as
donate educational sponsorship
for a child. Other projects range
from programs that train a group
of 25 in tailoring to three-day
training programmes in
community development. NASEOH
specifies donations required for a
tricycle, as well vocational
training for a year for a disabled
individual. 

The mode of payment can be
through a cheque, a demand
draft, as well as online credit
payment. You can also opt for ICICI's online
banking payment system. GiveIndia also
has a proprietary My Account system,
wherein you can open a charity account
with GiveIndia.org. You can deposit money
in it via credit card, Net banking or cheque
payments. You can get the requisite
donation amount deducted from 
My Account. 

If you do not like to donate, you can
also shop and help by tying up with
Craftsbridge, a company that promotes

Indian handicrafts. These funds are then
used to support artisans who crafted them.

Can I donate my time?
Of course you can. If you like to spend your
weekends or other holidays doing
constructive work, you can register online
to work in orphanages, old-age homes,
helplines, schools, relief efforts, NGOs, etc.
The Placement Services link has just about
all the information you need to register at
the nearest NGO.

Section 80G of the Income Tax Act allows 50 per cent
of your donation to be tax deductible. Impressed?

There’s more. Certain specified projects allow the benefit
of Section 35AC of the IT Act that increases the percent-
age of deduction to 100 per cent. Section 35(i)(ii) goes
further and shoots up the donation deductions to 125 per
cent from your business income and 100 pef cent from
your salary income.

Tax Benefits

Donorspeak

Online donations help these children at Apnayala get an
education

I am an NRI. I used to donate for 
charitable causes while I was on vacation 
in India. It used to be so hectic. Then I
found GiveIndia.org. I have been a regular
donor through this site, and have been
impressed by the way they provide 
a link between the donor and the NGO. 
Sanjay Khanna
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China banning Web sites and
clamping down on cell phone

messaging is not new. But on July
6, Chinese media reported that the
nation had adopted a revolutionary
technology. What was it?
a. The IPv7 protocol, a proprietary
Chinese protocol
b. A “mystery” protocol called IPv9 
c. VSE (Very Strong Encryption) for
all incoming and outgoing e-mails 
d. The RISA protocol, which would
allow Cabinet members to read 
private e-mails

Privacy has always been
sacrosanct on the Internet.

But on July 7, a three-judge US
Federal Appeals Court panel ruled
that...
a. E-mail service providers can copy
and read messages intended for
their customers.
b. ISPs can track their clients’
Internet usage patterns
c. Anonymisers on the Internet will
now be illegal
d. Credit card fraud would now be
punishable by death

The first edition of this quiz
was held in 1988, and is

modeled after college quizzes of
yore. It features some of the
biggest industry giants, and
winners have included Lotus
founder Mitch Kapor and Google
CEO Eric Schmidt. Which is this
super-popular quiz show?
a. Computer Bowl: Reboot 2004 
b. SuperBowl Computing
c. Computer Bowl 2004
d. Computer Superbowl 2004

In June this year,
MarketScape, a small 

US-based company sued an
imaging software giant for alleged
infringements on a patent that
covers extracting network
information. Which IT giant are we
talking about?
a. Adobe
b. Macromedia
c. Corel
d. Discreet

Founded two years ago, this
MIT project aims to ‘free

people from computer jargon,
keyboards, mice and other
specialized devices.’ A joint
venture between the Laboratory
for Computer Science (LCS), the
Artificial Intelligence Laboratory
(AI Lab), and six major
corporations, with support from
the Defense Advanced Research
Projects Agency. Name the project.
a. Project Ozone
b. Project Oxygen 
c. Project AI
d. Project Helium

Stelor Productions, which
owns www.googles.com, is

suing Web search giant Google for
infringing name. The company
claims that it owns the domain
name since 1997 and was two
months live before Google. Who is
their target audience?
a. Kids
b. Women 
c. Sports enthusiasts
d. IT firms

7

6

2

1

8

5

Which company recently
unveiled a collection of

designer mice models—two wireless
and one wired—in the most unusual
colours created by famed industrial
designer Philippe Starck?
a. Apple           b. Hewlett-Packard 
c. Microsoft     d. IBM

3
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Crossword 
Across: 6. Compaq, 8. Images, 9. Edit,
10. Octal, 11. Start, 13. Provide, 16.
ProTalk, 17. Draw, 20. Input, 21. File, 22.
Server, 23. Pascal
Down1. WordStar, 2. Spot, 3. History, 4.
Failover, 5. Redo, 7. QDOS, 12. Retrieve,
14. Download, 15. Clip art, 18. Stop, 19.
IGES, 21. Fast

Quiz
1: b, 2: a, 3: c, 4: a, 5: a, 6: a, 7: b, 8:a

Across
6.  ------ Presario PCs from HP (6) 
8. Visual representations stored in

electronic FORM (6)
9. Cut out to modify data (4)
10. Base-8 notation (5) 
11. Boot up upsets tarts (5) 
13. Make available (7) 
16. An object-oriented

Programming in Logic (7) 
17. Direct Read After Write (abbr)(4) 
20. Data entered into a computer(5) 
21.Element of data storage scatters

life (4)
22. Waiter to host computer on a

network (6)
23. Programming language named

after French mathematician(6) 

Down
1. DTP package of the 80s, confused

art words (8)
2. Microsoft’s new

technology reverses
heights (abbr) (4)

3. This icon resembles a sun
dial in a web browser
toolbar(7) 

4. Hot standby or Warm
standby? (8) 

5. CTRL+SHIFT+z in Corel (4) 
7. Quick and Dirty Operating

System (abbr) (4) 
12. Locate and read data

from storage (8)
14. Discharge cargo to

transfer computer data(8)
15. Prepackaged art work

(4,3) 
18. Bit end to an asynchronous

transmission! (4)
19. Initial Graphics Exchange

Specification (abbr) (4)
21. High-speed computer (4)

Compiled by Nitaa Jaggi

Crossword 

Answers

Got an
interesting
question? 
Send it in with
the correct 
answer to
quiz@thinkdigit.
com

Of mystery protocols and
celebrity quizzes...

Music legend George Michael was forced to
shut down his Web site message board

because fans had been using it to log disparaging
comments about him. The accusations ranged
from his failing to promote his recent album, the
poor quality of his recordings, and ...?
a. Him being overweight b. Him copying songs
c. His vulgar lyrics d. The site not opening in the
Opera Web Browser

4

An average Internet 
user spent 604

minutes online in June
2004, as compared to 
493 minutes in October
1999

Did you
know?



Business2.com June, 2004

Does Google Show Other
Corporates the Way?

WE ALL KNOW Google is the best,
but can it be a role model for the
rest of the world’s corporates?
Melanie Warner from Business 2.0
provided the answer:

The Wisdom of Google
Lesson 1: Don’t sell your soul to the
highest bidder

From the start, Brin and Page took
the high road with advertising. While
other search engines were secretly

tucking paid advertiser sites into their listings—a process called
“paid inclusion”—Google decided that the only parts of its site it
would ever sell to advertisers would be clearly marked
“Sponsored Links” sections at the top and side of the page. The
founders also refused to allow banners and pop-up ads. Brin, in
particular, was adamant about this. He hated using search sites
like AltaVista and Yahoo! and waiting while a colorful, inane ad
lumbered across the screen.
Lesson 2: Create a culture of risk taking
Now that Google dominates Web search, it’s easy to forget how
strange its approach really was in 1998. The notion that the
world needed another search engine—there were already at
least 10—was absurd. Though the quality of search results was
declining as the Internet swelled, most people didn't seem to
care. Even technologically savvy people like Kordestani were
content with their search engines. “I was using Yahoo! and
Netscape,” (Omid) Kordestani (head of sales at Google) admits.
“In some ways, you just didn't 
know any better.”

Conventional logic held that the ability to do searches was,
at best, a feature of some bigger, fancier product. Google
stripped its search engine down to the point where it looked
naked. No news, no weather, no horoscopes. Just a goofy logo in
Romper Room colors, and a search bar floating on an empty
page. 

Such a counterintuitive move branded Page and Brin as
serious mavericks, which in turn attracted kindred spirits. It’s
partly why Google CEO Eric Schmidt was so keen on taking the
job. Schmidt tagged himself as something of a risk taker when
he quit as Sun’s (SUNW) chief technology officer to join the
ailing networking company Novell. Brin delights in saying that

he and Page chose Schmidt because “he was the only candidate
who had been to Burning Man.” 

The risk-taking culture at Google is fostered by a policy that
encourages engineers to spend 20 percent of their time working
on personal projects that may or may not benefit the company.
The point is to get people thinking creatively and
independently...  

Even the aspects of Google that make it seem more like a
kindergarten than a company worth billions—the lava lamps, the
Segway scooters, the remote-control UFOs Brin and Page bought
at Costco a while back for no particular reason—send an
important message. They remind people that companies don’t
have to operate the way everyone thinks they’re supposed to. 

Read the entire story at
www.business2.com/b2/web/articles/0,17863,634420,00.html?ref=specials
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Pixar Out-Disneys Disney
CRICKETER AND COMMENTATOR
Sunil Gavaskar was once asked
how he felt when Allan Border
crossed his world record for the
most number of runs in Test
cricket. He replied: “Hundreds of
people have reached the summit
of Mount Everest, but nobody has
ever forgotten Edmund Hilary and
Tensing Norgay.” 

Walt Disney is in a similar
situation these days—the

challenger has arrived, but we never forget Disney. Pixar,
the company that apprenticed under Disney and created
movies, such as Toy Story and Finding Nemo, now threatens
to upstage Disney’s unchallenged monopoly in the
computer graphics (CG) animation features space.

Freelance writer Austin Bunn’s excellent business and
technology sketch of Pixar Animation Studios, in the June
issue of Wired magazine, chronicles the rise of Pixar, and
poses the question: Will Pixar now be the master, and
Disney the apprentice? 

An excerpt from the piece: 
By any standards, Pixar Animation Studios has reached

infinity and beyond. From 1995’s Toy Story—the world's first all-
CG feature—to last year’s Finding Nemo, Pixar’s five
hermetically crafted movies have grossed a staggering $2.5
billion at the box office, making it the most successful film
studio, picture for picture, of all time. “You have to take your
hat off to them,” says Neil Braun, head of CG-animation
company Vanguard and former president of the NBC Television
Network. In the history of film, there’s just one precedent for
this level of economic triumph, this ability to add to the
American childhood’s beloved cast of characters: Disney
Animation Studios.

Pixar hasn’t just turned into the new Disney. It has 
out-Disneyed Disney,
becoming the apprentice
that schooled the
sorcerer. Pixar’s most
talented animators
grew up admiring
Disney, worked at the
sketching tables in
Burbank, and went
on to crib the company’s DNA. Pixar’s story development
process as well as its internal lexicon—including sweatbox,
when the director critiques individual animations, and plus-ing,
heaping more and more good ideas on a structure that's
already working—come directly from the ‘House That Mickey
Built’. Both companies are technical pioneers: Disney imbued 2-
D cel animation with comedy and heartbreak; Pixar coaxed
empathy from digital effects. Now the flipbook animation style
that made the Magic Kingdom a powerhouse is fading to black:
Disney’s Home on the Range, released in April, is the last fully
2-D production for the studio, and competitors like
DreamWorks are retraining illustrators to be 3-D mouse
jockeys. Pixar's digital animation is the wave of the future.

Read the entire story at www.wired.com/wired/archive/12.06/pixar.html

MediaWise
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AdWise
Newsweek June 21, 2004

For Microsoft, All Roads 
Lead to China

CHINA IS, WITHOUT any doubt,
the only superpower who can
seriously think of challenging US
hegemony—politically, militarily,
technologically, and even
economically. Hence, it is only
natural that Microsoft, the
world’s largest software company,
has it second largest set up after
its Redmond headquarters, in
Mao’s country.

Newsweek analyst Sarah
Schafer wrote about how Bill Gates and his CEO Steve
Ballmer are courting China for the company’s 
next big foray.

Excerpts from the brilliant feature:
Microsoft’s largest beachhead outside the United States is in

the state most hostile to it: China. Since arriving in Beijing in
1990, the Gates empire has assembled a network of business
operations, from research and development to sales and
marketing to customer support, second only to its Redmond,
Wash., hub. Bill Gates and CEO Steve Ballmer, whose minutes are
managed as priceless commodities, regularly swoop into China
for meetings, trying to find a way to make it in the elusive China
market…

For Microsoft, the problem with doing business in China
comes down mainly to one thing: piracy. Touts line the street
outside a new $80 million Microsoft research center in Beijing,
steering customers through alleys to run-down apartments
where bootleg copies of Microsoft Office and Word are peddled
for about $1, at least $199 less than the global retail price.
Ninety percent of Microsoft products used in China are pirated... 

But in China the government has been sympathetic to the
pirates, openly hostile to the Microsoft monopoly and officially
embraced Linux. Cheap software has been critical to China’s
economic boom, and Beijing saw no upside to forcing citizens
with an average annual income of $1,000 to spend much of it on
Windows.

The new Microsoft China strategy attempts to create a
constituency for full-price software, starting with the political
and business elite. This means improving customer support for

big Chinese companies, helping
Beijing develop a domestic
software industry trained on
and tied to Microsoft
products, sharing more
technology and easing up on
buyers of pirated software
(but not on pirates). In
September Microsoft made

Timothy Chen its new China CEO and the face of its softer
strategy. Chen, a 10-year veteran of Motorola China, says he was
drawn by a mandate from the top-Gates and Ballmer-to revamp
the Microsoft operation. "They all wanted to see an integrated
China strategy, a road map," says Chen. He has dropped "the
threatening-letter approach" and focused on recruiting large
corporations as paying customers: "If we do that, I think then the
legal users will come."

Read the entire story at
http://www.msnbc.msn.com/id/5239397/site/newsweek/

Beauty in the brains
GE is a world leader in medical electronics. Now, we figure, it
creates great ads, too! GE’s new technology lets doctors see
the human brain clearly, and us the copywriter’s brilliance.

Bloody hell, we are still friends! 
Sony Playstation 2, easily one of the world’s best gaming
consoles, has this to say to their users. Our question: Was
there equal blood shed when this ad was created?



G
A

M
ES

BOOKS

Reality on the Shores of America
FOR LONG, ANURAG Mathur’s
bestselling novel The Inscrutable
Americans has been the bench-
mark in the confused-desi-in-
America genre in Indian writing.
It remained on the Indian best-
seller list for a record seven years
with no signs of leaving the Top
10 club. S Mitra Kalita’s Suburban
Sahibs, although steeped in fact
and technically not in the same
genre as Mathur’s fast-paced

poke at Indians trying to find the ‘real’ America,
tries hard to beat the notion of a confused diaspora
created by Mathur and later propagated by various
movie including ‘American Born Confused Desi’. It
is a sincere effort, worthy of praise, but you get the
same feeling you get when you miss the dessert
after a hearty meal—something, somewhere seems
to be missing even if you feel full.

Kalita’s credentials, though, are impeccable—
she is a reporter with The Washington Post and the
head of the prestigious New York-based South Asian
Journalists Association—and her writing skills are

beyond reproach. Her ability to get detail out of the
most trivial matter betrays her journalistic
instincts.

She tracks the lives of three families wanting to
make it big in the US, amongst which are people
naturally wanting to make it big with their H1B
visas—their passports to technological heaven.
Without being too sentimental about it, Kalita
writes about the rise and fall of the dotcom genera-
tion, and how the technology layoffs in the US hurt
the Indian economy in their wake.

Most importantly, Kalita records reality—some-
thing most tend to ignore when they reach
America’s shores and view the country with rose-
tinted glasses. Reality dawns, albeit a bit late.

It is this virtue that makes Suburban Sahibs a
readable book. It is not an unputdownable book—
but it is definitely a competent effort that made US
Senator Bill Bradley say: “It is beautiful book to be
enjoyed by all.”

Aparna Krishnakumar
Suburban Sahibs
Publisher Penguin Books Authors S Mitra Kalita
Phone 011-2649 0361/4401 Fax 011-2649 4403 E-mail
customer.service@in.pengroup.com 
Web site www.penguinbooksindia.com Price Rs 250
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No Better than a Rugby Game

FROM THE HARRY Potter books by J K
Rowling, one would assume that Quidditch
is a racy, lively game. But Electronic Arts
hugely disappoints with Harry Potter:
Quidditch World Cup, which is nothing but
rugby played in the air. 

QWC has great graphics, and the tuto-
rials are good, too, compared to the previ-
ous Potter games. One major hurdle is
that you must play a tutorial before start-
ing a match against another house team.

Despite the beautiful design of the
arenas or ‘pitches’, the gameplay gets
sluggish and boring. You are forced to
play more then half the matches at your
own national stadium. The character
porting is meticulous. Special moves are
another cool aspect of the game. While
holding the Quaffle, you get to perform
special moves that help you score goals
whopping fast.  

EA screwed up even the innovative
special moves. These moves cannot be

blocked, and this can get very frustrating.
Even the control system disappoints. EA
seems to have assumed that the 
gamepad is the standard PC peripheral.
The layout of the keyboard commands is
cumbersome. 

The game is highly recommended for
all Potter maniacs. However, chances are
that the casual gamer will find he’s bet-
ter off playing FIFA 2004. 

Swinging Times
JORDAN MECHNER’S PRINCE of Persia,
developed by Broderbund Software back in
the hoary days of yore, was a masterpiece.
Prince of Persia: The Sands of Time (SOT) is the
3D sequel to that classic title, and it
remains faithful to its predecessor in
remarkably creative ways. 

The game begins in medieval times,
shortly after the Prince and his father
the king have defeated a Maharajah and
looted his palace. 

You have to travel through the entirety

of the palace, use wits, acrobatics, the
sword, avoid traps, kill enemies, fall and
rewind, and... fall in love? Well, you do
meet a beautiful princess and an intrigu-
ing sub-plot unfolds. 

A major part of the gameplay lies with
the Dagger of Time. If you fall off a cliff,
miss a jump, fall down a ladder, or get
lured into a trap, you activate the Dagger
of Time, which turns back time before
your eyes. The environments and dia-
logues are all top-notch. 

This is a tough game to beat. If you
liked Prince, you’ll love SOT. 

Prince Of Persia: 
The Sands of Time (PS2)
Publisher Ubisoft 
Developer Ubisoft Montreal 
Web site www.prince-of-persia.com

1. Harry Potter and the 
Prisoner of Azkaban
Rs. 530

2. Grand Theft 
Auto Vice City
Rs 2,999

3. Cricket 2004
Rs 999

4. Need For Speed 
Underground 
Rs 1,299

5. Lord of the Rings: 
Return of the King
Rs 1,299

List courtesy: Crossword, Mumbai

Harry Potter: Quidditch World Cup
Publisher Electronic Arts 
Developer Electronic Arts
Web site harrypotter.ea.com
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FirstEscape

IT biggie Microsoft was
recently awarded a patent.

Hmmm, so what?
Companies such as
Microsoft an IBM keep
applying for patents, and
keep getting them at
regular intervals. What’s so
special about their latest

patent is this: the company
has patented a process 
that makes use of human
skin as a pathway to
electronic data.

Patent No. 6,754,472 says
that the human skin can be
used not only as a power
source, but also as a data
path for innumerable
gadgets that we are likely

carry in the near future. 
“As a result of carrying

multiple portable electronic
devices, there is often a
significant amount of
redundancy in terms of
input/output devices
included,” says the patent
application. “For example, a
watch, a pager, a PDA and a
radio may all include a
speaker.” 

The filing sketches a
plan to present a single,
uniform interface to these
devices. Of course,
Microsoft sees these devices
with really small form
factors with time—so an
earring which doubles as a
handsfree device could
derive power from the
earlobe to pick up a call,
which your wristwatch (also
powered by your skin) has
just received.

Such a Personal Area
Network (PAN) is currently
served by Bluetooth wireless
connections, but each

device carries its own LCD
screen, batteries, keyboards,
etc. Microsoft says it will
crunch devices such as MP3
players, PDAs, etc., to make
the power source
manageable, and the data
input method uniform and
logical. We are waiting for
this one!

GETTING EVEN

An adventure
in spam

Got fired? Get your
revenge by spamming

your bosses. Then get taken
in by the cops for all the
trouble you caused. A 17-
year-old clerk in the UK did
just that. 

After being asked to
leave by UK insurance
company Domestic &
General for failing to fill in
a time sheet, he

downloaded a mail bomber
and hit his erstwhile
employers with five million
e-mails. You read that
right—five million.

The spam did the job,
bringing the insurance
company’s Web site down
and causing a monetary
loss amounting to £18,000
(Rs 15 lakh). “All the e-mails
were harmless…” he
pointed. “ I just wanted to
cause them a bit of

Think you got the most
beautiful, most innovative

desktop around? Send it to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit shall publish the most 
eye-catching of them every month.

The Windows that looks like a Mac: by Pranav Naik

My desktop

ChandigarhCity.com

It advertises itself as a
guide to the city of

Chandigarh. Which is fine.
The Web site however
throws a bevy of all-
encompassing and vague
links such as Art &
Culture, Festivals,
Religious, etc. burying
the visitor under
confusion and doubt. The
worst of it is the choice of
colours employed for a
navigation tab: light text
over a light background.
Way to go!

Booby Trap
An anonymous British scambaiter scammed
Nigerian scamster Prince Joe Ebohby
convincing him to join the Holy Church of the
Order of the Red Breast. Prince painted his
nipples red, paying $80 as fees to the church.

Pixellated Art
Artist Claude Bosset has uploaded a 100 cm x
140 cm painting of a pixel to celebrate the
picture element’s 50th birthday. It is being
auctioned for 500 Euros. Bollywood is making
a film on Bosset called ‘Hum Aapke Hain Con’.

PATENT REGIME

Microsoft under your skin
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The winning
entry will win a
cool Webcam
worth Rs 1200.
This month’s
winner is
Pranav Naik.

Sponsored by
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inconvenience.” The
damage was far in excess to
the bit of trouble he was
looking to cause as Scotland
Yard’s computer
crime unit
would attest to. 

The law
questioned him
and then later
released him on
bail. If
convicted, he
faces a sentence
of up to six
months in jail or a
maximum fine of £5,000.
We await the book deal—
Tom Clancy’s Spam Force!

POVERTY LINE

Being
Microsoft

OK, don’t laugh.
Microsoft CEO says that

the $50-plus billion
Microsoft is not as rich as it
sounds. According to Bill
Gates’ chosen top man,
stories of unfathomable
riches are, just like Mark
Twain’s death we would
presume, greatly
exaggerated. 

In a sermon e-mail to
his staff, he intoned the
pitfalls of capitalism,
“We’re a technology
company with a lot of
growth opportunities… Our

cash needs are always
bigger than naked-eye
observers might think,” he
then stepped down from his

throne of solid-
gold, removed
his hat made up
of US greenbacks
and took a dive
into the cash-
pool, Uncle
Scrooge style.

According to
Ballmer, a
hiccup in the

cash flow came about when
Microsoft spent, while the
rest of the industry hung to
dear paisa. This was circa
economic-slump, which saw
companies shed workers
like yesterday’s fashion;
Microsoft, Ballmer said, was
then busy investing while
revenue was trying to catch
up to the associated
runaway costs. 

“This obviously is not a
trend we can continue,” he
declared. “This year, we are
targeting nearly $1 billion
(Rs 4,600 crore) in efficiency
improvement and cost

reduction across the
company, primarily by
rethinking how we do
things.”  The rethinking has
already seen the death of a
few cafeterias and a
reduction in the discount
that employees receive
when purchasing Microsoft
stock.

To end with a cheery
note, Ballmer said that he
was happy with the PC
industry and expected
much love in the form of
money. Amen!

OPEN AND SHUT CASE

Open Source
is Evil

And still on Microsoft,
one for the road. The

company's chairman and
chief software architect,
who answers to the name of
Bill Gates, doesn’t like Open
Source software. At all. And
he wants everyone to hate it
too. Why? OK, here is the
history behind the
statement.

On a recent visit to
Malaysia, he made it a point
to scare governments and
companies away from this
fast-approaching threat to
his business. Don’t get us
wrong, the Open Source
movement is far from the
messiah-of-the-masses that

Delete and Send to Recycle Bin?

Tux as a Garbage Bin: Bill Gates’ fantasy comes true at Goa’s Karmali
Railway Station. Sent by Rohini Sharma, Goa

Few would achieve
immortality for
spending five minutes

sitting in front of a
computer. That is precisely
what David J. Bradley,
retired head of Systems
Architecture, IBM and one
of the twelve people
behind the first IBM PC,
has achieved.

None of us even pause
and think of the
serendipities that gave us
little things that have
changed our worlds. Take
for instance the well
known key combination
[Ctrl]+[Alt]+[Del], the
‘three-finger-salute’. Any

PC user would tell you
that it is the holy elixir for
hung sessions and crashed
computers. 

Every day, millions of
Windows users reach 
for these keys in
frustration, trepidation or
even contempt, only to
forget all about it a few
minutes later.

Bradley joined IBM in
1975 as an engineer at
Boca Raton, California. He
wrote the famous piece of
code in five minutes some
time in 1980-81. His claim
to fame comes from those
five minutes. The idea was
to reset the PC without
having to actually turn 
off the power and then
turn it back on. 

David J. Bradley retired
from IBM at the age of 55.

David J.
Bradley

They changed
Computing

The $50-plus
billion Microsoft
is not as rich as
it sounds, says
the software
giant’s CEO,
Steve Ballmer

WIN!
An APUS Pen Drive worth
Rs 2500 just by sharing an
amusing picture which a
tech angle to it.

Send your picture to
ddiiggiippiicckk@@tthhiinnkkddiiggiitt..ccoomm..
The prize-winning picture
will be published every
month.



some of its disciples would
like us to believe, but Gates
is missing a few points. He
said: “If you don't want to
create jobs or intellectual
property, then there is a
tendency to develop open
source. It is not something
you do as a day job. If you
want to give it away, you
work on it at night.”
Hilarious! The 600-odd
employees of Red Hat and
the thousands working for
Novell and IBM work at
night, probably in their
parents’ basement. Bill
Gates said so. Additionally,
none of the top five
distributors of Linux—Open
Source’s flag bearer—are in
it for the money; perish the
thought.

There was more. Our
favourites: “[…] when it
comes to a guarantee or
having someone who stands
behind your software,
[Open Source] is typically
not something done in a
capital approach,” a

statement that comes from
a company known for the
security-through-obscurity
approach to its products
and customers. “Windows
has opened up
opportunities for computers
and chips to be built in
Asia.” 

Which is true, but most
of that software is pirated,
which brings us to: the loss
of tax revenue for
governments Bill ascribed
to, “when people don’t pay
for software.” As in pirated
copies of Windows, Mr
Gates?

He also pointed out that
software piracy is on the
decline in Asia. What he
failed to mention however
is the fact that Microsoft is
now selling a ‘Lite’ version
of Windows XP in Thailand
and Malaysia—light on the
wallet—something which
wouldn't have been possible
if Linux was not gaining
popularity in those
markets. Competition,
good. 
Perhaps next time, Bill
Gates would deem us
intelligent enough to
address real concerns on
Open Source and its
progeny, until then, thanks
for the laughs!

FERTILE IMAGINATION

Calling all
sperm

That irritating ringtone
could be ringing in news

more dire than a missed
meeting. Carrying a mobile
phone in your trouser or
jeans pocket could cut
sperm count by nearly 30
per cent. This news came
from a Hungarian study
conducted by the
department of obstetrics
and gynaecology at the
University of Szeged.

“The prolonged use of
cell phones may have a

negative effect on sperm
production and male
fertility,” said Dr Imre Fejes.
Fejes and his team analysed
sperm from 221 men and
questioned them about
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3D Studio
We give you absolute gems
from the 3DS Max roster of
jargon to help you get your
friends to drop their jaws when
they meet you next.

Space Warp 
This one takes the literal
meaning of space warp—it
warps space within physical
objects in a controlled fashion.
The commonest “warps” are
ripples in a rectangular surface,
a sphere exploding, etc.
Jaw-dropper My boss is worse than
a mailer daemon; tells me to finish
projects on Monday, even if he gives
them to me on Tuesday. The next
time he annoys me I will space warp
his face, and nuke his G5 on the side. 
Con Meter 6/10 

Gizmo
Traditionally, something your
rich friend possessed, and
something you always wanted.
In 3DSMax, a Gizmo controls the
modification of an object. It
allows you to visualise the
modification. If you bend a Bend
modifier Gizmo, for instance,

the object bends too.
Jaw-dropper This new

personal trainer of
mine, who I am
paying Rs 1,500
per workout
session, thinks he
has access to my

Modifier Gizmo. He
makes me stretch

and bend beyond limit!
Sometimes, I wonder why I

am paying him to torture me. But
give me a few months, and I will
sack him. Then let’s see who controls
his Modifier Gizmo.
Con Meter 6/10

Mental ray
No relation to Satyajit Ray! In
3DS Max, a Mental Ray is a cool
tool that allows physically cor-
rect simulations of light reflec-
tions and refractions producing
life like effects such as concen-
trated light reflection through
water surface and realistic glob-
al reflection effects. Confused?
Wait until you use it on your
unsuspecting friends.
Jaw-dropper Sorry I got late
for the party. My new Mental
Ray draws out such great
scenes that sometime I really
get lost in them. Oh, the stuff it
does. I wonder whether it is me
or just my Mental Ray.
Con Meter 8/10

The House of Digit often plays host to
Chaos. It visits during issue-closing night,

sits at the back, plays bad music, spews
corny jokes and come morning is
ceremoniously thrown out kicking and
screaming. As an irritating but tolerated
mascot, Chaos is par for the course. This
issue it overextended the
visit. Occasion: The Digit
Redesign.

The meetings weren’t
the 20-odd minute fests of
ideas, but mutants weaned
on 90 MB PowerPoint files,
which charted the redesign
course, mutants that
feasted on the brain-dump
of a million editors. Give or
take. Thus fed, these beasts boasted of a
minimum five-hour half-life. Writers, editors
and designers emerged with groggy eyes,
and a burning desire to see their loved 
ones, pronto!

This is not to say, we didn’t have our fun—
we persevered when we had to and had our
small doses of entertainment while no one

was looking. So, shush, don’t tell but: Counter
Strike—Condition Zero is a splendid game
indeed, table tennis can be tiring when
played for three hours non-stop, PopCap’s
Zuma is addictive, Lakshya sucks, and DVDs
have too much space, if you ask us.

We worked, we played, Chaos danced in
glee. Someone described the
scene as “the entropy of the
universe, packed in one
office”… There were new
section-names to learn, new
layouts to follow and much
to everyone’s chagrin, a lot
more software to be tested
for the DVD.

We did it though. 
Now, for the first time in two

months, the office is quiet as the rat-a-tat of
keyboards ceases and the dust settles down.
Everyone’s tired; weeks of 16-hour days will
do that. Even the veteran writers now
proudly exhibit callused fingertips like battle
scars. It is 3 in the morning, time to head
home to estranged families. Hope you enjoy
our labour of love. Happy reading!

A Redesign Riot



their use of mobile phones
to correlate between the
two. They found links
between a cell phone, even
in a standby mode, and
reduced sperm
concentration and quality. 

Professor Hans Evers, a
past president of the society
was sceptical, “It appears
not to take into account the
many potential
confounding factors that
could have skewed the
results,” factors such as
stress levels, the type of jobs
the men have and whether
they smoked, which could
all influence sperm count.

SHY GUYS

Homepage
owners put
on the couch

Owners of homepages are
shy, sensitive to

criticism and suffer from
low self-esteem. Oh, and
most of them are likely
male. Researchers at the
Chemnitz University of

Technology in Germany
interviewed more than 300
Web page owners to arrive
at the series of conclusions. 
To all those who feel that
homepages are an altar to
the ego, an exercise in

narcissism, homage to
trivial-pursuits of the HTML-
skilled, an ode to… you get
the point, the German
researches would beg to
disagree. They are a
challenge to the timid, they
said, a tool to transform
their social anxiety into
happiness, moreover the
majority of homepage
owners present themselves
as naturally as possible to
the world at large. 

A fact that is slightly
disturbing if you are a 
35-year-old Satan-
worshipping-vegan with a
penchant for leather. 
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Escape

Googleblog
http://snipurl.com/7oud

Oodles of Doodles
My name is Dennis, and I’m the guy who draws the
Google doodles. But the doodle tradition started here
before I did. The first doodle was produced by (who
else?) Larry and Sergey, who, when they attended the
Burning Man festival in summer 1999, put a little stick
figure on the home page logo in case the site crashed
and someone wanted to know why nobody was
answering the phone. By the time I began an internship
here in the summer of 2000, the company was
producing doodles on a regular basis. At the time I was
a Stanford undergrad majoring in art and computer
science, and, although I hadn’t been hired to do
anything remotely related to logo design, I eventually
stumbled into my first doodle gig (Bastille Day, July
2000, for which I did a fairly boring flag motif).

Michael Gartenberg
http://snipurl.com/7o8w

TiVo comparison to Windows Media Center 
I've spent a lot of time with both of them (and a few
others) over the last few months as we’re wrapping up
a major report on standalone DVRs such as MCE and
TiVO. There are other issues that need to be balanced.
First, the PC is more flexible. If I want to store and view
my pictures, music and other video content, burn to
DVD, copy to a portable media player and stream 
that content to other devices in my home, I can do that

with the PC, and not with the TiVo. The MCE EPG is also
more flexible. Try and record the West Wing on TiVO,
just the 7 pm episodes shown on channel 44, not the
other boradcasts. You can’t do it. It’s a snap on MCE
(Why would you want to? To record a series according
to airdates, so you can watch the episodes in order).
On the other hand, my TiVO never crashed, 
locked up, missed a scheduled record, or any other
annoying issue.

The Wireless Weblog
http://snipurl.com/7o8x

Big Fight Looming Over WLAN Standard
Ratification

Next week’s IEEE 802 plenary will surely feature
fireworks between some of the big names in the next-
generation wireless LAN world, including Sony, Intel,
Texas Instruments, and Motorola. What's at stake is the
ratification of a 802.11n WLAN standard that will
enable rates of between 100 and 200 Mbits/s.
Whomever is on the “winning side” of the debate 
could eventually see gigantic revenues in the
forthcoming high-rate wireless audio, video, and data
streaming marketplace. The 802.11n task group (TGn)
will meet in Portland, Oregon, next week as part of 
the IEEE 802 plenary. It will sort through 61 proposals
in search of a next-generation wireless LAN 
(WLAN) standard that will enable rates of between 100
and 200 Mbits/s, at least double that of current
802.11g/a standards.

Here’s taking a look
at a few riveting
posts from the world
of blogs. This month,
we selected three
interesting posts
from Snipurl.com. Get
an insight into the
evolution of Google’s
famous doodles—
from the creator
himself. Muse over a
fine comparison
between TiVo and
Windows Media
Centre. Keep abreast
of what’s on offer at
the looming fight
over WLAN standard
ratification 

“DID THE DOG get into my cupboard? Is
there a vandal on the loose? Help,
police, I've been robbed!”

After a thorough investigation, all
hope of ever finding the missing twin is
abandoned. Years pass—you don't heal.
People come over with treats, to try
and console you—it doesn't work. Your
friends tell you that life just isn't fair
sometimes, and recount their losses of

one of their twins—but yours was special. Nothing stops the
pain and irritation of losing one of a pair. “They were born
together; they serviced me for years together. How could
someone take one and leave the other? How lonely they must
be; they, and all like them, are meant to exist, again,
together!”, you tell your sympathisers. 

Yes, it can be terrible to lose a sock! What can you do
with one sock? A single sock has no purpose in life. It's
meaningless. However, throwing it away is just not an option.
So you get out a camera, take a picture and post it on
Lonelysocks.co.uk. How does this help? It's the odds of
probability at work here: Each sock manufacturer makes at
least 10,000 identical pairs of socks. At least 5,000 people
living near you probably buy clothes from the same store as
you. Chances are 100 of these people bought the same pair
of socks that you did. And finally, one of those 100 people
has to be as careless as you, and lose one of his or her socks. 

So why throw away a perfectly good sock? Just give it to
someone who could reunite your sock with it's twin. Right?

Ok so this is just our wildest guess at trying to figure out
what the makers of this site were thinking. Tell us if you have
any interesting theories, write to us at
WWTT@thinkdigit.com.

whatweretheythinking.com

www.lonelysocks.co.uk



Mail order

E-mail users across the world should be
indebted to Google. It wasn’t until

Google changed the rules of the game
that free e-mail service providers Yahoo,
Hotmail and Rediff woke up and went
beyond the 2 MB to 6 MB limits they had. 

The result was that, literally, all our
important e-mail had to be deleted in the
name of housekeeping. Not any longer.
Google’s announcement of 1000 MB
inboxes left the rest scurrying to increase
the size of their e-mail boxes. Now our desi
Rediff offers 1 GB (24 MB more than
Google!); Yahoo gives 100 MB; and Hotmail
has promised a 250 MB free e-mail box.

So what would distinguish one from
the other? Two things: service and spam.
Factors such as accessibility, recall and
speed would ensure better service. As for
spam, Bayesian filters seem all set to
become the standard to battle it, and so
it is left to be seen who wins the race.

Until then—just as we did with
search—let us thank Google.

Madhulika Mathur
Agra

SMS alert

Until recently, SMS was a great way to
communicate. It opened a new win-

dow of opportunity to shy people who
otherwise would not have gathered the
courage to say something.

However, the fun things about a new,
useful technology have lasted only this
long. Of late, SMS spoofing has become
alarmingly common. So much so that
people have started distrusting messages
from their own friends and family
members. SMS spam is another hazard
people have come to accept.

The question is: Do we really need to?
While SMS spam violates the privacy of
cell phone users, spoofing is set to bolster
fraud. Tricksters can now make use of
Web-based software specifically meant to

defraud through SMS. One can send
misleading messages to people by using
the cell phone numbers of other people.
The person whose number is used
wouldn’t even know that his number is
being used in sending messages to others. 

The biggest bother is that one is
helpless to mobile phone spam, as
unsolicited messages cannot be blocked.
Only a ban on advertising through SMS
can stop this nuisance.

Ashu D’Souza 
Mysore

Wake up, Google!

Looks like Google has competition. I
recently read about a new search

engine called Blinkx, developed by Kathy
Rittweger and Suranga Chandratillake.
Some say it has an edge over Google
because it doesn’t just search the Web
but also crawls news sites, e-mail attach-
ments, our hard disk, and also blogs. 

One has to download the Blinkx
windows client, which automatically
finds Web pages and documents related
to the content of the active window or
based on a specific query.

Also, Blinkx claims to use artificial
intelligence to rate stories—not page
rankings like Google. My fellow Digit
readers can download a beta version on
http://www.blinkx.com/. 

Will it beat Google. We don’t know
that yet.

Satyabrat Chakraborty
Rourkela

Thank you for the story

The July issue of Digit fed me to the
gills every bit of information 

about cellular phones—be they the regu-
lar ones, or camera phones, or even
smart phones.

All I can say is, thank you.
Having said that I would also like to

Illustrations M
ahesh B

enkar
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techno_funky

Joined 02 Dec 2003
Posts 776
Location Mumbai

Post Subject Digitized!

Bill Gates has been staring into his crystal
ball and sees no future for the DVD. In an
article published in the German mass-
circulation daily Bild, Gates reckoned that
DVD technology would be “obsolete in 10
years at the latest.” He said the concept of
carrying around film and music on little
silver discs to stick them into a computer
was ridiculous. He moaned that DVDs
could get scratched or get lost. 

Gates said that the home computer
will know who we are from our voice or
our face. It will know what we want to
watch, or what the kids shouldn’t be
allowed to see. Here the crystal ball
clouded over due to a blue screen of
death. Bill’s predictions and his crystal
balls can be a little inaccurate. He once
said that there was no future in that little
networking novelty called the Internet!

****************************************

deleted_empathy

Joined 04 Jul 2004
Posts 45
Posted Wed Mar 17, 2004 10:03 am 

Post Subject Warmed-Up Nerd

Bill Gates says a lot of things. 
He was of the opinion that 640 KB of
memory will be more than what one will
ever need. 
He also said that Linux is just a ’60s
technology wrapped in a new package.
How come then that ’60s technology and
its various cousins still give those
Microsoft guys sleepless nights when they
think of the server market? 

Everything evolves. Dumb people keep
getting replaced by saner, efficient ones.
Quite on the lines of the Theory of
Evolution. I have referred to Charles
Darwin, though I personally feel he didn’t
have that great traits of intelligence,
which many associate him with, but that’s
another story.

Technology is no exception. Most of the
current-generation DVD technology, for
example, is based on the red part of the
light spectrum. The efficiency can be—and
this is already being done—increased
moving further down the spectrum and
selecting lower wavelengths. Then come the
different concepts themselves. Like those
cool 3D holographic methods, for example.

So I am not surprised that Bill Gates
had to rack his brain to come up with the
idea of DVDs having no future. Which can
be obvious to a 10-year-old school dropout
as well!

Digit Forum

To post your comments on Digit Forum, 
visit www.thinkdigit.com/forum



add that even though urban and semi-
urban centres in India (even rural, for
that matter) have caught the mobile
fever, there are still a few who
stubbornly do not use cell phones. And
these primarily include celebrities.

They may have their own reasons (or
do they want to show-off?) for not
carrying a cell phone, but I guess the
market hasn’t suffered from such anti-
cell propaganda since this technology
propagates something that we all need:
communication. It’s this very need that
mankind has felt since time
immemorial and the cell fulfills that in
as small a form as it can get!

Thank you, Digit, for reminding us
of this fundamental need.

Meera Jain
via e-mail

Asking for a balance

Your July issue was quite busy—full of
articles that were of real value to the

average reader rather than just concen-
trating on just hardware and software
reviews.

Just when it was time for everyone to
file their tax returns, you came up with
a review of accounting and taxation
software, which was refreshingly
welcome. Even the article on IT jobs was
good, but it needed a lot more inputs
about personal experiences from job
seekers, to be able to cover both angles
in entirety. Perhaps space constraints
caused you to commit the lesser of the
two evils, as improper coverage of the
employers’ perspective would just be
criminal.

The ‘Tips & Tricks’ on Easter Eggs

was 100 per cent entertaining, and 0
per cent beneficial—make that 50-50 
at least the next time. For a gamer 
like me, the layout of the ‘Game 
Cheats’ section was confusing. The
white boxes all over the place with text
on a green background made for some
terrible reading.

Warren Dias 
Delhi

Usability is important too

Thank you for the special section on
cell phones in the July issue, particu-

larly smart phones. 
But I think usability is a key

criterion while purchasing cell phones.
The ‘eye-shaped’ Nokia 7600, for
example, has a radical design, but I am
not sure how comfortable it would be

to handle and use everyday, even for
people who can afford the handset. 

It seems to me that designers should
not compromise on usability just to
catch the customer’s eye. 

Saket Sharma
Via e-mail 

Inbox

On Page 134 of the July 2004
issue, in the review of College

Pro Science CD, you have men-
tioned two prices for the same 
product—Rs 1,350 and Rs 1,995. So
which one is correct?

Sachin Sharma

Dear Sachin,
The exact price of College Science Pro is
Rs 1,350. We apologise for the error.

Notice any goof-ups? 
Write to goof@jasubhai.com

Goof ups

Write to the Editor
E-mail editor@thinkdigit.com

Snail Mail The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate,  Nerul, 
Navi Mumbai 400 706. 

Digit will publish the best letters received from
readers on these pages. 

For subscription queries, call the Help Desk at 
022-27629191/9200 Fax 022-27629224, or e-mail at
help@jasubhai.com
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Just do it

Vipul Shah’s column in the July
2004 issue of Digit (‘Dear minister,

Lend Me An Ear’) was well timed. As a
nation though, we are already late.
Our illogical duties and exorbitant
bandwidth prices have done their bit
to stunt the growth of the Internet in
particular, and information
technology in general.

Shah’s column article stokes a
passionate issue for any serious
Internet user or enthusiast.
Indians don’t realise this until
their chat buddies abroad tell
you about their 512 Kbps and 1.5
Mbps Internet connections (512 K has
almost become the standard speed for
any casual broadband connection
abroad). So much so that broadband
seems to be a misnomer in India.

Moreover, ISPs are poorly
configured. You can very well surf the
Internet, but try doing something a bit
more advanced like running a
SHOUTcast server from your desktop,
or using a P2P application, and you
will usually find yourself behind a
restrictive firewall or a Network
Address Translator (NAT). Port
forwarding is a solution, but your
cablewallah administrator is either too
reluctant to configure that for you, or
just does not know how to do it. 

Quality of Service is a term they
have never heard of. Be it cellular
operators or ISPs, there’s no bottom
limit to how much their services
might degrade. They usually fix it
sooner or later but ideally, a customer
should be compensated for any sub-
standard service meted out to him.

A common argument is that
Chandrababu Naidu lost the state
elections in Andhra Pradesh because
he ignored basic needs of the people,
especially the poor and agricultural
class, at the cost of technological
advancement. Maybe so. My point is
that while a minister need not be
saturated with IT-promoting
ambitions, each minister in key
positions should have an
understanding of the importance of IT
and how we lag in certain aspects
plainly because of archaic policies. 

Other Asian countries are already
ahead of us. We cannot wait any
longer. No Sir! We have to start now.

Yuvan  Sankrityayan 

Love us? Hate us? Tell us!
Dear Reader, 

The September pages of Inbox will be
dedicated to your opinion of the

new Digit. Did you like the new
features? Did you like its people-centric
approach? What do you feel of the all
new sections? Did you love the DVD, or
did you hate it?

No matter what you feel or opine,
tell us. We would love to hear from you.
Write to us at editor@thinkdigit.com

Executive Editor

Letter 
of the
Month



SMS match
ends in court
Arecent competition in

Malaysia, involving text
messaging, had a $45,000 car
as the grand prize. The prize
was to be awarded by 
comparing slogans submitted
to by the 50 most prolific 
messagers.

Wong Jee Wai and her
boyfriend, Siew Kam Hong,
spent more than $5,000 on
their entries, and still could-
n’t win! Their slogans weren't
good enough. Now, the couple
is complaining, and want

their money back. They’ve
even taken their case to a tri-
bunal. Naturally, the tribunal
rejected their claim.

Wai and Hong did win
something—a motorcycle
worth less than a third of
what they'd spent on the mes-
saging. How’s that for a conso-
lation prize?

A couple of cliches fit the
bill here: “Quality is more
important than quantity,”
maybe, and perhaps “Always
read the fine print.”

Gates plays the
soothsayer again

Jobs lambasts 
Redmond company

At the World Economic
Forum in Switzerland, Gates

said, “Two years from now,

spam will be solved.”
Seven months later, spam is

worse than ever. Delegates at an
ITU spam conference in early
July aim to control the ‘modern
day epidemic’ of spam, again,
within two years. Looks like it'll
always be ‘two years’, just
because Gates said it would.

Bill Gates has a penchant
for doing a bad job at playing
Nostradamus. “Spam gone in
two years,” at a time when 
serious analysts are predicting
that spam will kill e-mail. 
640 K, anyone?

In his address at the 2004
Worldwide Developers

Conference, last June, Steve
Jobs made references to things
that Apple users will be look-

ing forward to—larger and bet-
ter displays, a vastly improved
operating system, etc. The lat-
est version of Max OS X v10.3 is
codenamed Panther. “People
are trying to copy Panther.”
Jobs said, referring to a
Redmond, WA, company.

About banners making fun
of Microsoft, Jobs said, “We're
having fun with that in the
lobby.” One banner read,
“Redmond, we have a prob-
lem.” One wonders what will
happen when Longhorn
debuts. Perhaps, we’ll then
have banners saying
“Cupertino, are your cash 
registers kaput?”

People And Events Who Grabbed Headlines—For Better Or For Worse

Not quite Nostradamus?

Steve Jobs warns copycats

Frisky footage of Cameron
Diaz in a steamy S&M video

recently hit the Internet, in
which she poses topless and
‘walks’ a leather-masked man
like a dog. 

The video—made in 1992

when Diaz was a 19-year-old
model—shows the Charlie’s
Angels star spraying her breasts
with a can of compressed air. 

The footage was shot by
photographer John Rutter, who
has since been involved in a
legal battle with Diaz after she
accused him of trying to extort

$3.3 million from her. 
The video captures Rutter

taking photographs of Diaz, a
model named Natasha, and a
man in bondage gear during a
‘spec shoot’ of photos meant to
build Diaz’s portfolio, but

never published. 
Rutter is currently out on

bail, and has filed a $10 mil-
lion countersuit against Diaz
for fraud and breach of 
contract. Last March, a 
judge denied Diaz’s request 
to dismiss Rutter’s 
fraud countersuit.

Angel’s mask off?

Cameron Diaz fights skeletons from the past
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